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Introduction

Volumes of the AR SPM Software User Guide

The Asylum Research Software manual comes in volumes. To date these volumes are:

Part I Overview. This part of the user guide covers a basic overview of how the software is organi-
zed and what the basic controls are for.

Part II Data and Image Analysis. Once the data are collected, this part of the user guide describes
many of the powerful analysis capabilities of the AR software. There are subsections on images
and force plots.

Part III Programming. The AR software can be customized for your needs on many levels, from
custom control panels to simple macros to completely open-source code for all the Igor Pro based
code, which defines nearly all the AR software functionality.

AR Software version It is assumed that AR Software version 14 or later is installed on your sy-
stem.

Getting Help

For additional help with your Asylum Research instrument, including software support, refer to:
https://afm.oxinst.com/support/

Updates to the Manual Bundled with the software, updates can be found at http://support.
asylumresearch.com.

Send Feedback Send e-mail to sba.manuals@oxinst.com (<– clickable link) and mention which
version of the user guide you are using and what chapter and section you’re commenting on.

Prerequisites

We recommend that you have a running AFM, or at least a functioning copy of the AR software in-
stalled on your computer. For an overview of a properly set up MFP-3D AFM, please refer to MFP-
3D User Guide, Chapter: Installation. Likewise, for the Cypher AFM a properly operating AFM
system includes a PC with the AR software installed. In case this software requires an upgrade,
or you want to install a copy on another computer (handy for image analysis), please see https://
support.asylumresearch.com/forum/content.php?150-Copies-of-Igor-instructions.

support.asylumresearch.com Page iii
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Part I

Software Overview
Part I: Who is it for? Every user should read this part at least once to get a general sense of the
structure and use of the SPM software.
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Ch. 1. Software Environment

1. The AR SPM Software Environment

CHAPTER REV. 2428, DATED 08/23/2021, 18:52. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Chapter Contents

1.1 Basic software components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.1.1 Igor Pro . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.1.2 The Asylum Research XOP . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.1.3 The AR SPM Template . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Before we get into describing the specific functionality of the AR SPM software, it helps to under-
stand a little about how it is built and how it differs from other instrument software you may have
used in the past. The AR SPM software was not written completely from scratch but builds upon
a program called Igor Pro, written by Wavemetrics. This quote from Wikipedia nicely sums up its
history:

“IGOR Pro is a scientific data analysis software, numerical computing environment
and programming language that runs on Windows or Mac operating systems. It is
developed by WaveMetrics Inc., and was originally aimed at time series analysis, but
has since then evolved and covers other applications such as curve fitting and image
processing. It comes with a comprehensive programming language with compiler,
but many functions are also accessible through menus. IGOR Pro’s strengths include
its graphics capabilities, and the possibility of extending the built-in functions with
external operations XOP allowing data acquisition, manipulation and analysis featu-
res, communication with external devices and in principle any other task that can be
programmed in C or C++.”

In a nutshell, Asylum Research writes C++ code which communicates with and controls the SPM
controller on a very basic level. This code cannot be altered by the instrument user. Asylum
Research also writes code in the Igor Pro programming language which executes commands in
this Xop to send parameters to the controller and retrieve data from the controller. More Igor code
creates a complete user interface to give you, the user, control over the instrument. Display of the
data, curve fitting, filtering, much image analysis, and many more features take advantage of a huge
number of built in Igor Pro functions.

Let’s open up the software and identify some of these basic components.

1.1. Basic software components

1.1.1. Igor Pro

You start up Igor Pro from the Start Menu on your PC computer: Start > All Programs > Igor Pro >
Igor . You will see something like Figure 1.1 on page 5.

BETA Page 4



Ch. 1. Software Environment Sec. 1.1. Basic software components

Figure 1.1.: Basic Igor Pro starting screen.

Notice the menu bar has items File, Edit, Data, Analysis, Macros, Windows, Table, Misc, and Help.
These menu items belong to Igor Pro and give you access to much of the Igor Pro data graphing
and analysis functions. Note that the Table item will change depending on what type of window
you click on (graph, panel, notebook, table, etc.)

If you are planning to do serious analysis on your AFM data, this is a good time to take a tutorial on
Igor itself. If you are only after a few AFM images to look at, this step can be skipped. However,
if you plan to use the AFM much, the tutorial is a very worthwhile investment of your time.

Just do it!

The Igor Pro Volume I - Getting Started manual (especially the Igor Guided
Tour portion) can be found from the Igor menu bar: Help > Manual. Then
click the ‘Open Online Manual’ button, and a pdf file of all of the Igor manual
volumes opens. It takes two to three hours to complete and is an excellent
way to learn about the basic graphing and analysis functionality of Igor Pro.
Although it is not necessary to complete the Igor Pro portion of the “Getting
Started” manual at this time, it is a highly recommended part of all new user
training.

1.1.2. The Asylum Research XOP

You don’t really need to know much about the XOP. It is an Igor Pro term which stands for eXternal
OPerations. They are typically computer files based on raw C++ code which allow Igor to cooperate
with external instruments and software. Asylum Research writes this software, and you can be
largely oblivious.

You will interact with the Asylum Research XOPs on some level. Notice the strip of icons at the
bottom of Figure 1.1 on page 5. You will not find that in the Igor Pro manual. These are some
small controls which are a result of an Asylum Research XOP and tell you about the status of the
AFM controller. We’ll refer to this strip of icons as the “software tray” or “system tray”.

While we don’t want to get bogged down in the detailed purposes of all of these controls, it is good
to have a basic grasp.

BETA Page 5



Ch. 1. Software Environment Sec. 1.1. Basic software components

À Igor Pro status If Igor is ready to accept a
software request from you, it will say Ready.
If not, it’s thinking or calculating indicative of
the Abort Button with a rotating quartered cir-
cle. This one is an Igor Feature and not part of
the AR XOPs.

Á Rescan Smartstart Bus Click this when the

SPM software gets confused. This may be ne-
cessary if Igor freezes up or when adding new
components to the system (e.g., heaters, diffe-
rent cantilever holders that have identity resis-
tors in them) that are not recognized.

Â Smart Start Status Click this to see what
MFP-3D components are communicating with
the Controller and PC computer. Furthermore,
individual information (e.g., temperature at, se-
rial number, etc.) on each component can be
accessed by clicking the triangular button to the
right of each component icon.

Ã MFP-3D status This displays if the AFM in-
strument is ready or if the controller or other har-
dware isn’t found.

Ä Quicklink to AR online support AR engi-
neers can control your MFP-3D over the web
during online help sessions.

Å CCD camera Click this to get camera screen
to come up.

Æ MFP-3D XOP version May be asked of you
during a support call.

1.1.3. The AR SPM Template

Note This may still be called the MFP-3D template for some time to come. For many years the
MFP-3D was sole instrument which communicated with the AR SPM software. Since it now also
drives the Cypher AFM, the software name was changed. However, references to the MFP-3D
AFM will continue to remain in the software. Don’t be alarmed, as your software will work with
any Asylum Research AFM.

The third arm of the SPM software is written in a special programming language defined by Igor
Pro, and it looks a bit like C. Nearly all the user interface controls are written in this language.

To load up this Igor Pro computer code, from the Igor menu bar select File .New MFP3D Template.
As explained earlier, this will probably change to New AR SPM Template, or some other name not
explicitly associated with the MFP-3D. The Igor Window will now look more like Figure 1.2 on
page 7.

Here are some of the basic features, clockwise from the upper left. (Note that if you are viewing
this file on a computer, you can zoom into the screenshot for closer scrutiny.)

Master Panel Upper left window. It has five tabs with controls and data displays for:

Main AFM imaging controls and control parameters

Thermal Cantilever thermal spectroscopy

Force Cantilever force vs distance curves

BETA Page 6



Ch. 1. Software Environment Sec. 1.1. Basic software components

Figure 1.2.: Typical start up screen for the Asylum Research SPM Software, after the Mode Master
panel has been closed. A few image panels have been left off the right of the screen, which usually
extends across the second monitor of your system. Note that not all the panels shown here are in their
original locations. It helps to manually tidy things up a bit so it looks like this figure.

Tune Cantilever vibrational tuning

Fmap Maps of force vs distance curves

Master Channel Panel During imaging, multiple data streams, such as cantilever amplitude, height,
and phase, return from the SPM to the computer. This panel contains information about those stre-
ams and allows for some real-time scaling and processing.

History Window Also known as the Igor Command line window (Which was the lower window
in Figure 1.1 on page 5). It will always have the name of your current experiment, which you can
also see at the top of the border for the entire software window. On occasion items executed by
clicking software buttons will generate some output here. Power users will type commands at the
command line to accomplish a variety of advanced tasks.

Sum and Deflection Meter A real time display of various data such as cantilever deflection, ampli-
tude, piezo voltage, and various other user definable channels. Also contains buttons for engaging
and withdrawing the AFM tip.

Image Windows For each active channel on the Master Channel Panel, one image will appear on
the screen. Before the scan starts, they are empty and appear small. They balloon to proper size as
soon as scanning starts. The windows display real time, line by line, the sample topography, phase,
amplitude, voltage, or any other measured quantity, as the cantilever raster scans the sample. There
is usually one such window per active tab in the Master Channel Panel (Lower left window). While
these windows are primarily a data displays, right clicking with the mouse can activate various
commands such as zoom and translate. A white area at the bottom of this window shows you a real
time “oscilloscope view” of the most recent line of image data, which are very useful when tuning
imaging feedback parameters.

A few other things of note are:

System Tray Along the bottom of the screen. Icon controls relate to the status of connected instru-
ment components. Low level software version is also displayed. This was discussed on 6.

Menu Bar Along the top of the screen. Note that there are a number of new items in addition to
the ones that “belong” to Igor (See Section 1.1.1 on page 4). The new items, specific to the SPM
functions, are MFP Controls, MFP IP, Programming, Data Folders, and User Settings.
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Ch. 1. Software Environment Sec. 1.1. Basic software components

Q Oops! I accidentally closed one of the control panel windows. How do I get it back?

A You can re-activate the panels via AFM Controls (MFP Controls in earlier versions of the
software) in the menu bar.

When you open the software you are opening an Igor Pro “Experiment” in which extra software
specific to the operation of the Cypher has been loaded. Beside graphing data and curve fitting, Igor
Pro provides a programming environment with full graphical user interface capabilities including
control panels with buttons, sliders, and fields for data input and output. These panels can be mixed
freely with graphs and tables of data. Hence the controls for the Asylum SPMs are a mixture of
graphs and control panels.

Tip
Nearly each individual item in the software control panels has a small
question mark button next to it. Click the button to read the relevant parts of
the software help file.

BETA Page 8



Ch. 2. Typical Use

2. Typical Uses of the AR SPM Software

CHAPTER REV. 2428, DATED 08/23/2021, 18:52. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Chapter Contents

2.1 Launching the AR SPM Software . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.2 Collecting and Saving Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2.2.1 Collecting Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.2.2 Saving Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

2.3 Keeping Things Organized . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
2.4 Shortcuts and Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

2.4.1 Igor Hot keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

The Asylum Research Scanning Probe Microscope Software (AR SPM Software) is capable of
many, many things–more than can reasonably be written in one single manual. You will probably
only use a small fraction of its capabilities, and this chapter can help you find that portion of the
software that is likely to be of use of you.

2.1. Launching the AR SPM Software

1. Boot up your PC (likely the one that came with installed AFM System).

2. On a PC computer select from the windows star menu: Start > All Programs > Igor Pro >
Asylum Research > MFP3D. (Please see the note on page 6.) In case you have copies of
the software installed on your computer, this will launch the original copy installed on the
computer

–OR–

Look for the same shortcut in the Windows Task Bar (usually next to the Start Menu). Again,
this launches the original installation.

–OR–

Look for the logo on your desktop. The accompanying number with the icon denotes the
major software release version. If there are multiple copies of the software on your computer,
there should be one shorcut icon for each copy. Double-click the icon of choice to launch
the software.

With the software launched, you’ll see something like Figure 2.1 on page 10.

Note
The windows in the ARM SPM Software do not have permanently assigned
positions. Get in the habit or arranging things neatly, as shown in Figure 2.1
on page 10, so you have an intuitive idea of where to look for certain controls.
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Ch. 2. Typical Use Sec. 2.2. Collecting and Saving Data

Figure 2.1.: Typical startup screen after closing the Mode Master window, a few other image windows,
and a little re-arranging

A VERY brief guide to what’s on the screen, from top to bottom:

Top window border This displays your version of Igor and AR SPM software.

Menu bar The menu bar links to all of the panels in the AFM software. It rarely directly controls
actions of the SPM hardware but rather allows you to launch control panels that appear in the main
part of the screen.

Main Screen The main screen is filled with control panels for controlling the SPM hardware and
software functions (here arranged around the perimeter of the screen) and data display windows
(one shown at the center of the screen) for viewing and interacting with data. Note the white
window near the bottom.

System Tray Also known as software tray. Shows you the status of Igor Pro and of all the con-
nected SPM equipment. It also shows the version of low-level software known as the “XOP”.

Now that the software is up and running (very lower left bit of the screen should say “ready”), you
will probably want to either collect new data (see Section 2.2 on page 10) or view and analyze
existing data.

2.2. Collecting and Saving Data

2.2.1. Collecting Data

1. Run through a tutorial. No amount of discussion will illustrate the basics of the software and
how it controls the hardware.

BETA Page 10



Ch. 2. Typical Use Sec. 2.3. Keeping Things Organized

For the Cypher AFM see1

For the MFP 3D AFM see2

2. Since a basic command of AC mode imaging is necessary before more exotic imaging modes
are attempted, the general business of data collection is covered in the AC Mode Imaging
chapter.

3. For non-imaging data collection, consider the following chapters:

Force Curves: 3

Lithography: 4

Spring Constant Calibration: 5

In general, data collection is managed through panels with buttons and fields containing numerical
parameters which control the data-taking process. Each imaging mode usually has its own panel.
Some of those panels, such as the Master Panel, which controls standard tasks such as AC and
Contact Mode Imaging, appear automatically when the software boots up. Panels for more advan-
ced imaging modes can be opened via items in the AFM Imaging Menu in the main menu bar at
the top of the software window.

2.2.2. Saving Data

Images are saved to disk automatically at the end of every image IF you select the appropriate
checkbox, such as the one called “Save Images” near the lower left corner of the Master Panel in
Figure 2.1 on page 10. DO THIS or you will lose data!

Force curves (see the Save tab under the Force Curve tab on the Master Panel) take up less memory
and can be automatically saved to disk or saved in memory.

If, at the end of a data collection session, you are not certain that all data in memory are saved to
disk, from the main menu bar select File > Save Experiment As. Igor Pro will save every last bit
of information currently in memory as a .pxp file (packed experiment file). When you open such a
file again, your entire data collection session is brought back up, down to the positioning of every
window.

2.3. Keeping Things Organized

As mentioned before, the control panels and data display panels in the AR SPM Software do not
have fixed positions. Here are a few tips on how to keep things organized and how to find things
that you may have “lost”:

• Get in the habit of arranging windows and frequently used control panels in a consistent
fashion (such as Figure 2.1 on page 10).

1 Cypher User Guide, Chapter: Tutorial: AC Mode in Air, Std. Scanner..
2 MFP-3D User Guide, Chapter: Tutorial: AC Mode Imaging in Air..
3 Applications Guide, Chapter: Force Curves Acquisition..
4 ?, .
5 Applications Guide, Chapter: Spring Constant Determination..
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Ch. 2. Typical Use Sec. 2.4. Shortcuts and Tricks

• Close windows and panels as soon as you don’t need them anymore. A good example is the
graph which appears after tuning a cantilever in AC mode.

• Use the Window Manager Panel (Ctrl+1 or select AFM Analysis Menu > Window Manager)
to see organized lists of all open windows and panels. Click on what you lost to bring it to
the front. Similar controls can be found in the Windows Menu.

• It can happen that a window or panel in the AR SPM software is not to be found because it
has landed “off the screen”. From the main menu bar, select Windows > Control > Retrieve
All Windows to bring all the windows and panels back into view.

• There are various tools for simplifying the SPM control panels and highlighting items on
them, including building your own custom control panels by picking and choosing controls
from various existing panels.

2.4. Shortcuts and Tricks

2.4.1. Igor Hot keys

ctrl+I Show Info, Igor A&B cursors

ctrl+A Auto scale graph

ctrl+F Find

ctrl+T Tool mode

ctrl+W Closes forwardmost window

ctrl+D Duplicates forwardmost window

ctrl+C Copy

ctrl+V Paste

ctrl+Y Window control, can rename windows

ctrl+O Open experiment

ctrl+P Print

ctrl+L Load waves

ctrl+J Bring History window forwardmost

ctrl+1 Toggle tool tips on or off

ctrl+shift+1 Window manager

ctrl+2 Do thermal

ctrl+3 Single force pull

ctrl+4 Cantilever auto tune

ctrl+6 Open S&D meter

ctrl+7 Open Master Channel Panel

ctrl+8 Open Engage Panel (Cypher or Jupiter only)
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ctrl+9 Open NAP panel

ctrl+F1 Igor search panel

ctrl+F2 Open Mode Master

ctrl+M Open Igor Procedure window

BETA Page 13



Ch. 3. All Things Video

3. All Things Video

Chapter Contents

3.1 AR Video Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
3.1.1 Capturing movies: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.2 Video Calibration Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.3 Guesstimating Scan Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

3.3.1 Centering tip in center of scan area in CCD image . . . . . . . . . . . . . 16

3.1. AR Video Panel

To capture images (or acquire movies) from the CCD camera, the AR video panel is needed.

1. Go to MFP-Controls > Video Panel; the AR Video Panel appears.

2. Click Top view or Bottom view if you have a Dual-View Stand-Alone base.

3. Have the ‘Scale Image’ checkbox checked if you have calibrated the image ; if the image
hasn’t been calibrated, the scale on the axis isn’t accurate.

4. Confirm the image is in the desired focus.

5. To save images, click the ‘Save to Disk’ checkbox or ‘Save to Memory’ checkbox. It is best to
save images as .tiff or .ibw file.

6. Click the ‘Capture’ button; the new image should be displayed immediately.

7. To get an assessment of the scan area relative to the cantilever position, click the ‘Show Scan
Box’ checkbox.

8. On the displayed image, place cursor towards the end of the cantilever, right-click, and select
Set Tip Location; this displays a red circle indicating the tip location (just as in the ’Point and
Click’ functions in ’Go There’ subtab).

9. Activate the ‘Show Scan Box’ checkbox. Two squares will appear on the displayed image;
the outer square shows the entire XY range (90µm), while the inner square shows the Scan
Area relative to the XY offsets.

10. As the Scan Area and XY offsets are changed, the display window is immediately updated. .

3.1.1. Capturing movies:

Movies of CCD images can also be captured with the AR Video panel as follows:
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1. Select a capture rate of no more than a couple Hz. Any more than that, Igor will have trouble
with collecting a lot of frames per second.

2. Choose the file type to save as. It’s recommended to choose .ibw or .tiff as the file type.

3. Give it a filename.

4. Click the ‘Start Background Capture’ button. This will start collecting at the specified rate.

5. When finished, click the ‘Stop Background Capture’ button.

6. Once complete, click the ‘Make Movie’ button to designate a frame rate for the movie. The
movie will be strung together into a video file.

3.2. Video Calibration Panel

The CCD image can be calibrated such that the scale bar along the X&Y axis of captured / displayed
CCD images is accurate. This process is very easy to do, and it’s described in full detailed in a
User Panel. It’s best to use a diving board cantilever for this.

1. Go to AFM Control > User Panels and Funcs > Video Calibration Panel.

2. This brings up the AR video calibration panel along with a Help menu to walk you through
it. This protocol is very easy to follow along with.

3. Confirm that CCD camera is on and cantilever in focus; the tip doesn’t have to be engaged
with sample.

4. Confirm that the probe is oriented in its pocket such that the cantilever length is parallel to
the X axis of the CCD window.

5. Enter nominal dimensions of cantilever for ‘Lever Length’ and ‘Lever Width’. The default
cantilever in the panel is for a Olympus AC 240 (i.e., 240 µm long, about 30 µm wide)

6. Turn off ‘Scale Image’ checkbox.

7. Click ‘Capture’ button

8. Click ‘Display’ button

9. On the new display image, call up the Igor cursors (ctrl + i)

10. Place the cursor at the end of the cantilever; place the other cursor at the base.

11. Click the ‘Calibrate Length (X)’ button.

12. Place the two cursors at each side of the cantilever to measure its width.

13. Click the ‘Calibrate Length (Y)’ button

14. Click the ‘Video Parms’ button

The Pixel Size should now be updated. It’s not a bad idea to jot that down somewhere in case you’ll
be using multiple CCDs (i.e., top and bottom views) during the experiment.

Now when the ‘Capture’ button is clicked, the displayed images should be set to proper scale.

If more precision is needed for the calibration, reticle calibration grids can be used to calibrate the
X and Y lengths.
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3.3. Guesstimating Scan Area

Here’s how to roughly determine if the selected scan area will contain a feature of interest as seen
in the Top View CCD camera. This method is a quick and easy way to figure out if the scan area
will reach the sample area of interest in the CCD image without calibrating the Video Panel (see
Section 14.8 on page 187).

1. Increase the Set Point voltage (if in AC mode) past the ‘Free Air’ amplitude voltage so the tip
comes off the surface ; if in Contact mode, decrease the Set Point voltage past the free air
deflection voltage so the tip comes off the surface .

2. Click the ‘Frame Up’ button and watch where the tip scans over in the CCD camera.

3. Click the ‘Frame Down’ button and watch where this scans over.

Make adjustments to coarse XY position micrometers or XY scan area if necessary

3.3.1. Centering tip in center of scan area in CCD image

Go to Force tab in the Master Panel. With no spots selected, have suffix on zero, and click the ‘Go
There’ button. This will put the tip in the center of the scan area. The tip will now be in the center
of its scan range.

BETA Page 16



Ch. 4. Navigating your Data

4. Navigating your Data
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4.1. Igor Graph Primer

4.1.1. Installing a grid on image screen:

If it would help you to have a grid on the image window (or any Igor plot) in real time or offline;
this is easy:

1. Double-click on one of the axis of the plot/graph. This shows the Igor Modify axis.

2. Click on the Ticks and Grids tab.

3. From the Grid menu, select On.

4. Select color and line thickness or any other aesthetic from this tab. For more on the Modify
Axis panel, see the Getting Started manual of the Igor Pro Manual.

5. Click the ‘Do It’ button.
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4.2. Viewing, Analyzing, and Resaving Stored Data

4.2.1. Image files

The entire topic of opening, viewing, analyzing, and saving files is outlined in great detail in Chap-
ter 7 on page 31. Please read at least the first few sections and work through the examples to get
familiar with this process. What follows here is a very brief synopsis.

(a) The Main Image Display Panel (b) Commands menu at
loction Æ to the left

Figure 4.1.: Image Analysis Display

4.2.1.1. Opening and viewing images

1. From the main menu bar select AFM Analysis > Browse Saved Data.

2. Choose a directory where the images are stored and show a panel with thumbnails of all the
images in the selected directory.

3. Double-click on any image to show an image display window (Figure 4.1a on page 18).

4. The tabs on the image show the various data channels/layers, such as height, amplitude,
phase, etc.

5. To view data in colorful 3D, navigate to AFM Analysis > 3D surface plots. See Chapter 11 on
page 132 for details.

4.2.1.2. Modifying and analyzing images

1. Click the ‘M’ button to bring up controls to filter or otherwise modify the image chan-
nels/layers.
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2. Click the ‘A’ button to bring up controls to analyze attributes (e.g., roughness, histograms,
etc.) of the image. For additional details, see Chapter 7 on page 31.

4.2.1.3. Saving changes

1. Choose Save Image from the pulldown menu shown in Figure 4.1a on page 18. Note that
any modifications you make to your data channels are stored in additional new image layers.
The original data channels (layers) will not not be altered.

2. If you are concerned about altering original data, first make a copy of the file from within
Windows and then work on that copy.

Note While there are other ways to save data in Igor, the method above is the only reasonable way
to save SPM Image files. Don’t be tempted by alternatives from the File and Waves menus.

4.3. Printing, Exporting, and Presenting Data

4.3.1. Quick and Dirty Printing

1. Select an image window (Figure 4.1a on page 18) and tab so that the layer of interest is
showing.

2. From the main menu bar, select File > Print Graph.

3. Choose the ‘Same Aspect’ button in the following print dialog box to maximize the image
size on the paper.

4. Select your printer and click ‘OK’.

Note This process also works for any other graphs on the screen, such as cantilver tunes and force
curves.

Note This process will not work for 3D images displayed via ARGyle. The next section describes
how to put the image in a layout first.

4.3.2. Pretty Printing with Layouts

Igor Layouts allow you to arrange images, graphs, text, and other graphical elements on a single
page for printing or bitmap export. For more information, refer to the Igor Pro manuals from
Wavemetrics. For a barebones rundown, read on:

1. Select an image window (Figure 4.1a on page 18) and tab so the layer of interest is showing.

2. Choose Export to Layout from the pulldown menu shown in Figure 4.1b on page 18.

3. A new layout window will appear with a copy of the image and some text with image parame-
ters that are fine-tuneable by choosing Set Layout Note Fields from the Commands pulldown
menu.

4. Rearrange or scale the items as needed or add other graphical elements using the toolbar.

5. If need be, repeat the first few steps and add more images to the layout.
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6. To add graphs, such as force curves or cross sections, to the same layout, click the ‘Layout’
button above the graph.

7. To add 3D views, from the Master ArGL panel, select New tab, and click the ‘Export to
Layout’ button.

8. From the main menu bar choose File > Print Layout to print the layout.

4.3.3. Exporting Graphs or Layouts

4.3.3.1. Save as a bitmap to disk

1. Select the graph, image, 3D view, or layout of your data.

2. From the main menu bar, choose File > Save Graphics and use the dialog box to export a
bitmap in various resolutions and file formats.

4.3.3.2. Copy as a bitmap to the clipboard

1. Select the graph,image, 3D view, or layout of your data.

2. From the main menu bar, choose Edit > Export Graphics and use the dialog box to copy a
bitmap in various resolutions and file formats to the Windows clipboard.

3. Choose any other application, such as Paint, Photoshop, Word, e-mail, etc., and choose Edit
> Paste.

4.3.4. Exporting Raw Data

Quick and dirty recipe for exporting line graph data:

1. Right-click on the trace you want to export.

2. Select Edit (which is followed by the name of the trace).

3. Right-click on the Table which appears.

4. Select Digits, then select the highest number there (16 at the moment).

5. Press Ctrl + A, to select the entire table

6. Press Ctrl + C to copy the contents of the table to the Windows Clipboard.

7. Paste your ascii data into any editor program (suggestion: Windows Start Button > All Pro-
grams > Accessories > Notepad).

8. Save the data as a text file (.txt).

9. Import the data into the analysis program of your choice.

For a more formal process, or an automated process for many graphs or images, please see on
page 173.
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4.3.5. Igor Electronic Notebooks

The Igor Electronics notebook editor is something of a word processor. You can copy any graph,
table, or layout and paste it directly into the notebook editor. Then you can add text between the
images and layouts, keeping a rough laboratory notebook of events. The notebook can be saved as
html or rich text (.rtf) and edited more from within your favorite word processor.

1. From the main menu bar, choose Windows > New > Notebook .

2. In the dialog box, choose ‘formatted text’.

3. Click the ‘New’ button.

4. Select any Igor graphic display window, layout window, or table window and press Ctrl+C
(or from the main menu bar Edit > Copy.

5. Select the notebook window and paste (Ctrl + v or Edit > Paste)

6. Type text between the images if desired.

7. To save, go to File > Save Notebook or Save Notebook As. Choose .rtf file format for further
editing in a word processor.

For more information on Electronic Notebooks see the Igor Manuals.

Tip

With a notebook selected (in the foreground) choose from the main menu bar
Notebook > Special > Enable Updating. In the next dialog box, check the box
and click the ‘OK’ button. Now, if you update any graph that is also in the
notebook, you can right-click on the time in the notebook and select Update
Selection. The graph will refresh to look like the original. With nothing
selected in the notebook, you can also select from the main menu bar:
Notebook > Social > Update All Now to refresh every copied item.
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5. Customizing the AR SPM Software User
Interface

Chapter Contents

5.1 Creating User Panels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

5.1. Creating User Panels

In the main menu of the AFM software, select Programming > User Panels. This opens the ARUP
Manager Panel (Asylum Research User Manager). The software engineers have included a number
of panels, some of which can be used independently and others which must be opened within a
Mode Master template.

• In the New Panel Name window at the top, enter the name for the new window.
• Click the ‘Start’ button. A new panel will open.

At this point, parameters, buttons, and radio buttons can be copied and pasted from other AFM
software panels.

It is also possible to include graphs and other objects.
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This section includes procedures the author finds valuable to perform while using the MFP-3D.
Some are commonly used, some are transparent, and others are rarely used; but, hopefully, this
collection may be helpful.

6.1. Lifting the Tip Off the Surface

Anytime you need to adjust something where it would be a good idea to lift the tip off the surface,
but you don’t want to disengage (i.e., withdraw the tip), you can adjust the Set Point voltage to the
false-engaged side of the free air voltage to lift the tip off the surface. This can be done with the
Hamster wheel or manually typing in the setvar parameter window. Specifically, you might want
to do this when:

• Shutting the door on the acoustic enclosure
• Changing image resolution
• Adjusting PD deflection: Be careful! This will likely move tip position up to a couple µm’s

just by touching the head
• Adjusting thumbwheel position

If in AC mode, increase the Set Point voltage to above the Free Air amplitude. Note that the
Z Piezo voltage will decrease.

If in Contact mode, lower the Set Point voltage to a value more negative than the Free Air
deflection.
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6.2. Engaging on Reflective Surfaces

Aside from monitoring the Free Air amplitude in the Sum and Deflection Meter while engaging,
the CCD camera can also be used when engaging on reflective surfaces to monitor relative tip
substrate separation based on the cantilever shadow distance from actual cantilever. Focus CCD
onto cantilever, then focus just slightly beyond that. This will allow surface to come into focus
when the tip nears it. When the tip is engaged, the cantilever reflection should not be seen.

Another tip that Scott MacLaren taught the author: If using a Stand Alone base, you can change
the aperture to slightly closed to get a bit of shadow around the edges of the video window. As the
tip approaches the surface, the image of the surface will come into sharp focus. This process allows
the tip to be brought towards the surface quickly with the thumbwheel for a coarse approach, then
slowed for engagement.

6.3. Adjusting Mis-Aligned Mirror to View Cantilever

Sometimes the previous user can mis-align the X&Y knobs on the top view optics mirror so much
that the cantilever can’t readily be found in the top view CCD- this problem becomes compounded
if the focus is also screwed up.

Instead of blindly manually rastering the mirror looking for the tip, here’s a quick way to fix this
problem: make sure a probe is in the tip holder to give a correct target for you.

1. Look straight down into the mirror housing (i.e., plumb), just as the light path does (see
Figure 14.10A)

2. Look for crisp clear trapezoid shape of quartz window. To assist this, wave your finger in
front of the window and look for the fleshy color of your finger in the mirror (Figure 14.10B);
also notice the opaque area of cantilever holder. The author looks for the crisp line between
the opaque area and the clear quartz window.

3. Move the XY mirror positioning knobs to bring cantilever into middle of trapezoidal window.

4. Once the mirror is positioned correctly, the cantilever should be easily viewed (Figure 14.10C)

5. Place the head back over the sample, and focus to suit needs.

6.4. Tip NudgerXYZ

This is very useful if the tip must be moved to a surface feature, in closed or open loop, that is
resolvable in the CCD camera. It’s also very intuitive to use, as follows:

1. In the main menu, go to Programming > Start User Panels.

2. Double-click on ’NudgerXYZ’.

3. Enter the ‘Step Size’ that you want to step the tip with.

4. Activate the X, Y, or Z axis checkboxes if you want the nudge to occur under Closed Loop
control or Open Loop.

5. Click the desired axis direction. Depending on the step size, the tip’s movement can be seen
visually, and there is typically a concomitant scanner noise.
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6.5. Smart StartTM

Sometimes when switching between software versions (e.g., old vs. newer), or if there has been a
repair performed on some hardware, there are calibration files that change and are highlighted in
red in the far left. Smart StartTM will catch this and display the ParmPanel window asking you to
change the calibration in the software so that the measurements are precise.

This panel can seem a bit of a sensory overload initially, but it’s relatively easy to deal with, as
follows:

1. Look at the Use This column and read the value for any row that is highlighted in red.

2. In that same row, compare the Software and Hardware column values and ’move->’ the value
that is different from the Use This column.

3. Click the ‘Use the ’Use This’ Values’ button at the bottom of the panel. This will activate the
button below it.

4. Click the ‘Save the ’Use This’ Values to Software’ button.

5. The process is now complete, and the window can be removed.

6.6. Determining the MFP-3D Software Version of a Saved Expt

Say you have a saved experiment and need to know what version of software it was originally
created with. The impetus of this is from trying to reload an experiment offline in which errors are
experienced because the version of software you are loading with is not the same as the version the
data was acquired with. To resolve this:

1. Go to Data > Data Browser. The Igor data browser window appears.

2. Confirm that only ‘Variables’ and ‘Info’ checkboxes are selected.

3. Click the ‘Browse Expts’ button. A browse dialogue appears. Find the saved .pxp experiment
needed. A second column appears on the right of the data browser.

4. Go into that column and drill down into root/MFP-3D/Main/variables/VerDate. Once se-
lected, the version will appear at the bottom of the data browser.

5. Now you can match that experiment for opening the experiment offline. If you need to know
the software version, contact support@asylumresearch.com .

Another easy way to determine the version is to view the Asylum Research tab in the Properties
information using Windows Explorer or My Computer.

6.7. Deactivating the Closed Loop Scanner

To deactivate the Closed Loop Scanner:

1. Go to Setup in the main tab of Master Panel.

2. Towards the bottom, click on the ‘Show?’ check box next to ‘Scan Mode’ pull-down. It
includes the option to turn off the Closed Loop feature.
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6.8. Sum and Deflection Meter Panel Freeze

This can occur if the cable connection isn’t very good. With time, and all that repeated cable
twisting from putting the head on its back while attending to the sample, the plug can wiggle its
way out enough to cause the meter to freeze.

To fix it:

1. Power the controller off for 10 to 20 seconds, then turn back on.

2. While you’re waiting, wiggle the plug back in a bit more.

We have noticed that anytime one of the levels in the S&D meter aren’t responding properly, it’s a
good idea to do some variation of the above procedure.

6.9. Rescan Bus

Sometimes if the system experiences a freeze, or the system is hanging because Igor has been
confused, click the ‘Rescan’ button (lower left). This should “ping” all the hardware systems to
make sure they are all communicating properly with each other.

6.10. User Callbacks

https://support.asylumresearch.com/forum?t=97&highlight=survey
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Part II

Data and Image Analysis
Part II: Who is it for? Once the data are collected, this volume describes many of the powerful
analysis capabilities of the AR software. It may also be useful with a second copy of the software
on a computer not attached to the AFM itself.

support.asylumresearch.com Page 28



Part Contents

7 Introductory Image Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
7.1 Opening Stored Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
7.2 The Modify Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
7.3 The Analyze Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
7.4 Miscellaneous Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

8 Force Curve Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
8.1 Opening Stored Force Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
8.2 Display Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
8.3 Pref Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
8.4 Parm Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
8.5 Cursor Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
8.6 Modify Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
8.7 WLC Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
8.8 Analyze Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
8.9 Spot Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
8.10 Elastic Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
8.11 Online Video . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

9 Particle Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

10 Video Overlay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

11 ARgyle 3D Data Visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
11.1 Viewing Saved Images in 3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
11.2 Overlaying Data on a Surface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
11.3 Display Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
11.4 Exporting Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
11.5 Activating Real Time ARgyleTM . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
11.6 Advanced Command Line Control . . . . . . . . . . . . . . . . . . . . . . . . . . 150
11.7 Argyle Lite Windows App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

12 Managing Image Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
12.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
12.2 Data Channels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
12.3 Selecting Image Pixel Density . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153



PART CONTENTS PART CONTENTS

12.4 Master Channel Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
12.5 Capturing Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
12.6 Offset Scan Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
12.7 Zooming Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
12.8 Multiple Offset/Zoom Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
12.9 Real Time Section Analysis: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
12.10 Other Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169

13 Exporting Raw Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
13.1 Exporting Your Data in ASCII Format . . . . . . . . . . . . . . . . . . . . . . . . . 173

support.asylumresearch.com Page 30



Ch. 7. Introductory Image Analysis

7. Introductory Image Analysis

CHAPTER REV. 2436, DATED 09/04/2021, 14:34. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Chapter Contents

7.1 Opening Stored Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
7.1.1 The Browse Graph . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
7.1.2 The List Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
7.1.3 The Display Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

7.1.3.1 Reprogramming Shortcut buttons . . . . . . . . . . . . . . . . 38
7.1.4 AR Thumbnail Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

7.2 The Modify Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
7.2.1 Flatten tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

7.2.1.1 Flatten Example, features on flat substrate . . . . . . . . . . . 41
7.2.1.2 Flatten and Planefit Example, Lattice steps . . . . . . . . . . . 43
7.2.1.3 Long involved flatten explanation . . . . . . . . . . . . . . . . 47
7.2.1.4 Making a manual mask . . . . . . . . . . . . . . . . . . . . . 48

7.2.2 Planefit tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
7.2.2.1 Planefit Example . . . . . . . . . . . . . . . . . . . . . . . . 53
7.2.2.2 Planefitting a step . . . . . . . . . . . . . . . . . . . . . . . . 55

7.2.3 Erase tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
7.2.4 Mask tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.2.4.1 Mask calculation methods . . . . . . . . . . . . . . . . . . . . 60
7.2.4.2 Hand drawing masks . . . . . . . . . . . . . . . . . . . . . . 61
7.2.4.3 Copying masks . . . . . . . . . . . . . . . . . . . . . . . . . 62

7.2.5 Filter tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
7.2.6 FFT tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
7.2.7 History tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

7.2.7.1 How to apply one process to another image: . . . . . . . . . . 67
7.2.7.2 How to apply one process to many images: . . . . . . . . . . . 68
7.2.7.3 How to remove one step from a multi-step process: . . . . . . . 68

7.2.8 Prefs tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
7.2.8.1 Modify Insert Layers . . . . . . . . . . . . . . . . . . . . . . . 68
7.2.8.2 Undo Only Last Planefit . . . . . . . . . . . . . . . . . . . . . 69

7.3 The Analyze Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
7.3.1 Roughness Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
7.3.2 Section Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

7.3.2.1 Straight Line Sections: . . . . . . . . . . . . . . . . . . . . . 72
7.3.2.2 Free Hand Lines . . . . . . . . . . . . . . . . . . . . . . . . 74

7.3.3 Histogram tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
7.3.3.1 Fitting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

support.asylumresearch.com Page 31



Ch. 7. Introductory Image Analysis Sec. 7.1. Opening Stored Images

7.3.3.2 Data Modification . . . . . . . . . . . . . . . . . . . . . . . . 77
7.3.3.3 Other Options . . . . . . . . . . . . . . . . . . . . . . . . . . 78

7.3.4 Particle Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
7.3.4.1 Particle Analysis Example 1: Finding the Length of a Piece of

DNA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
7.3.4.2 Particle Analysis Example 2: Finding Average Height . . . . . . 82

7.4 Miscellaneous Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
7.4.1 Saving modifications to images . . . . . . . . . . . . . . . . . . . . . . . 85
7.4.2 Custom work on image channels . . . . . . . . . . . . . . . . . . . . . . 85

7.4.2.1 Extracting layers: . . . . . . . . . . . . . . . . . . . . . . . . 85
7.4.2.2 Subtracting Image Layers: . . . . . . . . . . . . . . . . . . . 86
7.4.2.3 Rotating Images: . . . . . . . . . . . . . . . . . . . . . . . . 88
7.4.2.4 Reinserting layers: . . . . . . . . . . . . . . . . . . . . . . . 88

7.4.3 Cropping Images: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
7.4.4 Igor layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

This section discusses how to perform basic image analysis on stored image files (file extension
.ibw). Keep in mind that there are not necessarily hard and fast rules or sequences regarding image
processing. It can be a trial-and-error process that depends heavily on the data. For this reason, the
processing techniques are broken into sections below with some examples provided.

7.1. Opening Stored Images

1.

Prepare the software:

• Launch the AR SPM software and
you will see the Mode Master
window.

• Click the ‘Mode Master’ button at the
bottom of the screen any time you
want to load the Mode Master: .

• Click on the ‘Standard...’ tile.
• Then click Offline Image.

2.
Open the image browser:

• From the menu bar select AFM Analysis > Browse Saved Data.
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3.

Select a directory of images:

• If image data is not already loaded in
the experiment, you are asked where
you would like to load data from. If
there is data already in the
experiment, the Browse Graph is
opened, showing those images. To
open a new folder, you can click on
the ‘Change Directory’ button in the
upper-left corner of the Browse Graph
(Figure 7.1 on page 34).

• From the AR Load Path dialog, you
can click the ‘Browse’ button to select
a new directory.
-OR-

• Use the pulldown menus to visit
standard (Default Paths) or recently
visited (Recent Paths) directories.

• Click ‘That’s It’ to load the directory.
• The Browse graph will open

(Figure 7.1 on page 34) as will the
List Panel (Figure 7.2 on page 35) .

4.
To open an image:

• Double-click on the thumbnail to open the full-sized image.
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7.1.1. The Browse Graph

2

6

13 4
5

Figure 7.1.: The Browse Graph displays the data as thumbnails. This window can be resized by
clicking and dragging the corner.

The number labels in Figure 7.1 on page 34 refer to the following:

1. Image Data Type Specific data channels (i.e., Height, Phase, etc.) can be selected in the
Image Data Type. This is convenient if a specific image in a folder containing many images
includes a data type that most of the other images do not have. For example, choosing
NapPhase could help locate an MFM image among many non-NAP images.

2. Which Image Determines whether Trace or Retrace data is displayed. Selecting Either al-
lows both types of data to be displayed.

3. Vertical/Horizontal Number Thumbnail display array sizes can be altered by changing the
Vertical and Horizontal values. Vertical determines the number of rows in a window while
Horizontal determines the number of columns.

4. NextPage This button advances the screen to the next page of thumbnails, much like using
the Igor scroll bar on the right side of Browse Graph. The ‘Page Up’ and ‘Page Down’ com-
mands are keyboard shortcuts for this function.

5. Copy to Layout The ‘Layout’ button takes a snapshot of the Browse Graph and dumps it into
an MFP-3D layout window. See Section 7.4.4 on page 91.

6. Show Force Data This is useful for showing the different data types within a directory of
force-distance curves.
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7.1.2. The List Panel

Figure 7.2.: The List Panel

Images can also be opened in the List Panel (Figure 7.2 on page 35). It consists of two columns:
Images on Disk, which are the files stored in the folder, and Images in Memory, which displays the
images that have already been opened in the experiment.

• To open an image file, double-click on the file name.
• To open multiple images, hold down the ‘shift’ or ‘ctrl’ key while selecting the images you

want to open, then click the ‘Open Files’ button.
• Most of the function buttons are self-explanatory, so only a few are discussed, including:

Refresh List This updates the list of images in the currently selected directory. This is used
if images are being acquired real time while stored images are subsequently being processed
and analyzed.

Change Directory This is the same as selecting ‘Change Directory’ from the Browse Graph.
See Section 7.1 on page 32. It allows you to change the data file directory which is displayed
in the list.

Save to Disk Select one or more images to be saved over the original.

Note: Processed image layers are typically added to the original as new layers, and your raw
data tabs are preserved.
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7.1.3. The Display Window

When an image is loaded from the hard drive, it is displayed in the Display Window.

Figure 7.3.: The Main Image Display Panel

Figure 7.3 on page 36 shows an example of a Display Window image that will be used throughout
this section. Some of the controls at the top of this window include:

1. Range This adjusts the color scale, thereby changing the contrast.

2. Offset This adjusts brightness by changing where the center of the color range is.

3. Color Bar This allows the color scale to be viewed or removed from the image.

4. Auto button This auto-scales the color scale and offset.

5. ColorMap This offers many color tables for displaying the image data.

6. Stored data channel tabs The measured data channels, such as amplitude, phase, height,
and Zsensor, collected during a sample scan are saved as layers of the image. The tabs bring
an image layer to the front for viewing. Tab Naming Conventions include:

• Raw Data Raw Data tabs typically have three-letter names. The first two letters refer to
the data channel, such as Ht (Height), Am (Amplitude), Ph (Phase), and ZS (Z Sensor).
These two letters are then followed by the letter T for trace or R for retrace. HtT would
be the height trace signal, HtR the height retrace signal. The number of tabs present in
an image depends on which channels were saved when the data was collected.

• Modified Data Modified or processed image layers include an asterisk in their name
and are located to the right of the raw data tabs. Since it is possible to have multiple
modified layers of one original raw layer there is a number included in the layer name.
For example, the first modified layer of HtT would be HtT*0. Please see Section 7.2.8
on page 68 for more on this subject.
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7. Command Functions The Commands menu (Figure 7.3 on page 36) offers a large variety of
functions, most of which are described below. Some of the more frequently used functions
are repeated as programmable buttons to the right of the Commands menu. The default
buttons are shown in the margin next to the relevant command.

Display Panel This opens a window called the Display Manager, which includes a list of all
the image display windows open at the moment. It allows you to bring any window to the
front and to close, tile, or stack selected windows.

Modify Panel Functions such as flattening, plane fitting, masking, and filtering are perfor-
med via the Modify panel. See Section 7.2 on page 39.

Analyze Panel This is where roughness measurements, line sections, histograms of image
data, and particles are created, displayed, and generated. See Section 7.3 on page 69 for a
more in-depth discussion.

List Panel This panel allows you to open images, change directories, save images, and re-
name extracted images. See Section 7.1.2 on page 35.

Extract Layer Can export a copy of an individual image channel to facilitate custom proces-
sing. See Section 7.4.2.1 on page 85.

Insert Layer Reinserts an extracted layer into the display window. See Section 7.4.2.4 on
page 88 for examples.

Delete Layer Deletes the current image layer.

Show Note This is where many parameters associated with the image can be viewed.

Image Name–Show This button, which toggles between ‘Show’ and ‘Hide’, shows or hides
the image name within the display window. It can be useful for graphic exporting.

Change User Names Allows you to change the names of images stored as data from the
BNC connectors on the front of the controller. “UserIn0” can become something more des-
criptive, such as “Photocurrent”.

Save Image Saves any modifications to the display window, such as modified data or inser-
ted layers in new tabs. See Section 7.4.1 on page 85 for more details.

Save As... After requesting a new name for the selected image, this function saves the image
to a location specified by the user.

Save then Kill Image Saves the image, including all associated layers and tabs, then closes
the window.

Kill Image Removes the image from memory.

Export to Layout Appends the current image to a notebook style page. This process is des-
cribed in Section 7.4.4 on page 91.

Tiff exports: Tiff exports the current layer to a directory of choice as a separate image. It
includes numbers indicating the resolution of the new file it will have (1, 2, or 4 times the
number of pixels as the original image). These files can get very large but are great for
graphics that need to be displayed at larger scales, such as on posters. Note that you can
also choose Edit > Export Graphics from the main menu. This gives you other sizes and file
formats as export options.

Set Layout Fields Shows a list of display parameters for the ‘Export to Layout’ function.
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NanoIndenter Tip Area Function Shows a graph that will calculate Tip area from Z sensor
images of either nanoindenter tips or indentation. These tip area graphs can be used in the
analysis of indentation force plots on the Elastic Tab of the force review software.

Crop Image Once zoomed in on an image, this command discards all data outside the cur-
rent viewing area. This is done to all layers of the image. Please follow the steps in
Section 7.4.3 on page 89, as they include a protocol to prevent the permanent loss of raw
data.

Help Links to more detailed descriptions of these items.

New Appearance Toggles between the new and classical appearances of the 2D graphs.

Argyle 3D This button launches a 3D view of the data. Detailed in Chapter 11 on page 132.

For Display Windows with many image channel tabs, the small arrow buttons to the left of the tabs
allow you to move left or right through the image layers. If there are only a few tabs, these are
grayed out and inactive.

7.1.3.1. Reprogramming Shortcut buttons

Tip The shortcut buttons in the Display Panel
(Section 7.1.3 on page 36) are programmable.

Any function from the Commands menu can
be assigned to any of the buttons. For instance,
the ‘Note’ button, marked with the letter N, can
be replaced with a ‘Crop’ button, labeled with
the letter C. You can reassign one of the
shortcut buttons as follows:

• Ctrl+click on any of the six buttons.

.
• This will produce the dialog box to the

right.
• Select the button you want to reprogram.
• Enter a new name for it; up to two letters

can be displayed on the buttons.
Usually, the name is based on the initials
of the function.

• Choose the desired command from the
drop-down list.
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7.1.4. AR Thumbnail Viewer

Figure 7.4.: AR thumbnail viewer extension for Windows

On the Windows operating system side of the software, the AR thumbnail viewer is useful for
finding a specific image within Windows File Manager. This feature is installed as a Windows
extension along with the AR software.

1. Right-click on an image file, and choose Properties.

2. A panel similar to Figure 7.4 on page 39 will appear. The Asylum Research tab will have
a larger thumbnail of the stored image, and the lower portion of the panel has the pertinent
scan parameters.

3. On the dropdown menu, you can view any of the data channels, including amplitude, height,
and phase.

7.2. The Modify Panel

M stands for the Modification of raw image data. Usually this entails image processing of the
individual image layers to enhance features. The Modify panel can be opened from:

• The menu: AFM Analysis > Modify Panel

• The ‘M’ button on any offline image.
• Commands > Modify Panel on any offline image.
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7.2.1. Flatten tab

Figure 7.5.: Image Flatten controls.

When to use: When an AFM image is captured, there are two main things that affect the scan
from line to line. One is thermal drift, which smoothly affects the recorded height of the image. The
bad part about thermal drift is that it usually moves up and down in a seemingly random fashion.
The other thing that can affect the scanning is having the probe change its behavior suddenly. It
can break the tip off or pick up a piece of debris, and suddenly the measured height is changed by
more than the actual range of the image. Both of these can be dealt with by flattening. Since you
are scanning at 1 Hz, the time difference between two adjacent points horizontally is around 2 mS,
but the difference between two points vertically is 1 S; flattening is designed specifically to deal
with this problem.

How to use: Flatten Order 0 removes an offset from each line so that all of the lines have the
same average value.

Flatten Order 1 removes an offset from each line and also removes the slope of the line.

Flatten Order 2 removes offset, slope, and also a second order polynomial fit to the line.

Flatten Order 3 removes offset, slope, and a third order polynomial fit to the line.

Use Flatten on flat samples that show height varying in the slow direction, often caused by tip
changes or thermal drift. Longer capture times often require flattening of the image. Start with a
zeroth order flatten and look for artifacts or improvements. If the scan was slow, a Flatten Order 1
might make a noticeable difference also, as thermal drift can cause individual lines to have slope.

In general, the flatten must be done on a region of the sample that is on a continuous plane. Raised
areas or pits must be isolated from the flatten regardless of the image.

Note also that the images are saved with a first order flatten on them. To restore an image to its raw
form, on the Modify Panel (in either Flatten or Planefit tab), click the ‘Ultra Restore Layer’ button.
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7.2.1.1. Flatten Example, features on flat substrate

Overview For a successful application of flattening with minimal data transformation, flattening
should only be performed on portions of the AFM image that represent roughly a continuous plane.
In this case, we presume the background to be a relatively flat substrate. Nonbackground features
are excluded from the calculation with a mask, thereby preventing actual features from being used
to calculate the fit of the polynomial. The use of masks is discussed in Section 7.2.4 on page 59.
Here we perform a standard iterative process that works well for a wide variety of images:

• Flatten 0
• Mask
• Flatten 1

In this particular example, we use an image of DNA on mica. You can download this image file
from here: http://www.AsylumResearch.com/Files/Data/FlatteningExample1.zip

1.

Starting image layer:

• With an image open, select the
desired image channel.

• From the large offsets between lines,
you can tell that this image will
require at least a flatten 0.

2. Click the button to open the Modify Panel.

3. Set the ‘Flatten Order’ to 0.

4.

Perform the Flatten:

• Click ‘Flatten’.
• Notice that there are flattening

artifacts (black streaks) to the left and
right of taller features.

5. Go to the Mask tab and select Iterative from the Calc Method dropdown menu.
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6.

Create the first mask:

• Click ‘Calc Mask’.
• Make sure Fill Mask is still selected

to show the masked pixels. The red
pixels highlighted in this way will
subsequently be masked out and
ignored.

7.

Erode the mask [optional]:

• Click ‘Erode Mask’ once to eliminate
small, undesirable spots that have
been masked.

• Notice the mask covers less of the
features.

8.

Dilate the mask [optional]:

• Click ‘Dilate Mask’ twice to enlarge
the mask.

• Note that eroding and dilating are not
always reversible.

• Redo the mask with an iterative mask
to restore the image to its state in step
6. This is necessary to continue the
example.

support.asylumresearch.com Page 42



Ch. 7. Introductory Image Analysis Sec. 7.2. The Modify Panel

9.

Flatten.

• Select the Flatten tab.
• Select a Flatten Order of 1.
• Click the ‘Flatten’ button.

Note This procedure works because it keeps the order to 0 or 1. Sometimes it is useful to go
to a second order flatten in order to calculate the mask. Be aware, in this case, that you must
undo the second order flatten between creating the mask and applying a first order flatten to
eliminate second order modifications to the data.

10.

Review: [optional]

• Create 3D images of the starting point and the end point.

7.2.1.2. Flatten and Planefit Example, Lattice steps

Overview

Sometimes it is useful to use a combination of planefit and flatten. For example lattice steps can
prove to be difficult to correct. It will require an iterative process of masking and correcting, while
trying to minimize the distortion of the data. The use of masks is discussed in Section 7.2.4 on
page 59, and the use of planefit is discussed in more detail in 7.2.2. Here the outline is:

• Manual mask
• Planefit X1
• Improve mask
• Planefit X1
• Assess if Flatten 0 is required
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• Assess if Flatten 1 is required

In this particular example we will be using an atomic step of gold, sample courtesy of Nir Kampf of
the Weizmann institute. You can download this image file from here: http://www.AsylumResearch.
com/Files/Data/FlatteningExample2.zip

1.
Starting image layer:

• With an image open, select the Z
sensor channel.

2. Click the button to open the Modify Panel.

3.

Hand draw a mask on one side of the
image:

• Go to the Mask tab, click on ‘Include
Points’ and then drag a box from 6 to
8 µm in X and spanning the entire Y
axis.

• Click ‘Make Mask’ on the Mask panel.

4. Go to the Planefit tab.

• Set the Offset Uses to Mask. This will set one level of the lattice to zero, otherwise zero
would be between the two levels.

• Do a first order planefit in just X.
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5.

Create a better mask:

• Go to the Mask tab.
• Set the Calc Method to Bimodal.
• Click ‘Calc Mask’.

-OR-

• Click in the middle of the histogram
to set the level between the two peaks.

6.

Planefit X 1 again:

• Optional: Do an Ultra Restore to
undo the previous modifications to
the image, including the saved
planefit done to the image.

• Back to the Planefit tab, do another
first order planefit in XY.

• Click ‘Auto’ scale (on image).
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7.

Do a 0 order flatten [optional]:

• The rest of the instructions in this
example are optional. You need to
look at your image to figure out if you
need to go further or not.

• This particular image shows some
discrete shifts in the slow axis, a
couple from 0 to 2 µm, and clear one
at about 3.5µm, these will require at
least a zero order flatten.

• Make sure that the Offset Uses is set
to mask.

• Try adjusting your mask again, use
the histogram, and mask off most of
the histogram.

• Look at the other side of the lattice
(doing a flatten will make the visible
side look good, but could make the
other side worse).

– Click on ‘Inverse Mask’ on the
Mask panels.

– Click on ‘Auto’ on the image to
adjust the scale.

8.

Mask and flatten 0 again:

• Use the histogram to make a wider
mask and make sure you cover the
step. But if you get mask showing up
on the far side of the image (e.g., the
right side is mostly masked, and the
left edge of the image is also
masked), then that is going to go
badly. Try adjusting your mask more,
though you may need to undo flattens
to fix the mask.

• Do a 0 order flatten again.
• This should do a good job of getting

rid of the offsets between scan lines,
though there could still be some slope
to the lattice steps.
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9.

Mask and Flatten 1:

• Use the histogram to make a wider
mask. Make it really wide to include
nearly all of the histogram but leave
much of the image unmasked.

• Do a 1st order flatten.
• Look at the other side of the lattice

again.
• Take a section across the image.

7.2.1.3. Long involved flatten explanation

This is an explanation of flatten where we look at the effects of flatten on just one line.

• The black line is the original,
• The red line has had the flatten applied to it.

1.

Flatten 0:

• This is a line from an image that has
Flatten 0 applied to it.

• You can see that the shape and
everything stay the same, just the
offset is changed.

2.

Flatten 0 vs Flatten 1:

• Next is a comparison between Flatten
0 and Flatten 1.

• Though the amount of bow makes it a
little hard to see, the tilt has been
removed in the Flatten 1 version. This
is more obvious in a flatter scan line.

3.

Flatten 0 vs Flatten 1, cont’d:

• Easier to see difference between
Flatten 0 and Flatten 1, with different
data.
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4.

Flatten 1 vs Flatten 2:

• This is the difference between Flatten
1 and Flatten 2.

• Our scanners don’t usually have too
much bow; this scan line had bow
artificially added to it.

• You can see some bow in the Height
layer if you have a lot of tilt in the fast
direction.

5.

Flatten 2 vs Flatten 3:

• Next is the comparison between
Flatten 2 and Flatten 3.

• It is not unusual if there is a lot of
bow that there also more complicated
distortions.

6.

The actual unmanipulated data used in the
above examples. The bow in our
microscopes for the most part come from
tilt in the sample in the fast direction, so
whether the bow is up or down depends on
whether the scan was ascending or
descending.

7.2.1.4. Making a manual mask

Flattening works best on surfaces that are very flat without big features, which is good because that
are the conditions that normally need to be flattened the most. If there are big features, then a mask
usually has to be applied to keep the big features from distorting the image.

1.

This scan is the ZSensor layer of a sample
that has a raised surface and big particles
on the right side of the image. It has been
saved with Planefit 1, which means that the
vertical offset and X and Y tilt have been
removed. You can see from the wavy
looking height on the left side of the image
that it does need to be flattened.
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2.

Also, because of the big particles on the
right side, the planefit actually introduces
tilt into the flat left side of the image. This
is a line through the image that misses a big
particle on the right.

3.

So, we need to either do a Flatten 0 and
then a correct X Planefit 1, or just go ahead
and try a Flatten 1.
Well that didn’t go well.

4.

To see what went wrong, let’s look at an
individual line. The Flatten 1 algorithm
does a linefit to each line of data and then
subtracts that fit from the line. In this case,
the linefit is skewed by the big particle, so
the subtraction of the fit messes things up.
What is happening is mathematically
correct, but you don’t really want to be
doing this.
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5.

To fix this, we need to apply a mask, which
is something that limits what parts of the
image we are going to use to calculate the
fit. Masks limit what is used for the fit, but
the resulting fit is always applied to the
whole image disregarding the mask. We
could start over, but since we are still
planning to use a Flatten 1, there is no need
to. As long as you are going to be using the
same level of fit or higher, you don’t need
to go back to the raw image. If you are
going to just use Planefit, and you have
used Flatten, then you need to start over.
Or, if you want to use Flatten 0, and you
have used Flatten 1, then you need to start
over. But if you are using the same or
higher level of modification, you can just
keep going.
This image has a fairly obvious flat surface
that we can use for our flattening. Click on
the ‘Include Points’ button, and then draw a
box starting outside the image over the left
side of the image. After you click the ‘Make
Mask’ button, it will look something like
this, depending on what the transparency
on the Mask tab is set to .

6.

Now it’s time for Flatten 1. That looks
better. But now you can see that a couple of
particles on the flat area are affecting the
flatten. Click on the ‘Exclude Points’ button
and circle them, then clcik the ‘Flatten’
button again. If you are in the middle of
drawing things, and you click the ‘Flatten’
button, it triggers the ‘Make Mask’ button
for you.
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7. This looks good.

8.

Same image with the mask reset. Usually
at this point, it would be a good time to
adjust the Range so you can see the image
better; but if we did that on this image, you
could really see how noisy the image is
from being captured with an AFM sitting
on a random table. So we won’t do that.

9.

Here is a look at the line that we looked at
before now that the fit is correct. The part
that we fit to is now flat. The flat part is a
little below 0 because the offset of the
image is calculated doing the whole image,
and the big particles contribution means
that most of the image is below 0. If during
the flatten (or afterwards if the mask is still
there) the ‘Offset Uses Mask’ button is
clicked, then that flat area would be at 0.
On most images with big particles, you
want to use a fancy calculated mask; but, in
this case, the part of the image where the
particles were was also raised, so we didn’t
want anything from there anyway.
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7.2.2. Planefit tab

Figure 7.6.: Image planefitting controls.

When to use: Planefitting is useful when you have sample that is known to be flat but has a tilt
to it. Thermal drift and sample mounting are two common reasons for a straight sample to give a
tilted height image. By fitting and subtracting a plane to the entire image, the image can be made
flat. Measuring topographical features then becomes easier since there is a relevant zero height
from which to measure.

Planefitting an image works on the whole plane of an image at once instead of a line at time like
Flatten. Flatten is a more intense modification, if you have used Flatten on an image you do not
need to do a Planefit in Y, and if you have used Flatten 1 then you do not have to do Planefit 1 in
X. If you have a channel that was captured with a Save Planefit of Flatten 1, which is the default
setting for Height, then you need to do an Ultra Restore Layer on it first.

Planefitting is more tolerant of big particles and other things that would need a mask if you are
flattening. The particles average in with everything thing else better since they aren’t being isolated
in a single line. A flat surface with big particles evenly distributed will planefit just fine, where it
would require a mask to flatten correctly.

How to use:

Plane fitting is very similar to flattening. It fits the unmasked data to find and subtracts a plane of
specified order.

• 0-order is not very common, as this option simply takes the offset of the unmasked image.
• 1st-order is the most common. It subtracts a flat, sloped plane from the image.
• 2nd-order is much less common. Care needs to be taken with this modification as it has much

more potential to alter the topography. In this calculation, a second order polynomial plane
is subtracted from the image.
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• 3rd-order probably should not be used for any publication. It is included in the software just
for tinkering with data. In this calculation, a third order polynomial plane is subtracted from
the image.

• Histogram is a much more complicated algorithm; it is more of a recipe that seems to do a
good job on a wide variety of images. It:

– Does some filtering on a temporary copy of the image.
– Calculates a mask based on the histogram of the filtered data.
– Does a 1st-order planefit to the image.

7.2.2.1. Planefit Example

Overview In this example, we go through the various planefit orders and compare their results on
a highly curved sample.

We will be using an image of human hair. You can download this image file from here: http:

//www.AsylumResearch.com/Files/Data/PlanefitExample1.zip

1.
Starting image layer:

• This is the original Z sensor image of
a human hair.

2.
Do a 0 order planefit:

• Note that a new layer with an average
of 0 was created.
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3.

Do a 1st order planefit:

• Since we are increasing the order, we
can simply do this on the modified
layer.

• Note that the left edge of the hair is
lower than before.

4.

Do a 2nd order planefit:

• Note that the image is drastically
different.

• This can be helpful in that details on
the surface of the hair are clearer, but
caution is required as those features
could be artifacts from the 2nd order
planefit.

5.
Do a 3rd order planefit:

• The 3rd order planefit is similar to the
2nd order planefit, but more extreme.
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6.

Histogram planefit:

• You first need to undo the planefit.
Click ‘Undo Planefit’ or ‘Restore
Layer’. Note that the latter option will
undo modifications prior to the
planefit.

• Set the order to Histogram and click
‘XY’.

• Note the similarity to the 1st order
planefit. The hair was masked out, so
the side of the hair is more planar as a
result of this modification.

7.2.2.2. Planefitting a step

1.

An example of where you need to mask for
planefitting is if you want to image a step
correctly. The shown image is of a gold
step on a substrate. The sample has been
imaged correctly, with the scan crossing the
step in the fast direction and enough flat
area on both sides of the step for
planefitting. It has been saved with Planefit
1, which is the default save planefit for Z
sensor.

2.

But if we look at a line in the middle of the
image, it doesn’t look right. Since the
image had a first order planefit applied, but
it has a large step in the middle of it, the
planefit has leveled out the high and low
regions on either side of the step.
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3.

To correct this, we need to do a planefit on
just one of the flat parts of the image. We’ll
use the substrate as our plane, as it looks
smoother than the top and sometimes
deposited films have a slope near their
boundary. Use the Include Points button
and draw a box on the substrate.

4.
Then a Planefit 1 in X. We’ll change the
scaling a little so we can see the top of the
step.

5.

Let’s look at the same line that we looked
at earlier. Compared to the earlier line, you
can see that the substrate is now flat, and
any slope in the film should be real.

6.

But looking at the image, it looks like there
is a horizontal step in the image where the
probe changed properties. It is hard to see
with image scaling that we have now, so
let’s change the scaling to see the substrate
clearly. We could just change the Offset
manually, or we can put our mask back on
and check the Offset Uses Mask button on
the Flatten tab. This sets the offset by what
is not masked instead of using the whole
image. Once we do that, we can see there is
a step and some pretty serious thermal drift.
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7.

So, let’s fix that by doing a Flatten 0. We
have already done things in the X direction,
so we do not need to do a Flatten 1. If we
did, that would actually work fine. That
gets the substrate flat.

8. Now, let’s look at the whole image again.
Looks good.

7.2.3. Erase tab

Figure 7.7.: Erase controls.

When to use: Abnormal scan lines can make adjusting your color scale difficult, as well as be
problematic in masking and skew some analysis (such as sections). Note that erasing too many lines
in publication grade data can work against you; experienced SPM users expect aberrant noise lines
in publication images. Please use this feature with discretion. Appropriate use may include the
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removal of lines caused by disturbances in a lengthy image scan (such as your lab mates slamming
doors while the best image of your life is being collected).

How to use: Select the line or lines that you wish to have blurred out, adjust the width to make
sure the lines are covered, and click ‘Do It’. The marked lines will be replaced with averages of the
lines remaining on either side of the block to be erased.

1. With a Display Window image open and the desired image channel as the forwardmost tab
(for example, Height Trace (HtT) in Figure 7.3 on page 36), click the ‘M’ button to open the
Modify Panel.

2.

Locate the bad line:

• Identify the offending line.
• In this case, it shows up particularly

well in a 3D view of the data.

3.

Zoom in:

• Expand a small area around the lines
to be erased.

• Do this by selecting the area of
interest in the image and then
right-clicking on the area.

– Select Expand or Vert Expand.

4. Go to the Erase tab of the Modify Panel.

5. Click the ‘Draw Lines’ button.
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6.

Select the offending line:

• While holding the left mouse button
down, place the pointing finger cursor
over the scan line you wish to
remove, then release.

• Notice that the line goes from red
while positioning and to blue when
set.

7. If necessary, increase the Line Width value (Figure 7.7 on page 57) to cover more lines.

8. If the placement of the line is unsatisfactory, click the ‘Clear Lines’ button to remove them.
Repeat the attempt.

9. Click the ‘Erase Lines’ button. The line will disappear from the image, indicating that the
erasure has taken place.

10. With the cursor over the image, use Ctrl + A to restore the original zoom and assess the
results. It is also possible to zoom out by right-clicking and selecting Autoscale Axes.

7.2.4. Mask tab

Figure 7.8.: Image masking controls.
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When to use: Flattening (Section 7.2.1 on page 40) and Plane Fitting (Section 7.2.2 on page 52)
should be applied exclusively to the part of the image that is known to be planar. Image masks
allow the non-planar areas to be omitted during the fitting. The mask can also be used for image
analysis exclusively inside or outside the mask (see Section 7.3 on page 69).

How to use: Masking is used to exclude some portion of the image, typically by setting a thres-
hold value to include the pixels above or below that threshold. There are a couple of ways to make
finding the threshold value easier, as well as a number of other methods to fine tune the resulting
mask. The general steps for a simple manual mask:

1. Drag the blue vertical line through the histogram graph to set the threshold for the mask.

2. Optionally, invert the mask using the ‘Invert’ checkbox.

3. Optionally, use ‘Range’ to mask a range of values in the middle of the histogram; it is also
possible to unmask this range by checking ‘Invert’.

Next, a simple automated method:

1. With a Display Window image open and the desired image channel as the forward most tab
(for example, Height Trace (HtT) in Figure 7.3 on page 36), click the ‘M’ button to open the
Modify Panel.

2. Go to the Mask tab of the Modify Panel (Figure 7.8 on page 59).

3. Confirm that “Iterative” is chosen as the Calc Method. This method is a good mask to start
with to find the proper threshold value.

4. For typical AFM samples with a flat background and protruding features, check the ‘Inverse’
checkbox. For a sample with pits, do not choose ‘Inverse’.

5. Click the ‘Calc Mask’ button. A threshold will be determined that may work for your image.
Notice that the Calc Method has changed to “Manual”, and the determined threshold has
been entered.

6. If the mask seems close to where you want it but should encompass a bit more adjacent
area, click the ‘Dilate’ button. This will add pixels around the existing perimeter of the mask.
Click ‘Erode’ to shrink the masked area. You can also eliminate lots of small masked areas
by eroding one or two steps, then dilating back again. Only large blobs will survive that
process. For examples of this, see Figure 7.9 on page 61.

7. If the mask seems completely off, you can always edit the threshold and range values and
manually recalculate the mask. Alternately, use the histogram to set the threshold manually,
as described in the simple manual mask above.

Once you have your mask, flattening and plane fitting will only use the unmasked areas for the fit
and will apply the subtracted fit to the entire image; the unmasked areas are affected, but they are
not used for the fitting.

Filters such as smoothing or blurring will only be applied to the unmasked area. Masked areas will
remain exactly as before the filter.

7.2.4.1. Mask calculation methods

There are many different mask algorithms to choose from:
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Manual The user may enter a value into the Threshold range. This will put the mask above or
below that value, depending on the state of the ‘Inverse’ checkbox. There is also a histogram on the
Mask panel that represents the image data. You can drag a blue vertical line on this histogram to
set the threshold graphically.

Iterative This calculation automatically picks a Z threshold range using an iterative method.1

Bimodal The mask is calculated based on the assumption that the image histogram is a simple
bimodal distribution2.

Adaptive Adaptive thresholding evaluates the threshold based on the last 8 pixels in alternating
rows2.

Fuzzy Entropy This function uses entropy as the measure for fuzziness2.

Fuzzy-Mean Gray: Fuzzy thresholding uses a method that minimizes a fuzziness measure invol-
ving the mean gray level in the object and background2.

Typically, one uses manual or iterative. Playing with the more exotic methods is encouraged. They
can sometimes surprisingly lead to the result you were looking for.

Figure 7.9.: Creating image masks: A) after zero order flatten (i.e., no mask); B) after Iterative mask;
C) Panel B after Erode mask button click; D) Panel B after Dilate Mask button click.

7.2.4.2. Hand drawing masks

When all the automated mask algorithms fail, or if they work except for one area, it is possible to
add or subtract areas from the mask by hand. This can be done either to an existing mask or to an
unmasked image.

1. To add points to the mask, click ‘Exclude Points’. This will cause a set of drawing tools to
pop up to the left of the Image Display window (Figure 7.3 on page 36). The points will be
excluded from subsequent operations.

2. Select a tool and draw a shape around the area of the graph you want to add to the mask. You
can draw multiple areas with multiple tools during this step.

Advanced Note: Each tool can be right-clicked to reveal more tools.

3. Notice that the ‘Exclude Points’ button has turned into ‘Make Mask’. Click that button and the
outlined areas will be added to the mask.

1 T. W. Ridler and S. Calvard, IEEE Transactions on Systems, Man and Cybernetics, SMC-8, 630-632, 1978.
2 This function [ImageThreshold] was designed by Wavemetrics Inc. and is built into the Igor Pro software. Please refer

to the Igor Pro Software manuals for more information.
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Note: To remove areas from a mask, follow the same steps using the ‘Include Points’ button.
They will be included in subsequent image processing.

Figure 7.10.: Using ‘Exclude Points’ masking feature: A) Click on exclude points, and select the free
hand tool to make shape; B) Draw the shape on the image; C) Change the tool to ellipse and drag
around the height feature to also be excluded–blue indicates it can be moved on image with arrow
keys; D) Click on ‘Make Mask’. (Data courtesy of Keith Jones, Asylum Research; sample courtesy J. Schlenoff, FSU

Chemistry.)

7.2.4.3. Copying masks

In some instances, performing two separate iterative mask calculations on two separate image
channels in a data file can give two different results. This can be problematic, especially when
overlaying two channels in ARgyle (Section 11.2 on page 133). In these instances, it can be a good
idea to copy the mask from one channel and paste it into the other channel.

Another reason to copy the mask is to save processing time when trial-and-error approaches are
being employed with planefitting or in finding a flattening order.

1. Make a mask on one of the image layers using the methods described above.

2. Click the ‘Copy Mask’ button.

a) Note that a pull-down menu appears to the right of the ‘Copy Mask’ button. This allows
you to copy to multiple “clipboards”.
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3. Select another image layer.

4. Click the ‘Paste Mask’ button. This will paste the mask on top of whatever mask was already
present on that layer.

a) If you are using multiple clipboards, there will be menu to the right of the ‘Paste Mask’
button allowing you to select which clipboard to use.

7.2.5. Filter tab

Figure 7.11.: Image filtering controls

When to use: Flattening and planefit are very good “filters” for AFM images, they apply a mo-
dification to the data that can remove typically problems in AFM images. But sometimes you need
a bit more. The filter tab has more general use filters that can be applied to any image data. In fact,
many of these algorithms were developed for photography. But if you are having trouble making
out edges, and you know not to use that resulting image for quantitative analysis, it is perfectly
reasonable to apply a harsh edge finding filter.

How to use: This tab applies a variety of standard image processing techniques to the unmasked
part of the image (see 7.2.4). The two filter types primarily used are the NxN and 3x3 matrix filter.
At each pixel of the image, they look at the nearest neighbors of that pixel and apply an operation
on those neighboring pixels to calculate the new pixel. A very simple 3x3 filter would take an
average of the 9 pixels and put that value into the center. A description of these matrix filters is
defined better in the software Help menus.

• NxN filter: This matrix filter has various filter method types including: Median, Average,
Gauss, min, max, and NaNZapmedian.
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– Size: Defines the size of the NxN matrix; the larger the number, the more the pixel will
be blurred (influenced by more neighbors).

– Passes: Defines the number of iterations that filtering process undergoes. More passes
mean more blurring but can sometimes work better than increasing the size.

• 3x3 Filter: Additional filtering options are available here, including: surface edges, find
edges, point, sharpen, sharpen more, and gradient filters in each direction (N,S,E,W).

Consult any standard image processing textbook to see which filter is best for the type of noise or
feature you are trying to suppress or enhance. Also consult the Igor Pro user guides, as most of the
image filters are built-in Igor Pro functions.

Note
To remove spiky noise on surfaces, consider the Median filter. Unlike
Gaussian filters which tend to blur everything, median filters can remove
noise while preserving edges.

An example of how to apply a 1 pass 3×3 median filter on an image:

1. With a Display Window image open and the desired image channel to modify as the forward
most tab (for example, Height Trace (HtT) in Figure 7.3 on page 36), click the M button to
open the Modify Panel.

2. Select the Filter tab.

3. Select Median from the N×N Filter dropdown menu.

4. Set Size to 3 and passes to 1.

5. Click the ‘Do It’ button, located just below N×N Filter.

6. A new tab will appear in your Image Window with the filtered result.

7.2.6. FFT tab

When to use: FFT filtering can be very handy when trying to reveal an underlying periodic
structure in a sea of noise, as well as removing that periodic noise from images. Doing a fast
Fourier transform (FFT) on the image gives you a measure of the frequency components of the
image. The noise is removed by masking out regions of the FFT and decreasing their strength. The
result and the difference are reported before you confirm putting the iFFT (inverse FFT) back into
the original image.

How to use:
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1.

Select Image, Open Mod:

• With a Display Window image open
and a desired image channel to
modify as the forwardmost tab, click
the ‘M’ button to open the Modify
Panel.

2.

Select FFT tab and prepare the panel:

• Select the FFT tab.
• Make sure the ‘Auto’ Scale check box

is selected. Now change the Image
dropdown menu to make sure Auto is
selected for all three values (FFT,
iFFT, Diff).

• Click the ‘Make Graph’ button .

3.

Create mask, run the filter:

• Click the ‘Exclude Points’ button.
• Have the ‘FillMask’ check box

selected.
• Choose a drawing tool from the

pop-up to the left of the window.
• Draw rectangles or ovals around the

periodic peaks in the FFT window.
• Click ‘Make Mask’.
• Leave the FFT multiplier at

“1.00e-9”.
• Click ‘Do It’. The two square images

to the right of the elongated FFT
window will refresh with new
contents.
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4.

Result: The window on the upper right
was formed by only the spatial frequency
components inside the two selected ovals.
All the other rejected (masked out)
frequency components are shown in the
image below that. The lower image looks
largely like random noise. There is a tiny
bit of structure left in it, perhaps warranting
another attempt at drawing the masking
ovals a bit larger. But, this will do for the
purposes of this demonstration, which
preserved the majority of the low frequency
components and gave the image its long
range structure. Comparing to the
unfiltered image shows that some of the
atomic steps near the center of the image
are not truthfully represented in the filtered
result.

5.

Reinsert the result into the original
image:

• In the FFT tab (seen in Step 2
above), click the ‘Insert Layer’ button.

• Click ‘Do It’ in the next window, and
the filtered result is added as a new
layer to the original image.
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7.2.7. History tab

Figure 7.12.: History Tab.

When to use: This tab shows what modifications have been done to the current image. This is
where various steps and filters that were applied can be undone. In addition, once a series of image
processing steps have been performed on one image, they can be copied and applied to a batch of
images.

How to use:

7.2.7.1. How to apply one process to another image:

1. With a Display Window image open, click the ‘M’ button if you have not already done so.

2. With an image layer that has some image processing applied to it, select the History tab on
the Modify Panel. Here you will see a list of applied filters and processes.

3. With all or some of these processes selected, click the ‘Copy’ button. This will copy the
selected steps. A new item will appear under the Set dropdown menu, indicating that the
selected history may be applied elsewhere.

4. Select the image and layer you want to apply this process to. Select the appropriate history
choice from the Set menu.

5. Click the ‘Execute’ button, and the series of steps will be applied to the new image.

Note If the process is particularly elaborate, save the current experiment history so it can be used
to process future images. If the images have been killed and reopened, the history window will not
show what modifications were made. FFTs are not listed in the history.
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7.2.7.2. How to apply one process to many images:

1. Perform steps 1 through 4 above 7.2.7.1.

2. Check the ‘Global Execute’ checkbox at the top.

3. Click on the ‘D’ button to bring up the display manager.

4. Select the images you want to operate on. Note that only displayed images are listed here;
you many need to display more images from the List panel see Section 7.1.2 on page 35.

5. Go back to the History tab and click ‘Execute’, and those steps will be applied to all of the
images selected in the Display Manager panel.

7.2.7.3. How to remove one step from a multi-step process:

1. Make sure that only the steps you do want to do are selected in the history list.

2. Make sure the ‘Global Execute’ check box is NOT selected.

3. Make sure the ‘Restore Prior to Execute’ check box is selected. This will undo all the mo-
difications to the current image first, and then go through the history, applying the selected
steps.

4. Make sure Set is set to current layer.

5. Click execute.

7.2.8. Prefs tab

Figure 7.13.: Modify Panel preferences

This tab has two complicated controls that do not seem to belong in any other section.

7.2.8.1. Modify Insert Layers

This is the checkbox shown in Figure 7.13 on page 68. We already mentioned in Tab Naming Con-
ventions on Step 6 on page 36 that modifying a layer places the result in a new layer with an asterisk
in its tab. This new layer creation is the default behavior when ‘Modify Insert Layers’ is checked. If a
modified layer already exists for a certain channel, more modifications will overwrite that layer. In
other words, filtering a raw data layer automatically creates a scratch copy. Subsequent filtering of
that scratch copy will keep overwriting the results of the scratch copy. This preserves your original
data while preventing the pileup of countless scratch copies.
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Example: Your data has Height Trace and Deflection Trace. You apply a flatten to the height layer.
With Modify Insert Layers not checked, the original height layer would be overwritten. If Modify
Insert Layers is checked, then you will get a new layer called HtT*0 which has the flattened height
data. If you were to then view the HtT*0 layer and do a filter on it, the data in that layer will
be overwritten, regardless of the state of this control, with the flattened and filtered height data.
Finally, you go back to the original Height Trace layer and do a planefit. The HtT*0 layer will be
overwritten with the original height data, followed by the planefit; you lose the flatten and filter.

7.2.8.2. Undo Only Last Planefit

This check box changes how ‘Undo Planefit’ works.

• When not checked, everything works the way it used to. When the ‘Undo Planefit’ button
is clicked, it undoes all the consecutive planefits applied to the selected image. In addition,
when this control is not checked, it is impossible to undo a planefit once another operation,
such as a flatten, has been performed. The planefit can only be removed if the layer is
restored.

• When checked, clicking on the ‘Undo Planefit’ button will undo only the last planefit. If a first
order planefit is applied after a second order planefit has been calculated, only the first order
planefit will be removed. When this control is checked, a planefit can be undone at any time,
and no other modification will be reversed. The only other way to do this would be to use the
History tab (see Section 7.2.7 on page 67). Finally, if this control is checked, then you can
undo the RealTime Planefit; this function is completely backward compatible. You can load
up old data and undo the RealTime Planefit. There is no other way to reverse the RealTime
Planefit.

7.3. The Analyze Panel

The Analyze panel is where roughness, line sections, histograms, and particle analysis of image
data can be performed.
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7.3.1. Roughness Tab

Figure 7.14.: The Roughness tab of the Analyze Panel.

When to use: This tab provides statistics on images. When used with the Section 7.2.4 on
page 59, it can also provide statistics of the unmasked portions of the image. The topmost image
will have its statistics displayed. See the gray help buttons (question marks on right side) for des-
criptions of statistics. If the image is masked, then the Masked Image column will have the statistics
excluding the masked pixels.

How to use:

1. With a Display Window image open and the desired image channel as the selected tab (for
example, Height Trace HtT in Figure 7.3 on page 36), click the ‘A’ button to open the Analyze
Panel.

2. Select the Roughness tab.

3. View statistics of the currently selected channel.

4. Click the ‘Export Roughness’ button to create a text file of the statistics and save it to the
directory from which the image originated.

An example of image roughness measurements relative to surface features contained by the mask
is shown in Figure 7.15 on page 71. You can download this image from here: http://www.

AsylumResearch.com/Files/Data/RoughnessExample.zip. Panel A shows an image of an
elastomeric mold that contains no image mask. Notice the Masked Image column of the Roughness
tab shows Nan, “Not a Number”, because there is no mask. Panel B shows the result of an iterative
mask with ‘Inverse’ checkbox NOT activated. The values in the Masked Image column represent
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the areas outside the mask that include the lighter areas of the image. Finally, in Panel C, the mask
was manually set to include the smaller features of the mold above the plane of its main surface;
these statistics represent the image with the ‘Inverse’ checkbox activated.

Figure 7.15.: Roughness Panel statistics: A) Unmasked image; B) Iterative mask results; C) Manually
adjusted to mask smaller features at top of pattern.
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7.3.2. Section Tab

Figure 7.16.: The Section tab of the Analyze Panel.

When to use: The Section tab allows you to make line section sto extract image data. Both
straight lines and curves can be defined. The lower portion of the panel provides measurements
alon the image section.

How to use:

7.3.2.1. Straight Line Sections:

1. With a Display Window image open and the desired image channel as the selected tab (for
example, Height Trace, HtT in Figure 7.3 on page 36), click the ‘A’ button to open the Ana-
lyze Panel.

2. Open the Section tab.

3. Make sure Mode is set to Line.

4. Make sure the ‘Angle’ checkbox is unselected.

5. Click the ‘Draw’ button.
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6.

Draw a line:

• Click the spot on the image where
you want the section to start. Hold the
mouse button down.

• Drag to the endpoint of the section
and release the mouse button.

• Note the two cursors at the ends of
the line section. They can be dragged
to other locations in order to reorient
the line section.

Optional Select the ‘Full Width’ checkbox if
you want the line section to extend to the
edges of the image.

.

7.

View section:

• Once the line is drawn, a Section plot
appears.

• Drag cursors from the bottom of the
trace graph onto the trace;
corresponding markers appear on the
image.

• Positions and distances between the
cursors are displayed in the lower
half of the Analyze Panel.

Optional Click the ‘Export Table’ button on
the Section Panel if you want to store the
information.

8.

Average over multiple lines:

• Increase the pixel width of the line to
average the section over a broader
path. The control is located next to
the ‘Full Width’ checkbox.

• The section graph will update
automatically.

Note The width uses units such as “n” for
nanometers or “P” for pixels. .
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Leveling Line Sections If an image happens to possess some tilt, as is usually apparent from
section data, using the Igor cursors to measure a meaningful height difference is not an easy pro-
cess. One possibility is to perform a first order XY planefit on the image before making sections, as
was discussed in Section 7.2.2 on page 52. An alternate solution based on manual subtraction of a
linear background can be executed if the section data are already on screen. The latter is described
below.

1.
Hold down the ‘Ctrl’ key while moving the
mouse pointer over the curve. An up/down
arrow cursor will appear.

.

2.
Click and drag vertically to change the
underlying slope of the curve. Then,
manually level the background.

.

Note Be sure not to confuse these leveled curves with real, unmodified data. Only the section
profiles are altered, and this modification will be undone if the section is updated.

Adjust the XY Angle of the Section Line on the Image There are two ways to adjust line section
angles with the section drawn:

• Move one of the end cursors on the section line by left clicking and dragging it to a new
point.

• Select the ‘Angle’ checkbox, then manually adjust the angle by typing values into the Angle
field on the Section Panel (Figure 7.16 on page 72).

Note Once the ‘Angle’ checkbox is selected, the section cannot be rotated with the cursors.

7.3.2.2. Free Hand Lines

Free hand lines are curved lines that are drawn by hand.

1. With a Display Window image open, and the desired image channel as the forwardmost tab
(for example, Height Trace (HtT) in Figure 7.3 on page 36), click the ‘A’ button to open the
Analyze Panel.

2. Open the Section tab.
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3.

Set up for drawing:

• Select Free Hand from the Mode
menu.

• Click the ‘Draw’ button.
.

4.

Draw the curve:

• Click and drag to draw the cursor
path through the surface features of
interest.

• Once the mouse button is released,
the line becomes a series of square
points.

• [Optional] By click-dragging these
points, you can modify the curve.

.

5.

Finalize the section:

• Click anywhere on the image away
from the curve.

• The square points disappear, and a
section graph will appear on screen.

.

Plotting Multiple Line Sections on One Section Plot:

1. Make a section of an image layer using one of the methods described above.

2.

Create a copy:

• In the section graph window click the
‘Take a "Snap Shot" of active trace and
append to upper graph’ button.

• The current trace is copied to a
second graph, while the bottom graph
is empty and awaits a new section.

Optional Double click the upper graph and
change its color.
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3. Make another section of an image layer as described above. A new section will appear in the
lower graph.

4.

Overlay multiple sections:

• Click the ‘Snap Shot’ button again to
join the lower graph with the other
curve on the upper graph.

• Repeat this process as many times as
needed.

• ‘Ctrl’+click the ‘Snap Shot’ button to
append the section to an invisible left
axis. This is good for comparing
sections of different data types, such
as phase and amplitude, as the section
will not need to share the same axis
range.

• ‘Shift’+click the ‘Snap Shot’ button to
simultaneously append the marker
distances (located in the bottom half
of the Sections panel) to a notebook.

Exporting Sections as ASCII: Click the ‘Edit’ button on the Section Graph. This will create
an X,Y delimited table from which the columns can be copied and pasted as text into any other
program.

7.3.3. Histogram tab

When to use: This tab allows you to view histograms of image data. Histograms are the result
of taking data arrays and counting how many times a value falls within various ranges of values,
called bins. This can give an estimation of the probability distribution of the data.

How to use:

1. With a Display Window image open and the desired image channel as the selected tab (for
example, Height Trace HtT in Figure 7.3 on page 36), click the ‘A’ button to open the Analyze
Panel.
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2.

Histogram Analysis Panel:

• Click the Histogram tab.
• Click the ‘Make New Histogram’

button, and a histogram graph
automatically appears.

• If you have a histogram graph already
up, you can append to that graph with
options to the right of the ‘Make New
Histogram’ button.

3.

Histogram Result Graph:

• You can put multiple histograms on a
single graph from the Histogram tab.
There will be a dropdown menu to the
right of the Make New Histogram,
listing the existing histograms. Select
one of those to append the current
data set to that histogram.

• The Select Histogram control on the
histogram graph will set which
distribution the rest of the controls
work on.

7.3.3.1. Fitting

• There are three distributions built into the software: Gaussian, Poisson, and Lorentzian.
• Select the model in the Fit Type field, then click the ‘Fit’ button. There are more options

available in the dropdown menu to the right of the this button.
• The parameters from the fit are displayed under the ‘Fit’ button.
• To append the fit parameters to the graph, use the dropdown menu to the right of the ‘Fit’

button and select Label Fit.
• To fit a subregion of the distribution, mark the start and stop with the cursors. Press ‘Ctrl’+‘i’

to show the info window, then drag the circle and square to mark the start and stop of the fit
region.

7.3.3.2. Data Modification

To do offsets of the image data, place the cursors at the positions you want to be zero. Press ‘Ctrl’+‘i’
to show the info window. Then drag the A (circle) or B (square) cursor where you want zero to be.
Then go to the Commands dropdown menu and select “Set cursor A to 0” or “Set Cursor B to 0”.
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7.3.3.3. Other Options

Edit This button displays a table of all the values of the image that created the current histogram.
You can press ‘Ctrl’+‘A’ to select all the values, then copy and paste them into any program.

Bins You can adjust the slider to change the number of bins in the histogram. If you have multiple
histograms, the ‘Link Bin Sizes’ checkbox cann ensure that all the histograms have the same bin
size.

Mask Place Igor cursors around the region you want to have masked. From the Commands drop-
down menu, select “Make Mask from Cursors”. Now that there is built-in histogram on the Mask
panel, this is not as useful as it once was.

Crop You can crop data outside the cursors from the Commands dropdown menu. This will remove
data from the histogram outside of the cursor range set. This is useful if the wide distribution of a
few data points makes it difficult to see details in the distribution.

7.3.4. Particle Tab

When to use: This tab allows you to analyze particles or features of an image defined by a mask.

How to use:

1. Create a mask that defines the particles on an image. To bring up the Mask panel, click the
‘M’ button on the image window and select the Mask tab.

2. Open the Analyze Panel by clicking the ‘A’ button on the image window, then select the
Particle Analysis tab.

3. Click the ‘Analyze Particles’ button. When the software is finished analyzing, all of the parti-
cles will be selected. To select only the particles you want, hold down the left mouse button
and drag the cursor over them.

4. Click the ‘Detailed Stats’ button. This brings up the Particle Analysis Stats Panel that will
display the attributes of the currently selected particles.

5. From this panel, you can graph the attributes by clicking on the buttons to the right. The
leftmost button is for a histogram, the next button is for a distribution, and the last two are
for plotting Y attributes vs 1 or none X attributes. See Step 4 on page 83.

7.3.4.1. Particle Analysis Example 1: Finding the Length of a Piece of DNA

In this particular example, we will be using an image of DNA on mica. You can download this
image file here: http://www.AsylumResearch.com/Files/Data/FlatteningExample1.zip. We will
use skeleton erosion to find the length of a strand of DNA. This method works best on thin particles
with curves, where a straight line measurement is not appropriate, making DNA a good candidate.
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1.

Flatten image:

• This is the same image used in the
flatten example. For details on
flattening the image, see
Section 7.2.1.1 on page 41.

• For this experiment, the image should
already be flattened and it should
appear as it does to the right.

2.

Apply mask:

• From the Mask tab on the Modify
Panel, apply an appropriate mask that
covers the DNA completely, as shown
in the figure atright.

• For details on applying a mask, see
Section 7.2.4 on page 59.

3. From the Particle Analysis tab on the Analyze Panel (Figure 7.17a), click the ‘Analyze Parti-
cles’ button. A progress bar will appear (Figure 7.17b), and a blue overlay will appear on top
of the mask (Figure 7.17c).

(a) Analyze Panel (b) Progress Bar (c) Blue Overlay

Figure 7.17.: Analyzing Particles
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4.

Selection of particles:

• When analyzing of the particles has
reached completion, all of the
particles will be selected in a green
outline.

5.

Reset the mask:

• On the Mask Panel, you can reset the
mask to make it easier to see the
particles.

6.

Un-select the particles:

• Left-click anywhere on the surface to
un-select all of the particles.

• Then, move your cursor over to the
upper-left strand of DNA.

• When the cursor is over it, the particle
will turn green.
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7.

Detailed view:

• Right-click on the particle and choose
Detailed View of Particle.

• This opens a detailed view of the
particle, as shown in the figure to the
right.

8.

Start Skeleton:

• Click the ‘Start Skeleton’ button.
• The particle will change to a lighter

orange, as shown in the figure to the
right.

• Click on the ends of the particle with
the mouse cursor. These two points
will be shown in blue.

Note The skeletonizing process works by
eroding the particle until it is a single line
thick. It is possible and often occurs where
the resultant skeleton will have multiple
branches. The two points choose are
considered safe and can never be eroded, so
they preserve their respective branches,
while any other possible branches are
completely eroded away.

9. When you like the end points selected, click the green checkmark button.
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10.

Completed skeleton:

• Another progress bar will appear.
When it is finished, you should see
something like the figure at right.

• In our case, we see the skeleton
consists of 4 segments: a light blue
segment at top, a green segment at the
bottom, and two tiny segments in the
middle (yellow and violet). This
happened because the mask itself had
a tiny hole in it that caused a loop.

• If you mouse over the different
segments, they will highlight with
their individual distances displayed at
the mouse cursor. Clicking on the
segment will show it and other
clicked-on segments combined
distance in the upper right.

Note The software automatically calculates
the shortest path and displays it in white un-
derneath the segments. In this case, it is a
combination of the blue, violet, and green.
If you zoom in, you will see the yellow seg-
ment is longer than the violet and not nee-
ded to make the shortest path. The combi-
ned distance is shown as a tag. In this case,
we got 696.81nm long. Your results will
vary depending on the end points chosen.

7.3.4.2. Particle Analysis Example 2: Finding Average Height

In this example, we will be finding the height of the raised features (particles) of a SEB sample.
We will use the modified height layer, which has already been flattened.

1.

Create Mask:

• To start, we first must create a mask
to define the particles just like in
Section 7.3.4.1 on page 78.

• In the figure on the right, the mask
was calculated as an iterative mask,
then eroded twice to make sure to
exclude the boundary portion.

Note Since we are only looking at the
height of the particles we do not have to
check the "Ignore Edge Particles"
checkbox. If we were interested in the
geometry of the particles we would want to
ignore the edge particles.

2. Click the ‘Analyze Particles’ button. After it has finished, you may click the ‘Reset Mask’
button on the mask panel to remove the mask from the image. By default, all of the found
particles will be selected with a green outline.

support.asylumresearch.com Page 82



Ch. 7. Introductory Image Analysis Sec. 7.3. The Analyze Panel

3. Click the ‘Detailed Stats’ button. A new panel will come out with a list of attributes. The
value displayed next to each attribute is always the average of the selected particles. Since
we currently have all of the particles selected, we are looking at the average of them all.

4.

Find the Height of Raised Features

• We want to know the height of the
raised features, and have 3 different
values to use:

– Maximum Z: The largest height
found on the particle

– Center Z: The value of the exact
center of the particle

– Average Z: The height value
averaged over every pixel of the
particle

• The first two options are more
appropriate for spherical particles. In
this case, we will use the Average Z.
So at this point we have the Average
of all the particles’ Average Z. The
value is 21.242nm as shown in the
figure to the right.

5.

Distribution Plot:

• If we click the second button to the
right of the Average Z value, we can
bring up a distribution plot.

• Notice that over 90% of the particles
are below 30nm, with a few that are
much higher. These high values are
due either to impurities on the sample
or to the tip having trouble tracking.
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6.

Change the Range:

• If we look at the image with a large
range, the particles we are interested
in become grayed out, but the
offended areas remain white.

7.

Remove Offending Particles:

• We could simply shift-click on the
three offending particles to remove
them, but doing it by hand is not
always ideal.

• Instead, from the Particle Analysis
Panel, click the ‘Filter’ button. A filter
panel (PA Search Panel) appears.

• Click the checkbox next to Average Z.
• Change the filter type to Less than <.

In the high value, enter 40nm.
• Click ‘Find Particles’. The software

will then select only those particles
that have an Average Z of less than
40nm.

8.

• The selected particles should look
like the figure to the right, with the
offending particles not selected.
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9.

Histogram of the Data:

• Recheck the PA Stats Panel (see step
4) and note that the Average Z value
has changed to 20.170nm.

• Click the button just to the right of the
Average Z to bring up a histogram of
the data.

• Change the bin size and then apply a
fit of the histogram data to get a Mean
and Standard deviation value.

7.4. Miscellaneous Operations

Below are some useful operations for image processing.

7.4.1. Saving modifications to images

Any image modification can be saved by going into the Commands dropdown menu and selecting
one of the “Save...” options.Save as will ask you to rename the file, then to select the path you
want to save the image to. Save and Save then Kill will both save over the original file, but Save
then Kill will close the image after saving it.

You can also save multiple images from the List panel. To do so, select the images from the
Memory column on the right, and then click on Save or Save as. Save as will ask for a new
location in which to save the data.

7.4.2. Custom work on image channels

7.4.2.1. Extracting layers:

A copy of an image layer can be extracted into its own image containing just that layer. Math can
then be done on that layer, or the layer can be packaged into individual files.

1.

Select layer to extract:

• With the desired channel as the
selected tab, select Extract Layer in
the Commands menu.

• [Optional] ‘Ctrl’+click one of the six
letter buttons to set it to Extract Layer,
as described in Section 7.1.3.1 on
page 38.
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2.

View the extracted layer:

• Open the List Panel (see Section 7.1.2
on page 35).

• To view this file, double-click
LayerData.

Note

If you intend to extract several layers in succession, you must rename the
LayerData name manually between extractions. The LayerData name gets
reused and overwritten with every extraction. To rename the layer, select the
LayerData file, and choose ‘Rename Images’ from the List Panel. There is an
advanced command line technique for extracting multiple layers without
renaming, described below in Section 7.4.2.2 on page 86.

7.4.2.2. Subtracting Image Layers:

Subtracting image layers entails a pixel-by-pixel subtraction of one image layer from another. This
can be useful for comparing lateral trace and retrace data.

You can download the file for this example here: http://www.AsylumResearch.com/Files/

Data/SubtractExample.zip

1.

Extract the first image layer:

• In the Display Window of the image
layer you wish to perform the
subtraction on, select the lateral
retrace image, and then select Extract
Layer from the Commands menu.

• The images in memory column of the
List Panel will now have LayerData as
a choice.

Optional To see the image, select
LayerData and click the ‘Open Images’
button.

.
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2.

• Back in the List Panel, select LayerData in the right column. Click the ‘Rename Images’
button. The New Name dialog will appear; enter any name to finish the renaming process. In
this example, the new name is “LatRetrace”.

• Alternatively, in the Command line, rename that extracted layer to whatever you want. For
this example, the command would be:

Duplicate/O layerdata LatRetrace

3.

Extract the second image:

• Go to the lateral trace image and
select Extract Layer from the
Commands menu.

.

4.

• In the Command line, subtract one channel from another:

Layerdata = Layerdata -LatRetrace

-OR-

layerdata -= LatRetrace

5.
Reinsert the result:

• Reinsert the layer (see Section 7.4.2.4
on page 88) into the original image.

.
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7.4.2.3. Rotating Images:

In some rare instances, an image must be rotated, typically by increments of 90°.

Figure 7.18.: Image Rotation and the Command window

To rotate an image:

1. Extract the desired layer (see Section 7.4.2.1 on page 85).

2. In the Command line, type:

RotateImage(LayerData,Degrees)

where Degrees is the angle you want to rotate the image.

7.4.2.4. Reinserting layers:

Once an extracted image layer has had some changes applied to it, it can be reinserted into the
original image.

1. Only the last extracted layer can be reinserted.
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2.

Open the original image:

• From any Image Display Window
select Insert Layer from the
Commands menu. The software
automatically sends the LayerData
back to the original image.

3.

Insert Layer dialog box:

• The Insert Layer window will pop up.
• Either choose to overwrite the

original layer from which the layer
was extracted, or to direct the data to
a new modified layer tab.

• Notes can be added to the new layer
in the large text box.

• Click ‘Do It’.

7.4.3. Cropping Images:

Cropping images is relatively straightforward. This section will discuss basic image cropping by
eye first, and precision cropping second.

1. Either copy the .ibw file in Windows or extract a layer (Section 7.4.2.1 on page 85) before
cropping an image; cropping will delete the excess data, so it is generally safe practice to
crop a copy of the data lest in order to protect raw data.
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2.

Zoom in on the area of interest:

• Click+drag an area of interest.
• Right-click and select Expand or

Square Expand.
• You can then ‘Alt’+drag to pan the

view.

Note Square Eexpand only works for
offline data, not real-time imaging.

Notice The scales do not have their origin
at zero.

.

3.

Crop and Save:

• Go to the Image Window Commands
menu and select Crop Image.

• [Optional] Go to the Image Window
Commands menu and select Save or
Save As.

Notice The scales have their origin at zero
after the cropping. The image here was
taken just prior to cropping.

.

Precision Cropping:

There is a way to crop more precisely:

1. Double-click on the number labels of an axis of the image or select Graph > Modify Axis from
the menu bar. This opens the Modify Axis Panel.

2. Manually enter the cropping area under the Axis Range tab. Note that it is necessary to enter
values in meters, so 1e-6 represents 1 µm.

3. Go to the Image Window Commands menu and select Crop Image.

4. Optional: Go to the Image Window Commands menu and select Save Image.
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7.4.4. Igor layouts

Many graphs have a useful item referring to exporting or appending data to a layout (see Section 7.1.3
on page 36).

• Any data you have worked on in the offline analysis can be put into one of these layouts by
clicking the ‘Layout’ button.

• To save the layout, go to File > Save Graphics. In the dialog box, you can determine the
name, path and file type of the layout.

• Use the Igor tool box (‘Ctrl’ + ‘T’; upper-left corner) to add text or shapes to the layout.

(a) Saving the layout as Graphics file (b) Igor Layout Example

Figure 7.19.: Igor Layouts
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This Section discusses how to perform basic force analysis on stored force (.ibw) and force map
(.ardf) files. Keep in mind, there are not necessarily hard and fast rules / sequences regarding
data processing; it depends on the data, and can be a trial and error process. For this reason, the
processing techniques are broken into sections, and some examples given.
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8.1. Opening Stored Force Plots

1.

Prepare the software

• Launch the AR software to open the
Mode Master window. (You can also
click the ‘Mode Master’ button at the
bottom of the screen: .)

• Click the ‘Standard...’ tile.
• Then select Offline Force.

2.
Open the Force Review Panel directly:

• Alternatively, you can open the Force Review Panel from the menu bar. Select AFM Analysis
> Master Force Panel

3.

Select a directory of force plots:

• If there is no force data already
loaded in the experiment, the software
asks you where you would like to
load data from when it is opened.

• For a new directory, click the ‘Load’
button (bottom left corner of panel)
and select the directory.

4.

Select a force plot to open:

• Select a force plot from the list near the middle of the panel (see Box 2 in Figure 8.1 on
page 94).

• You can make use of the various data display options outlined in Section 8.2.2 on page 95.
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8.2. Display Tab

1
2

3

Figure 8.1.: Box 1: Adjusting the Display, Box 2: Navigating the Data, Box 3: Load and Delete

8.2.1. Loading and Deleting

Loading

• When the Force Review Panel is first opened, you are asked where you want to load data
from. You can reopen this dialog by clicking the ‘Load’ (folder) icon, lcoated in the lower-
left corner of the panel.

• You can also:
– Double-click a force plot from Windows (operating system) to show it in the force

review. These force plots will be stored loose in the "memory" folder.
– Double-click force plots from the offline image browse graph to load the force plots

into the force review.
• The list in the middle of the panel includes the available force plots, sorted by folder. To

select one or more, hold down the ‘Shift’ key for contiguous section or ‘Ctrl’ for multiple
noncontiguous.
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• There is a distinction between listed in the software and actually loaded. Loading all of the
force plots at once can present many problems with computer memory, so there is a title that
specifies how many are loaded and how many are simply listed. Once you need the data
(generally for display), it loads the force plot, and it remains in memory until removed. You
can load all of the listed force curves into the experiment with the load listed curves button.

– This is dangerous with large data sets on older computers, as it can most likely result
in running out of memory errors.

Figure 8.2.: Load and Delete

Deleting

• Deleting refers to removing the force plots from the Igor experiment; it never deletes ibw
files from the hard drive. Force plots can be saved two ways: directly to memory and/or to
the hard drive as ibw files (or ARDF force maps).

• The default is to save force plots to both disk and memory and force maps only as ARDF to
disk.

Note If you change the default to save only to memory and then click on the ‘Delete All’
button, you will be deleting your only copy of the data.

• You can also delete subsets of the listed data using the ‘Select & Delete’ button and the ‘Delete
Displayed’ button. ‘Select & Delete’ opens a dialog to delete some of the force plots. ‘Delete
Displayed’ will remove the currently displayed force plots.

8.2.2. Adjusting the Display

Y Data The controls at the top of the panel are for selecting what is shown on the Y axes of
the graph. When you select a force plot for display, the text color of the channels are changed as
follows:

• Black All of the selected force curves have the channel.
• Blue Some of the selected force curves have the channel.
• Grey None of the selected force curves have the channel.

All of the selected channels from a given axis can be removed with the ‘Select None’ button, located
at the bottom of each list. You can display additional channels on any axis, but it generally works
better to give each channel their own axis. You can show up to five axes with the control at the very
top of the Force Display Panel.
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Figure 8.3.: Y Axis

X Data All of the Y data channels are plotted against one common X data channel, which is set
with the X axis popup. Typical X data types are:

• Zsnsr Heavily filtered Z sensor
• Raw Minimally filtered Z sensor
• Time Starting from the beginning of the force plot
• Sep Tip-sample separation calculated from Z Sensor and deflection
• Ind Tip-sample indentation, calculated from Z sensor and deflection

Note Both Sep and Ind require that Invols is correctly calibrated.

Figure 8.4.: X Axis

Section The force plot is broken into various sections:

• Extend (Ext) Where the tip is approaching the surface.
• Retract (Ret) Where the tip is withdrawing from the surface.
• Dwell towards (Towd) the surface.
• Dwell Away (Away) from the surface.

You can control which sections are shown in the middle-left of the Display Panel.

Advanced There are more advanced, lesser-used display options on the Prefs tab. For more
information, see Section 8.3 on page 99.
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8.2.3. Navigating the data

Figure 8.5.: Navigating the data

Viewing Force Plots

• Use the list to directly select which force plots you want to see. It can be useful to collapse
the list when switching between folders (force maps).

– Click the ‘+ Expand List’ button to list all of the folders. The button will change to ‘-
Collapse List’.

– Click the ‘- Collapse List’ to collapse all folders in the list. The button will change to ‘+
Expand List’.

– Click the ‘±’ sign to the left of the folder to expand/collapse a single folder.
• Use the ribbon of buttons to adjust the list:

– Use the arrow buttons to jump to the next (or previous) force plot in the list.
– Use the - and + buttons to add or subtract from the number of displayed force plots.

• You can also use the keyboard to navigate the list:
– Right or Down arrows move to the next force plot.
– Left or Up arrows move to the previous force plot.
– ‘Page Up’ and ‘Page Down’ move up or down, respectively, in the list by larger step sizes

(12 on most computers).
– ‘Home’ and ‘End’ move to the first or last force plot in the list.
– ‘+’ or ‘- ’(on a keypad) add or subtract one of the force plots to the graph.

Note These can all be done from any tab of the Force Review Panel or from the Force Review
Graph.

Movie Player Use the ‘Movie’ button to display the FP Move Player to play through the force
plots in a slide show. For more detailed information, refer to Igor software ‘Tool Tips’. (To toggle
‘Tool Tips’ on or off, press Ctrl + 1.)
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Figure 8.6.: FP Movie Player

support.asylumresearch.com Page 98



Ch. 8. Force Curve Analysis Sec. 8.3. Pref Tab

8.3. Pref Tab

Figure 8.7.: Pref tab on the Master Force Panel

General

• This panel is for advanced formatting of the Force Review Graph. If you are familiar with
Igor, you know there is very large set of display properties that you can set, including line
width, line style, and markers.

• This panel has a system of determining what user actions have been done to the force review
graph and records those actions to apply again. This panel refers to that as the macro.

– Note that macro has many other meanings in a different context.
• The top of this panel allows you to turn the Macro on or off. The bottom of the panel allows

you to update the macro, as well as open the macro in a table for direct editing.
• The ‘Reset Macro’ button will put the Macro back to the default state. This is a good safety
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measure, because the changes you make to the macro will automatically be saved to disk and
reloaded the next time you start Igor.

Line Style

• The default line style is to display the force plots with solid lines when only a single data
type is on a given axis and to switch to data type specific line style when multiple data types
are on the same axis.

• You can set this to always be solid, or always be set by data type, or to call a user-specified
function to set the line style.

• The data-type specific line styles are also set here.

Figure 8.8.: Line Style

Line Color

• The default line color is to display each section (Extend, Retract, Dwell) as a different color
when there is only one force plot on the graph.

• When there are multiple force plots, each force plot is automatically assigned a different
color from a color table. The color table can wrap around; so if enough force plots are
shown, it will reuse the same colors.

• You can set this to always be color table, always be color by section, or to call a user-specified
function to set the line color.

• If you have multiple force plots on the graph, you can double-click on the trace and then
change its color. Then on the force graph, there is a split button labeled ‘Review Graph’.

– In the Review Graph dropdown list, you select Update Color Table. This will look at
the graph, see what has changed, and then update the color table so that the next time
you build a graph, it will use your color. You should also see the lower list on the Force
Display Panel update with your new color.

– There is also an Update Color Table button on the Prefs tab.
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Figure 8.9.: Line Color

X Orientation

• ‘Keep surface to the left’ When selected, most data types will have the surface on the left.
• ‘Keep surface to the right’ When selected, most data types will have the surface on the right.
• Indentation is the opposite of other data types (surface will be on the right when set to keep

on left).
• Time is increasing when the surface is set to the left.

Figure 8.10.: X Orientation

Miscellaneous

• Auto Stack Force Axes is on by default, which means the Y axes will be placed so they do
not overlap. When this is turned off, then all the Y axes will be overlapping on top of each
other.

• The Macro controls are discussed at the beginning of this section (see Section 8.3 on page 99).

Figure 8.11.: Miscellaneous
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8.4. Parm Tab

The Parm tab lists the parameters associated with each force plot. Some parameters are editable
and, when changed, update the data. Most parameters are simply viewable.

Figure 8.12.: Parm Tab

Editable Parameters

• The top half of the panel deals with parameters that can be changed, mostly calibration
values, such as spring constant and invols, or scaling factors for user channels. Only the first
five displayed force plots have their parameters shown.

• Once you have made a parameter change, you can apply that change either of following ways
to:

– selected force plots with the ‘Set Selected’ button
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– all listed force plots with the ‘Set All’ button.

Note This is very memory intensive, as it tries to load all of the force plots in order
to apply the modification. Older computers typically cannot deal with 1000’s of force
plots.

Parameter Search

• The bottom half of the tab resports the rest of the parameters. It works well if you can guess
part of the name of the parameter you are interested in, type it into the ‘Search’ box, and the
resulting list will be reduced to only those that match the search string.

• The ‘Copy’ button takes the resulting list of matches (or selected lines) and put it in the
clipboard. You can still use the keyboard shortcuts when this panel is topmost (left/right
arrows go to the previous/next force plot). Only the first five force plots displayed have their
parameters shown.

Note The ‘Search’ box can be turned on and off in the Setup.

8.5. Cursor Tab

Figure 8.13.: Cursor Tab

The Cursor tab is used primarily for marking regions of interest (ROIs) for the Worm Like Chain
(WLC) tab (see Section 8.7 on page 107).

You can set the ROI at any time on the Force Review Graph.

• To set a new point: Shift + left-click on the trace at a new point.
• To select an existing point: Shift + left-click on an existing point.
• To deselect an existing point: Shift + left-click on the selected point.
• To change the selected point: Drag the A cursor after selecting the point of interest.
• To remove a point: Ctrl + Shift + left-click on an existing point.

The Cursor tab allows you to modifiy the behavior of how the above Force Review Graph shortcuts
work, as described below.
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Limiting You can limit where you put new markers by segment and by force plot. This can be
useful if the data is overlapping and you want to make sure you put the markers on one specific
trace. To limit by section, use the list box; the checked segments are segments where the markers
are allowed. Turning off a section removes any markers in that segment. You can also limit by
trace, but this is only useful if you are plotting multiple force curves.

Clearing You can clear markers from traces by:

• Selecting the trace you want to remove from the ‘Clear Locks From Trace’ menu.
• Turning off sections. The markers will then be removed from the excluded sections.
• Ctrl+clicking on the markers you want removed.

Figure 8.14.: Clearing and Highlighting

Highlighting You can make the markers on a trace larger by using the ‘Highlight Locks From
Trace’ control.

Editing

• You can modify a marker by Shift+clicking on it (you may need to zoom in if there is another
marker near the one of interest). You should see a circle around the marker. You can then
drag that to another location or use the arrow keys (left or right) to move the position of the
marker.

• For more advanced editing, the Locks field in the editable parms can be used to update the
markers. See Section 8.4 on page 102.
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8.6. Modify Tab

1
2

3

Figure 8.15.: Box 1: Modify Box 2: Undo/Redo Options Box 3: Save Options

8.6.1. Modifications

You can remove offsets and lines from the data. These operations work on the currently displayed
force curves or all of the force plots listed. Operating on all the force plots listed can be extremely
memory intensive. It will need to load the force curves into memory, do the modification, and keep
the data in memory. Older machines running Win XP cannot process very large data sets. It is
better to break the data into smaller data sets (move groups into sub folders in windows) or only
modify the data as needed.

Automatic Offsets

• These operations are in terms of X and Y axes, whatever the force plot is displayed as. The
offsets find the zero point in the Retract or the extend data (based on the state of the radio
buttons to the left). see also: Offset algorithm below.

Manual Offsets

• You can right-click on the Force Review Graph to select X, Y, or XY offsets. The position
where you click will be set to zero for the axes selected.

Line
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• You can subtract a line from the data. Press Ctrl+i (i for info) when the graph is topmost and
drag the A (circle) and B (square) cursors to define the region you want to fit to a line. The
line is extrapolated over the entire force curve and the line subtracted.

Offset Algorithm

• The Y Offset takes the average of the last 10 points for retract data or the average of the first
10 points for extend data as the zero point. If your force plot was taken using the Indenter
panel (or Indentation Master panel), the offset is taken as the min of the dwell towards the
surface.

• The Raw (X) offset uses the function GetContactSlope to find the rough estimate of the
surface contact point. It does this by fitting the slope of the deflection vs. ZSnsr in small
(~7 points) chunks until the slope is > 0 (see function FindSurfaceIndex). It then fits the
deflection from 20% force to the contact point and extrapolates that line to where it intersects
the zero force.

– If you do not have deflection data, then this function will not modify to the data.

Note This is the simple algorithm. The elastic panel has a much more involved iterative method
of better finding the contact point. See Section 8.10 on page 115.

8.6.2. Undo, Restore, and Save

These operations all work on:

• The last modified force plot
• A selected subset of the force plot
• All of the force plots listed

Save FMap works on:

• A single selected force map
• All of the force maps listed

Attention
Typically, operating on all force plots listed is memory intensive, but the Save
As All operation will remove force plots that it loaded as it goes, and so the
total amount of memory used for this operation should be minimal.

Undo

• These buttons toggle between undo and redo. They undo all of the last type of change.
• For example, you change the InVOLS on a force plot 20 times. Clicking ‘Undo’ last will

undo all the InVOLS changes and revert the force plot to it state before any InVOLS changes
have been made.

Figure 8.16.
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Restore

• These buttons restore the specified force plots to their original state, which is typically the
hard drive state. For force plots only saved to memory, there is an extra copy of the data
before modifications were done to the data that is used.

Figure 8.17.

Save

• ‘Save’ and ‘Save As’ save IBW files. If the source is an ARDF, it will convert to the old loose
style of ibw files. Be careful with this since you may end up with a large number of files,
making things slow; however, it can be useful for exporting the data into other packages.

• ‘Save As’ asks you once for the root folder you want to save to. You cannot rename files, as
it is possible to save many, many files with this operation.

• ‘Save FMap’ will save ARDF files, which are packages of force plots. If the selected force
map is really from ibw files, it will still save as an ARDF, so this is a good way to convert
old style force maps to newer ARDFs. Note that Save FMap only works on a single selected
force map or on all of the force maps listed in memory.

Figure 8.18.

8.7. WLC Tab

This tab is used to fit polymer stretching events to the Worm Like Chain (WLC) model.
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Figure 8.19.: WLC Tab

8.7.1. Force WLC Models

The Multi Chain checkbox switches between the Single Chain (multiple attachments) and the Mul-
tiple chains (single attachments) models.

The difference between these two extremes is in how the stretching events (Hitches) are added
together:

• Single Chain, then it adds the WLC response only in the error region.
– Applicable if each response is NOT influenced by the other stretches.

• Multi Chain, then it adds the WLC response to the entire stretch.
– Applicable where the observed response is the sum of the individual responses.

The difference between these two cases can be made more apparent by turning on the ‘Show Indivi-
dual Stretches’ check box.

If the Single Pers checkbox is selected, all the stretching responses are fit to one persistence length.
If you believe that all the stretching events are from the same type of polymer (in particular the
single chain extreme), selecting this will force each response to have the same persistence length.

8.7.2. Getting Started

How to fit force plots with the WLC model:
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1. Find the force plot you want to fit.

2. Plot it as Force Vs. Sep (Sep is short for tip-sample separation). The X axis is controlled
with the Force X axis popup menu beneath the Y axis Data Type list, located on the Display
tab.

3. You need to define where 0,0 is. To set the offsets, you can either:

a) Right-click on the graph to offset X and Y so that the force is zeroed and the tip hits
the surface at zero separation, or

b) Go to the Mod tab and click on ‘Y offset’ and ‘Raw (X) offset’.

4. Go to the Cursor tab and select that you only want cursors on Ret (short for retract) Force
Cursor Sections.

5. Shift + left-click on the graph to define the stretching regions. You want to define the error
region of the fitting function; so pick one point where the polymer ruptures its attachment
to the tip and pick the other point at the lowest extension as the data looks like it will be
fit. You can fit multiple stretching events in a single force plot. If you want to do that, pick
two "locks" (cursors) to define each stretching event (the software calls polymer stretching
events “hitches”).

6. Open the WLC tab. Make sure that the initial state of the parameters is close to the data;
the fitting function often throws up its hands in despair if the initial guess is too far from the
data:

a) The pers is the persistence length; it is basically a measure of the polymer’s stiffness.
Lower persistence lengths have much more non-linear responses.

b) The extension ratio is the fraction of the contour length that the polymer chain is
extended. The fit parameter is the extension ratio where the polymer chain ruptures
its attachment to the tip (max extension ratio). Therefore, you can get the contour
length of the chain from the rupture length divided by the max extension ratio.

7. Once you have your fit parameters fairly close to the data, you can then click ‘Fit’.

8. If you have multiple hitches in a force plot that you want to fit, then there are two questions
you have to answer:

a) Is the observed response due to one chain with domains or loops or is each hitch the
result of stretching a separate chain? If you think you have a single chain, you want
to unselect ‘Multi Chain’ (upper-left corner) Force WLC Models. If you think that each
hitch is from a separate chain, then select ‘Multi Chain’.

b) Do you think that each hitch should have the same persistence length? Generally, this
is the case, but it is not required by the fitting function. If you want to fit each hitch to
a single persistence length, select ‘Single Pers’; if you want each hitch to have its own
persistence length parameter, then unselect ‘Single Pers’.

9. You can also hold and constrain each of the fit parameters using the hold and constrain
checkboxes:

a) Hold means that the fitting function will hold that parameter constant and not fit it.

support.asylumresearch.com Page 109



Ch. 8. Force Curve Analysis Sec. 8.8. Analyze Tab

b) Constrain means that it will keep the fit parameter between the upper and lower limits.
The limit controls show up after you constrain one of the parameters. The constrain
option does not always work well; often when the fit fails, it will run the parameter into
the limit.

10. Once you like the fit, you can show the individual responses by clicking on the ‘Show Indi-
vidual Stretches’ checkbox. You can then label the contour length of each response with the
‘Tag Stretches’ checkbox.

11. You can also tweak your fit with the Max Iterations and Fit Tolerance. You can specify the
temperature at which the stretching was done with the temperature control.

8.8. Analyze Tab

8.8.1. Single Force Plot Tab

This tab runs various analysis (built-in or user-specified) on collections of force plots or force maps
to create histograms, plots, and images of calculated parameters from the force data.

Figure 8.20.: Single Force Plot Tab

Histogram This check box creates a histogram of calculated values. On the Single Force tab,
you can set which force plots will be used to generate the histogram in the upper-left corner. This
includes either all of the force plots listed (memory intensive) or a selected subset of the data. The
various parameters that can be calculated are:

• Adhesion Simple minimum of the force curve, appropriate for clean adhesive ruptures with
no polymer tethers.
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• DC Invols Calculates the slope of deflection vs. Zsensor in the contact region and can use
extend or retract data.

• AC Invols Calculates the slope of Amplitude vs. Zsensor in the contact region and can use
extend or retract data.

• Indentation This takes the difference in the indentation at two marked points in the force
plot. You need to mark the start and end points of the indentation with the cursor panel
controls.

• Pers
• Contour Length
• Extension Ratio
• Rupture Length
• Rupture Force
• Young’s Modulus E1
• OliverPharrFit
• OliverPharrStiffness
• OliverPharrReducedDepth
• OliverPharrArea These are all report values that were calculated from other methods (WLC

or elastic tab). When these calculates are done, they store values in the wave notes, the
histogram or scatter plots are simply reporting those stored values.

Scatter Plots

• You can create scatter plots of a calculate value vs. another parameter. This calculation
shares most of its controls with the histogram; the force plot selection and the calculation
type are the same as the histogram.

• The X axis of the scatter plot is set by the X parm popup, just under the calculate popup.
These are generally parameters that are extracted from the force plot note. For example, you
can plot the adhesion vs. seconds to see how the adhesion changed over time.

Force Average

• This takes the currently displayed force plots and puts them on a second graph that will be
averaged along the X axis. It divides the X axis into evenly spaced bins and averages the Y
data that falls into each bin.

• You can adjust the number of bins from a slider on the graph.
• It is critical for each of the force plots to be overlapping when you do this. If there is an offset

in the deflection from one force plot to the next, that is what the averaging will be showing
you.

PFM Hysteresis Loops

• PFM Force plots taken in the DART spectroscopy controls (driving the DC tip bias with a
triangle square wave while driving the AC tip bias with a sine wave) can be further analyzed
with this button.

• It converts the raw data in the currently displayed force plot to a hysteresis plot of the average
of the data while the bias is off, plotted vs. the DC bias of the previous step pulse.

• More detail on this can be found in ARApplicationsGuide in the PFM chapter.
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8.8.2. Entire Force Map Tab

1

2

3

Figure 8.21.: Entire Force Map tab. Box 1: Input and Calculation Box 2: Optional Advanced Controls
Box 3: Starts the Calculation

On this tab, there are controls that create images from force map data. Select the ‘Input’ and the
force map you want to use to calculate the image. Select the function. Below are descriptions for
each of the functions:

FMapCalcAdhesion Calculates the adhesion by returning the difference of the minimum of the
data and the average of the last 10 points.

FMapCalcJKR2Point Calculates Young’s modulus of the sample using the 2 point JKR method
Sun Y. et. al. Langmuir 2004, 20, 5837-5845. The First element of the Parm Wave is the radius
of the spherical apex of the paraboloid tip, in meters. The second (optional) element of the parm
wave is the Poisson Ratio of the sample [Default = 0, meaning that the result will be in Reduced
elastic modulus, not sample modulus].

FMapCalcHeight Calculates the height by returning the negative max of the data.

FMapCalcMax This function simply returns the max value of the input channel.

FMapCalcMin This function simply returns the min value of the input channel.

FMapCalcXMaxLoc This function returns the value of the Data where the DataTypeB is maxi-
mum. EX: Data is deflection and DataTypeB is ZSnsr, then it would return the trigger point of the
deflection.

FMapCalcXMinLoc This function returns the value of the Data where the DataTypeB is minimum.
EX: Data is ZSnsr and DataTypeB is deflection, segment is Ret, then it would return the Z position
of the adhesive rupture.
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FMapTransitionMap Heavily filters the data, then returns the value of Data where the derivative of
DataB is at a minimum.

FMapCalcPFM(On/Off) These functions extract the Hysteresis loops of the PFM measurements.
The On version takes the data during the On cycles of the triangle square wave, the Off version
takes the data when the DC bias on the tip is zero. These functions are specialized in that they build
four layers: Coercive Imprint Negative Positive Bias is rising, is the loading cycle; Bias is Falling
is the unloading cycle. Positive (Vp) is the bias at which the input channel is at a minimum during
the Loading cycle. The negative (Vn) is the bias where the input channel is a minimum during the
unloading cycle. The Coercive is (abs(Vn)+abs(Vp))/2 Imprint is (abs(Vp)-abs(Vn))/2.

FMapCalcInvols This function calculates the inverse slope of the contact region, between 10 and
90% of the Max force for that segment.

FMapWork Integrates DataType vs DataTypeB. The default section is ALL, so that it is returning
the difference between the trace and retrace segments.

FMapContactWork Integrates DataType vs DataType B. Finds where DataTypeB is zero, and in-
tegrates the positive values of DataType vs DataTypeB from zero to the trigger point.

FMapCalcPlasticity Uses FMapContactWork to calculate the work for the extend data and retract
data. Returns the ratio: (AreaExt-AreaRet)/AreaExt.

• These functions live in XCalculated.ipf. You can add your own functions to UserCalcula-
ted.ipf. XCalculated.ipf will be overwritten by the installer the next time you update your
software. UserCalculated will not.

• For the most part, when using existing functions, you don’t need to worry about Data, DataB,
Section and Edit Parms, those are for doing custom calculations, selecting the function will
set the dataType, dataTypeB, and section to the default state. The auto name and output
controls set where the image is going once it is calculated. If you point it to an existing
image with a different number of points and lines, the calculated image will be interpolated
to fit in the existing image. This way you can calculate images from force maps, and put
them into typical AFM images.

• The ‘Do It’ button will start the calculation. The force map calculation will unload any force
plots that it loaded to do the calculation, so that the memory footprint should not grow signi-
ficantly while doing the calculation.

8.8.3. Examples

Adhesion histogram In this example, we analyze a batch for force curves to obtain a dis-
tribution of adhesion. The software measures the adhesion by taking the difference between the
minimum and the zero point. The zero point is defined here to be the average of the last 10 points
in the noncontact portion of the curve. The minimum is the lowest point in the retract portion of the
curve. Keep this in mind when using this application for polymer stretching force curves, where
there may be a larger adhesion away from the surface, this analysis may not be all that useful.

1. In the Analyze tab, select Adhesion from the ‘Calculate’ dropdown menu.

a) If ALL the curves are to be analyzed, activate the ‘Use all FPs’ checkbox

-OR-
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b) Click the ‘Select FPs...’ button to bring up a panel for selecting the force plots.

2. Click the ‘Histogram’ checkbox.

3. Click the ‘Do It’ button. Igor will process and produce a histogram.

4. Within the Histogram window, a variety of information can be acquired or exported. Fits can
also be acquired from the ‘Fit Type’ menu.

Invols Statistics Small improvements can be made in the precision of the Invols by taking a
statistical average of many invols values. In this example, we calibrate the invols by taking statistics
on a batch of force curves.

1. Collect a reasonable number of force curves (say 10-100) on a hard surface. Make sure they
all have the same trigger point.

2. Load just those force plots into the force review software.

3. In the Modify tab, click the ‘All Y’ offset.

4. Plot the force curves as DeflV and note what voltage range you want to do the fit over.

5. On the Analyze tab, select Calculate DC Invols Ret or DC Invols Ext, depending on which
segment you want to use.

6. Two controls will appear, allowing you to set the deflection voltage range to do the line fit
over.

7. Click the ‘Histogram’ check box.

8. Click the ‘Do It’ button. Igor will process and produce a histogram.

9. Within the Histogram window, a variety of information can be acquired or exported. Fits can
also be acquired from the ‘Fit Type’ menu.

10. Back on the Analyze tab, there are two buttons:

a) ‘Set to fit’ sets the invols of the analyzed force plots to the fitted mean.

b) ‘Set to each’ sets the invols of the analyzed force plots to each have their own Invols
value determined when creating the histogram.

8.9. Spot Tab

This tab allows you to mark where a force plot was performed relative to the image coordinate
system.
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Figure 8.22.: Spot Tab

1. Turn the spots on and off by using the ‘Activate Spots’ check box in the upper-left corner.

2. Select the force plots from the left column. This list is the same list as the one on the force
Display tab, and the offline force graph will update to display the selected force plots.

3. The locations of the force plots will be marked on the images selected on the right. Note that
only the displayed images are listed. You may need to go to the list panel to open the images
(note the List Panel... button which will open the list panel). To have the spot updated on the
images, you need to have the ‘Activate Spots’ checkbox turned on in the upper left corner.

4. The Display Prefs (bottom part of tab, click the ‘+’ to expand) section allows you to set the
text, color, and marker properties of the force plot locations.

Note Moving the sample or tip in the holder (changing tips) will make this analysis useless. Addi-
tionally, when this analysis is appropriate, there may also be small errors arising from thermal drift
that are not accounted for.

8.10. Elastic Tab

This tab fits single force plots or entire force maps with various elastic models to provide elastic
modulus.
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Figure 8.23.: Elastic tab. Major interface areas are numbered and outlined below.

1. Fit Input The upper-left corner of the tab is where you can set it to work on a single force
plot or calculate an entire elastic map from a force map. You can also set which segment of
the force plots you are working on: extend, retract, or dwell.

2. Calibration Here you can override the invols and spring constant stored in the file. Clicking
the red ‘X’ button in the corner of this area will undo the override values and revert the data
back to the stored value.

3. Warnings This area posts any problems that the software finds with your data. Clicking the
buttons here will take you to the Help section that describes what the problems are, their
implications, and how to fix and avoid the problem in the future.

a) If your input is set to force map, then initially this will be a button with an estimate on
how long it will take to load up a handful of the force plots. Once this has been done,
any problems found with the examined force plots will be listed.

b) Also, if you have analyzed the force map, clicking the ‘Warnings’ button will bring up
a mask that shows which parts of the image had this problem.
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4.

Model Selection Guide:

• This area posts suggestions on which
models may describe the data better.

• It calculates the plasticity factor, the
Force ratio, and the Tabor coef; and
from those parameters, selects one of
the four available models that best
works with those parameters, as seen
in the flow chart at right.

• When the Fit Input is set to Entire
Force Map, the model selection guide
changes to report statistics on the
force map that has been examined so
far. The colors to the left of these
controls reflect the colors of the mask
applied to the image.

• There is a control to check the map
that loads and examines force plots
randomly to get more statistics. This
operation can be canceled at any time
from the progress bar that appears.

5. Models The tab selects which elastic model you are using. The Model Selection Guide
(above) can give some guidance as to which models may describe your particular data. Mo-
dels include:

a) Hertz The classical theory of contact mechanics. From 1886 to 1889 Heinrich Hertz
studied how lenses deform under load, and his equations led to the foundation of contact
mechanics. See also 8.10.0.1. This model assumes:

• Negligible adhesion between the tip and sample
• Strains are within the elastic limit
• The contact area is much smaller than the radius of the tip

b) DMT Derjaguin-Muller-Toporov; takes into account adhesion outside the contact area.
Applies to samples with a small Tabor coefficient.

c) JKR Johnson-Kendall-Roberts; takes into account adhesion inside the contact area.
Applies to samples with a large Tabor coefficient. See also 8.10.0.2.

d) Oliver Pharr Relatively new elastic model that fits the unloading curve. More appro-
priate for samples that deform plastically.

6. Model Assumptions This area describes the tip and the sample. The elastic models calculate
the reduced Young’s modulus, which is comprised of the tip and sample’s Young’s modulus
and Poisson ratios. You need to describe the tip and sample in order to determine the sample
modulus from the reduced modulus.

1
Ec

=
1−V 2

i
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+

1−V 2
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V is the poisson ratio, E is Young’s modulus, Ec is the reduced Young’s modulus i denotes
indenter, s denotes sample.

a) The elastic models also deal with pressure. This means you need to know area and
tip geometry, which is set in the geometry area. The Oliver Pharr model has more
complicated and flexible controls to specify the area.

b) The Tip Geometry controls are above the Model Assumptions. There is also an estima-
tion of which geometry will describe your data the best; it is useful as a double-check.

7. Initial Guess: The specifics of this area depend on the Elastic Model. In general terms, you
can type in values for the fit parameters and see how that alters the calculated line. Then
fitting will take that initial point and try to converge on a better description of the data. If the
initial guess is very far from describing the data, the fit will not be able to converge.

8. Results: Here the sample modulus is calculated from the tip and sample properties and the
reduced modulus from the fit.

8.10.0.1. Elastic tab hertz example

This example’s instruction set uses a force map collected on a homogenous polyacrylamide gel
with a modulus of ~700 Pa. The instruction set will refer to specific force curves from this sample.
You can download this sample data set from here:

http://www.asylumresearch.com/Files/Data/PolyacrylamideGel.zip.

(a) Master Force Panel, Display Tab
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(b) Single Force Plot (c) Entire Force Map

Figure 8.24.: Master Force Panel, Elastic Tab

1. Open the AFM software. In this example, we are using Igor PRO 6.32A and the MFP3D
120804+0806. Earlier versions of the AFM software (especially anything before 101010)
may not work or have the features we use in this document. Please check the Asylum sup-
port site (https://support.asylumresearch.com/forum/content.php?4-Software)
for the latest version.

2. Load your Force Map data. From the menu bar, select AFM Analysis > Master Force Panel. A
new panel called the Master Force Panel should appear, along with the AR Load Path win-
dow. Using the browse button on the AR Load Path window, select the folder that contains
your force map data, see 8.2.1.

3.

Open a Force Curve:

• You should see a list containing all of
your force curves towards the bottom
of the Display tab of the Master Force
Panel (Figure 8.24a on page 118).

• Simply click the name of any one of
your curves, and a graph of the force
curve will appear. In this example,
we’ve picked the force curve located
at Line 1, Point 1.

-OR-

• If an image came up with the force
map, you can click the image to
display the corresponding force plot.

4. Select the Elastic tab on the Master Force Panel. The panel should now look like Figure 8.24b
on page 119.

Note By default, the Elastic tab starts in Single Force Plot mode, as evidenced by the blue
Single Force Plot subtab towards the top of the panel. This is a good place to start, even if
you are analyzing an entire force map.
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5.

Inspect the Force Curve:

• The force curve will be displayed
with Force on the Y-axis and
Indentation on the X-axis.

• Note the crosshair on the graph
showing the location of the software’s
current estimation of the contact
point.

• Also note the software’s first fit to
your chosen elastic model, indicated
by a brown line. In the example, the
first fit does not match the data very
well, indicating that we have more
work to do before we get a better fit
on our data.

6. You can change the selected curve either by going back to the Display tab or by pressing the
arrow buttons under the Fit Input grouping on the Elastic Panel. You can also use the key-
board arrow keys to navigate across adjacent curves. See 8.2.3. Also, we will use the extend
portion (not the retract portion) of the force curve for this model, which should automatically
be selected in the drop-down box in this grouping.

7. Check your warnings: When the fit is made, the software checks for a series of common
problems that are found in indentation data. The top-right corner of the panel will display
any problems that have been detected with the data in yellow. Click the name of the warning
for a description of the problem. If there are no issues detected, a green button labeled No
Problems Detected will be displayed.

8. Input your model assumptions. Next, you will want to assume a tip shape, size Poisson ratio
for your sample. These need to be entered into the model assumption grouping. The tip
material is not required for soft samples, when the sample is in the kPa to a few MPa range,
then the difference in a 60 GPa indenter and a 360 GPa indenter is negligible.

a) In this case, we used an unmodified silicon nitride AFM cantilever, which we assume
is a cone with a half-angle of 36°. For a PA gel, the literature reports various Poisson
ratios- here we will use 0.4. Note that assumptions are very difficult to make, and in
real-life situations it might not be feasible to expect that your assumptions are constant
throughout a single data set.

9. Adjust your initial guess, if needed. The Initial Guess grouping allows you to assist the
model in making first-order guesses. The Force Offset and Depth Offset are the X- and Y-
locations of the contact point, relative to the 0,0 point in the force curve data. They describe
the center of the crosshairs displayed on your force curve graph. When the boxes next to
these parameters are checked, the program will try to solve for these offsets by iterative
fitting.

10. Adjust the fit region, if needed. In many cases, only a subset of your curve will be amenable
to a single model. By default, the fit is made between 10%-90% of maximum indentation.
To select a smaller or larger region, press the Show Fit Region Controls Checkbox. Using
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the parameters shown, you can select a lower and upper bound by inputting a specific value
or just a percentage of either the maximum force or indentation that will be fit by the model.
If the low parameter is grayed out, that means that you are trying to fit the force offset, and
the non-contact data is required to fit for that. Note that as you change the ROI parameters,
your data graph may auto-zoom the graph window.

a) When looking at these example force curves, you can see a small kink in the extend
portion of the curve at about 50% of the maximum force application. This might be due
to various factors that are not described by the model. In order to exclude this section
of the curve from the model analysis, we can use the ROI controls to select a sub-set of
the data for analysis.

11.

Fit your Data

• You will see the model fit represented
as a brown dashed line on your force
curve, and the numbers in the Results
grouping will be updated. To the right
we show a good fit on our data, which
was obtained by rejecting all data
above the kink in the force curve.

12. Look at the Results part of the panel. The modulus of the sample is highlighted in yellow.
The reduced chi-square (χ²) value is an estimate of the fit quality, where values closer to
1 indicate a better fit. The reduced modulus is the actual measured modulus, which is a
convolution of the sample modulus and the indenter modulus.

13. ‘Start Over’, if needed. This button removes the region of fit restrictions and allows you to
start again.

14. Select ‘Entire Force Map’: Selecting this tab should result in the border of the panel turning
green (Figure 8.24c on page 119).

15. Fit an Entire Force Map: We started by analyzing one force curve in order to adjust our
fitting parameters and assumptions. We can now analyze an entire force map.

Note When you do this, you apply the same assumptions and fit parameters to every curve
in the force map. This might not be appropriate as the variability of the sample and the tip
during the experiment might require different assumptions for different areas.

16. Check for warnings: The warnings area of the panel should now give you the option to check
a small subset of your data for fit problems. It will also list the estimated length of time that
such a check will take. The warnings that appear here are identical to those described in the
previous section.

17. Select your data output: Using the top-left section of the panel, you can select the name of
the image output. The ‘Image Output: AutoName’ check box is selected by default and will
produce an image with the same name as the folder that contains your force map data. This
name will be listed just under the check box. Be careful if you do not check the box; adding
the calculated data as a layer into a new image can be tricky, especially if you are adding it
to an image file that has a different pixel count or scan size.
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18. Fit your data: Click the ‘Fit’ button. A progress bar with estimated time to completion will
appear as the program fits the individual curves.

19.

Explore your Data:

• A figure with results should appear.
Each pixel represents a modulus
value.

• To see a point in more detail, click the
point on the image. The force curve
display will show you that force curve
and the Results area of the Elastic tab
will show you the value.

Note Very poorly fit points are displayed
as dark red pixels. If you choose one of the
problems noted in the Warnings section, a
bright red mask indicates which areas
represent the reported warnings.

20. Refit a specific point, if needed: If a single point has been fit poorly, or requires different
assumptions or parameters, you can select that point and adjust the fit parameters in the
Elastic tab, just as you would when analyzing single force curves. If your new parameters
and result are satisfactory, you can then update the force map with the new value by clicking
the ‘Update Value in Map with Current Fit’ button.

21.

Further Analysis (Optional)

• In this example, the Force Map was
taken on a homogenous gel. This was
done so that many data points could
be analyzed to achieve an average
value for the sample. If you had a
large data set (> 100 force plots), you
could do a Gaussian fit to the
distribution from the histogram panel.
This example data set is only 16 force
plot, so reading the average and
standard deviation from the roughness
panel is more appropriate (see
Section 7.3.1 on page 70). The
histogram example is described here
as an example.

• To show the Histogram tab, open the
Analyze Panel by clicking ‘A’ at the
upper-right of your result map (see
Section 7.3.3 on page 76).

support.asylumresearch.com Page 122



Ch. 8. Force Curve Analysis Sec. 8.10. Elastic Tab

22.

Further Analysis (Continued)

• Click the ‘Make New Histogram’
button.

• The resulting histogram can be
adjusted using the slider to control the
number of samples per bin.

• A Gaussian fit can be applied to the
data by selecting ‘Do it’ on the top
right of the Histogram window. You
can also fit a subset of the data by
bracketing the region of interest with
the Igor cursors (press Ctrl + i to
reveal these) and then doing the fit.

Note In this example, the Gaussian mean
value was 664.18 Pa with a standard
deviation (Width) of 7.56 Pa. Compared to
the actual average of 682.9 Pa and standard
deviation of 8.183 Pa from the Roughness
tab.

8.10.0.2. Elastic Tab JKR Example

This examples’s instruction set uses a force map that was collected on Dow Corning Sylgard 186
Silicone Elastomer http://www.dowcorning.com/applications/search/default.aspx?R=
118EN. The instruction set will refer to specific force curves collected on this sample. You can
download this sample data set from here:

http://www.asylumresearch.com/Files/Data/JKRData.zip.
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(a) Master Force Panel, Display Tab

(b) Single Force Plot (c) Entire Force Map

Figure 8.25.: Master Force Panel, Elastic Tab

1. Open the AFM software. In this example, we are using Igor PRO 6.32A and the MFP3D
120804+1118. Earlier versions of the AFM software will not have the features we use in this
document. Please check the Asylum support site (https://support.asylumresearch.
com/forum/content.php?4-Software) for the latest version.

2. Load your Force Map data. From the menu bar select AFM Analysis > kMaster Force Panel.
A new panel called the Master Force Panel should appear, along with the AR Load Path win-
dow. Using the browse button on the AR Load Path window, select the folder that contains
your force map data.
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3.

Open a force curve:

• You should now see a list containing
all of your force curves towards the
bottom of the Display tab of the
Master Force Panel (Figure 8.25a on
page 124).

• Click on the name of any one of your
curves, and a graph of the force curve
will appear. In this example, we’ve
picked the force curve located at Line
1, Point 3.

-OR-

• If an image came up with the force
map, you can click on the image to
display the corresponding force plot.

4. Select the Elastic tab on the Master Force Panel. Then, click on the JKR tab. The panel
should now look like Figure 8.25b on page 124.

Note By default, the Elastic tab starts in single force plot mode, as evidenced by the blue
Single Force Plot subtab towards the top of this panel. This is a good place to start, even if
you are analyzing an entire force map.

5.

Inspect the force curve:

• The force curve will be displayed
with Force on the Y-axis and
Indentation on the X-axis.

• Note the crosshair on the graph
showing the location of the software’s
current estimation of the contact
point.

• Also note the software’s first fit to
your chosen elastic model, indicated
by a brown line. In the example, the
first fit does not match the data very
well, indicating that we have more
work to do before we get a better fit
on our data.

6. You can change the selected curve either by going back to the Display tab or by pressing
the arrow buttons under the Fit Input grouping on the Elastic Panel. You can also use the
keyboard arrow keys to navigate across adjacent curves, see Section 8.2.3 on page 97.
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7.

Select the region: The JKR model can
fit either Extend, Retract, or both
(Ext+Ret). The JKR model does not
include visco elastic deformation, so when
there is significant separation between
extend and retract (as shown in these force
plots), you will not end up with a good fit
to both extend and retract. The fit curve is
between extend and retract, describing
neither. This should be an indicator that
your model may be incorrect, and you may
want to do a force rate dependency study to
see what effects that loading rate has on the
shape of the force curves. These curves do,
however, have a very clear decrease in
restoring force just before the rupture on
retract, this is a signature of the JKR model
that is absent in Hertz and DMT. So for the
sake of this example, we set the fit input
to retract to see how well the JKR model
could describe that portion of the curve.
You can see it immediately does a much
better job of describing that data.

8. Check your warnings: When the fit is made, the software checks for a series of common pro-
blems found in indentation data. The top-right corner of the panel will display any problems
that have been detected with the data in yellow. Click the name of the warning for a des-
cription of the problem. If there are no issues detected, a green button labeled No Problems
Detected will be displayed.

9. Input your model assumptions: Next, you will want to assume a tip shape, size, and a Poisson
ratio for your sample. These need to be entered into the model assumption grouping. The
JKR model is derived for a paraboloid shaped tip. The tip material is not required for soft
samples, when the sample is in the kPa to a few MPa range, then the difference in a 60 GPa
indenter and a 360 GPa indenter is negligible.

a) In this case, we used an unmodified silicon nitride TR800 PSA (Short)http://www.
asylumresearch.com/Probe/TR800PSA,Olympus that we assume is a spherical apex
with a radius of 20 nm. We also assume a Poisson ratio of 0.5. Note that assumptions
are very difficult to make, and, in real-life situations, it might not be feasible to expect
that your assumptions are constant throughout a single data set.

10. Select the fit parameters and adjust your initial guess, if needed: The more fit parameters, the
more freedom the fit function has, making it easier for it to get lost. If you have a difficult
time converging (getting a good fit), try turning off some parameters and adjusting them by
hand. For example, adjust the Depth Offset, so that it looks correct to you and then turn off
that Fit parameter. Adjust the Pull Off Force to be the minimum of the curve and turn off that
parm. Adjust the Force Offset so that the base line looks correct and then turn that parameter
off. Then do a Fit and see where that gets you. Once you are close, you can turn on more fit
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parameters, and they should improve when you fit.

11. Adjust the fit region, if needed: In many cases, only a subset of your curve will be amenable
to fitting. By default, the fit is made between 10%-90% of maximum indentation. To select
a smaller or larger region, select the ‘Show Fit Region Controls’ check box. Using the para-
meters shown, you can select a lower and upper bound by inputting a specific value or just
a percentage of either the maximum force or indentation that will be fit by the model. If the
low parameter is grayed out, that means that you are either trying to fit the contact point (see
the previous step) or you are fitting both extend and retract. In the latter case, the upper limit
is found in both the extend and retract data, and the force above that level is excluded from
the fit.

12.

Fit your data:

• You will see the model fit represented
as a brown dashed line on your force
curve, and the numbers in the results
grouping will be updated. To the right
we show a good fit on our data.

13. Look at the results part of the panel. The modulus of the sample is highlighted in yellow.
The reduced chi-square ( χ²) value is an estimate of the fit quality, where values closer to
1 indicate a better fit. The reduced modulus is the actual measured modulus, which is a
convolution of the sample modulus and the indenter modulus.

14. Start Over, if needed: This button removes the region of fit restrictions and allows you to
start again.

15. Select Entire Force Map: Selecting this tab will result in the border of the panel turning green
(Figure 8.25c on page 124).

16. Fit an Entire Force Map: We started by analyzing one force curve in order to adjust our
fitting parameters and assumptions. We can now analyze an entire force map. Note that
when you do this, you apply the same assumptions and fit parameters to every curve in the
force map. This might not be appropriate as the variability of the sample and the tip during
the experiment might require different assumptions for different areas.

17. Check for warnings: The warnings area of the panel should now give you the option to check
a small subset of your data for fit problems. It will also list the estimated length of time that
such a check will take. The warnings that appear here are identical to those described in the
previous section.

18. Select your data output: In the upper-left section of the panel, you can select the name of the
image output. The AutoName checkbox is selected by default and will produce an image
with the same name as the folder that contains your force map data. This name will be listed
just under the check box. Be careful if you do not check the box; adding the calculated data
as a layer into a new image can be tricky, especially if you are adding it to an image file that
has a different pixel count or scan size.

19. Fit your data: Click the Fit button. A progress bar with an estimated time to completion will
appear as the program fits the individual curves.
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20.

Explore your data:

• A figure with results should appear.
Each pixel represents a modulus
value.

• To see a point in more detail, click the
point on the image. The force curve
display will show you that force curve
and the Results area of the Elastic tab
will show you the value.

Note Very poorly fit points are displayed
as dark red pixels. If you choose one of the
problems noted in the Warnings panel, a
bright red mask indicates which areas
represent the reported warnings.

21. Refit a specific point, if needed: If a single point has been fit poorly, or requires different
assumptions or parameters, you can select that point and adjust the fit parameters in the
Elastic tab, just as you would when analyzing single force curves. If your new parameters
and result are satisfactory, you can then update the force map with the new value by selecting
the ‘Update Value in Map with Current Fit’ button.

22.

Further analysis (optional):

• It may be possible to distinguish
between two different samples by
looking at the histogram of the
obtained Young’s modulus.

• To show the Histogram tab, make the
Analyze Panel by clicking ‘A’ in the
upper-right section of your result
map, see Section 7.3.3 on page 76.
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23.

Further analysis, continued:

• Click ‘Make New Histogram’ button.
• The resulting histogram can be

adjusted using the slider to control the
number of samples per bin.

• A Gaussian fit can be applied to the
data by clicking ‘Do It’ in the upper
right section of the Histogram
window. You can also fit a subset of
the data by bracketing the region on
interest with the Igor cursors (click
Ctrl + i to reveal these) and then
doing the fit.

Note In this example, the Gaussian mean
value was 1.25 MPa with a standard
deviation (Width) of 0.0287 MPa.

8.11. Online Video

Consider watching this video: Hertz Fitting for Nanomechanical Analysis (requires an internet
connection).
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9. Particle Analysis

CHAPTER REV. 2049, DATED 09/27/2018, 11:13. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Currently the Video Overlay software feature for AR SPM Software Version 14 is described in this
online video tutorial: Particle Analysis.

support.asylumresearch.com Page 130



Ch. 10. Video Overlay

10. Video Overlay

CHAPTER REV. 1984, DATED 11/10/2017, 14:24. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Currently the Video Overlay software feature for AR SPM Software Version 14 is described in this
online video tutorial: Video Overlay - Combining Optical and AFM data.
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11. ARgyle 3D Data Visualization

CHAPTER REV. 2436, DATED 09/04/2021, 14:34. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Chapter Contents

11.1 Viewing Saved Images in 3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
11.2 Overlaying Data on a Surface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

11.2.1 Basic Examples of Color Overlay . . . . . . . . . . . . . . . . . . . . . . 134
11.2.2 Overlaying Data from Difference Sources . . . . . . . . . . . . . . . . . . 136

11.2.2.1 Overlay of Height on Height . . . . . . . . . . . . . . . . . . . 137
11.2.2.2 Overlay tricks . . . . . . . . . . . . . . . . . . . . . . . . . . 138
11.2.2.3 Flattened Surface Overlay on Topography . . . . . . . . . . . 138
11.2.2.4 Error Signal Overlay on Topography . . . . . . . . . . . . . . . 138

11.3 Display Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
11.3.1 Axes, Prefs, Lights, and Windows Tabs . . . . . . . . . . . . . . . . . . . 140
11.3.2 Color Tables, Rotate, Zoom, Pan, and Lighting . . . . . . . . . . . . . . . 141
11.3.3 Z Axis Range, Offset, and Clipping . . . . . . . . . . . . . . . . . . . . . 144
11.3.4 3D Graphics Aspect Ratio . . . . . . . . . . . . . . . . . . . . . . . . . . 146
11.3.5 Anaglyphs, Auto Rotation, and Fly-Overs. . . . . . . . . . . . . . . . . . . 147

11.4 Exporting Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
11.5 Activating Real Time ARgyleTM . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
11.6 Advanced Command Line Control . . . . . . . . . . . . . . . . . . . . . . . . . . 150
11.7 Argyle Lite Windows App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

ARgyleTM (a play on ArGL or Asylum Research Graphics Library) is the MFP-3D’s 3D image
rendering software. It uses open GL code and the graphics card on your PC to produce stunning
3D representations of your data. In real time or with offline analysis, custom colors and specular
lighting can bring out features in your data that are not easily perceived in the standard 2D view. It
also allows multiple data channels to be overlayed as color on another data channel.

There are two ways to get started using ARgyleTM, depending on whether you are imaging in real
time or doing offline analysis. 3D representations of saved data will be covered first, so this tutorial
can be used even if you are not actively imaging a sample. For the same capabilities with reference
to data being collected in real time, please see Section 11.5 on page 149.

11.1. Viewing Saved Images in 3D

1. Open the Image Browser Panel as outlined in Section 7.1 on page 32.
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2.

Open a 3D Window:

• Open an image of choice. This will
bring up the 2D image display
window.

• Select a tab of the image: probably
Height or, as shown here, Zsensor.

• Click the ‘3D’ button.

3. A 3D rendered image will appear in a new window. Figure 11.1 on page 133 shows a typical
example. The data is scaled in a box of aspect ratio 3 to 1. The color bar corresponds to the
total range of the Z axis.

4. Try a few things with your mouse:

a) Click-drag on the 3D surface with the left mouse button to rotate the view.

b) Use the mouse wheel to change the level of zoom. Clicking and dragging the left mouse
button while holding down the ‘Ctrl’ key has the same effect.

c) Right-click-drag to change the angle of the lighting.

d) ‘Shift’ + left-click-drag to pan the image within the XY plane.

Figure 11.1.: Typical ARgyle window when it first opens.

11.2. Overlaying Data on a Surface

Figure 11.2 on page 134 shows an example of an overlay. Unlike the images covered so far,
the color map overlay has no relation to the data channel it is overlayed on. In this case, the
color is proportional to surface potential at the cantilever tip as measured by Kelvin Probe Force
Microscopy, but the shading and 3D rendering is proportional to the sample topography. The
potential as measured at each pixel is painted over the sample topography. It is not unlike a 3D
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rendering of a geographical map in which colors represent vegetation type. This effect can be quite
useful for depicting many quantities measured by AFM, such as magnetic field, conductivity, tip
sample capacitance, and cantilever phase.

Note

AFM images commonly have spikes in the data, which can be very
distracting in surface plots. Use of the filter panel can be a quick and easy
way to clean up the image for use as a surface plot. See Section 7.2.5 on
page 63 for detailed instructions.

Figure 11.2.: Surface potential overlay on topography.

11.2.1. Basic Examples of Color Overlay

1. Open the Image Browser Panel as outlined in Section 7.1 on page 32.
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2.

Open a 2D Window:

• Open an image of choice, which displays the 2D Image Display window. Here we
show a polymer topography image and the phase channel. Both are flattened and
slightly filtered for noise.

3.

Set the Color Channel:

• On the 2D image graph:
– Select the channel you want for

the color. This will usually be
phase, current, or some other
measured quantity.

– ‘Ctrl’ + Click the ‘3D’ button. This
will set the currently displayed
layer as the color for the next 3D
image.-OR-

• Open the Master ArGL Panel by
selecting AFM Analysis > 3D Surface
Plots from the menu bar:

– Click the New tab.
– Click the ‘Color’ checkbox.
– From the ‘Color’ menu, select the

same data file as you selected for
the surface.

– From the ‘Data Type’ menu, select
the desired channel in that image.
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4.

Set the Surface Data:

• On the 2D image graph:
– Select the channel you want for the surface. This is usually Height, Zsensor,

or a modified version thereof.
– Click the ‘3D’ button.-OR-

• From the Master ARgyle panel:
– Click the New tab.
– Select the topography data file from the ‘Surface’ menu.
– Select the desired channel of that image from the ‘Data Type’ menu.
– Click the ‘Do It’ button to create the 3D view.

• The image shows a nice example of how one value of phase associates with
ridges and another value with furrows.

Note Once the 3D image is rendered, neither the surface nor the color channel can be
reset without closing the window.

11.2.2. Overlaying Data from Difference Sources

(a) LFM Image (b) Force Map (c) Overlay

Figure 11.3.: Force Map overlay on LFM image.

The previous section overlaid the phase channel from one image onto the height channel from the
same image. As you may have guessed from the dropdown menus when you selected the Surface
and Color sources, the channels do not have to be from the same image; surface and color sources
can be selected from any open images. Figure 11.3 on page 136 shows an example of a lateral
force image which is used as the surface source (topography actually represents force) with a color
overlay based on a map of force curves.

The sample is a micro contact printed mercapto undecanoic acid (-COOH terminus), backfilled
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with dodecanethiol (-CH3 terminus). The Au coated SiNx tip had the acid thiol on it as well, and
it was acquired in a pH 4 buffer standard. The example was done in moderate haste to show this
type of experiment can be done, and seems to correlate reasonably well.

11.2.2.1. Overlay of Height on Height

An overlay of topography as a color on topography in a 3D image can be very useful when trying
to create a certain data landscape. In a standard 3D image, the color bar of the height is directly
linked to the range of the Z axis. The only way to get a certain color to occupy a certain altitude in
the topography is to translate offset the data, usually causing some of it to go outside of the frame
box.

By associating color with a secondary channel, the ArGL Master Panel allows the color scale to be
offset freely. Please follow this brief demonstration.

1. Open the Image Browser Panel as outlined in Section 7.1 on page 32.

2.

Open a 2D Window:

• Open an image of choice which
brings up the 2D Image Display
Window.

• Select a tab of the image data channel
of interest, probably Height or, as
shown here, Zsensor.

• ‘Ctrl’ + click the ‘3D’ button.

3.

Open a 3D Window, Topography:

• Go back to the image.
• Click on the ‘3D’ button, but do not

hold down ‘Ctrl’.
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4.

Manipulate the Color Bar Scaling and Offset:

• Select the View tab.
• Set ‘View Mode’ to “Color Scale”.
• Use the sliders to change the color scale range and offset. Notice that the total

range on the color scale is 2 microns, while the total range on the Z axis is 500
nm. This cannot be achieved in a non-overlay type graph.

11.2.2.2. Overlay tricks

These are not intended for quantitative scientific visualization but can be very helpful when trying
to communicate features of an image.

11.2.2.3. Flattened Surface Overlay on Topography

You may want to do a 3D rendering of some material that has smaller features but some larger
curvature of radius, for instance, large spheres or hair. The problem is that the finer details of the
topography features do not get colored well in ARgyle due to the extreme changes in Z scale of the
material.1

To solve this problem, flatten a height image channel with a second order flatten to take out the
large-scale curvature of the material, then overlay it onto a Z sensor or copied height channel that
has nothing greater than a 0-order flatten applied to it.

Using ARgyle, overlay the 2nd order flattened image onto the other, such that the 2nd order image
is the colored layer. This will help to bring out the smaller features much better. Figure 11.4
on page 139 shows an example of this technique. Note that this technique is mostly to enhance
visualization. The color bar may best be left off since its scale will only reflect, at best, local
variations with respect to the surface of the object.

11.2.2.4. Error Signal Overlay on Topography

The amplitude signal in AC mode imaging or the deflection channel in contact mode imaging, also
known as the “error signal”, is a measure of the inability of the Z feedback mechanism to actually

1 This idea courtesy of Scott Maclaren, Center for Microanalysis of Materials, Frederick Seitz Materials Research La-
boratory, University of Illinois, Urbana Champaign.
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(a) Raw height (b) Parabolic flatten (c) Overlay of (b) on (a)

Figure 11.4.: Overlay of a second order flattened height image on the topography of the same image.

keep the cantilever amplitude fixed. When the cantilever encounters edges in the sample, it will
take some time for the feedback to react. During this time, the amplitude or deflection will not
be at their respective set points. The resulting image of this signal often looks appealing since it
accentuates edges and ignores slower variations in topography. It contains no direct topographical
information, only convoluted information which, in a way pleasing to the human eye, brings out
small surface detail. It is not unlike some of the traditional edge finding filters that can be found in
the Filter subtab of the Modify tab.

When imaging cells, users commonly overlay the amplitude signal onto the overall topography to
visually enhance the presence of small surface features. Always clearly state how the image was
processed, since this borders on “Photoshopping” the actual data.

(a) Zsensor image (b) Color Overlay

Figure 11.5.: Fibroblast cells on a glass substrate. Overlay of the amplitude image channel on the
topography. Some blue colored specular lighting added.
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11.3. Display Settings

When the ‘3D’ button is clicked, the ArGL Master Panel is opened along with the 3D representation
of the data. This gives additional controls over the 3D image beyond the mouse clicks and drags of
the last section. Each of the tabs will be discussed but out of order for the sake of clarity.

Note

On the first activation of a 3D image, the panel will have certain default
parameters (i.e., Zoom, scale, rotation, color, etc.) that may appear off-scale
(in Z) if the surface features are large relative to the XY scan area, or close to
scale (in Z) if the features are small. If you have already processed a 3D
window in the current experiment, the new ARgyle image will have the same
rotation, zoom, etc. as the previously opened 3D window. It will have the
same Z data scale as the 2D image in the Display Window.

11.3.1. Axes, Prefs, Lights, and Windows Tabs

The tabs that are self-explanatory will be discussed first. Take a look at Figure 11.6 on page 140
and peruse the settings. Within Igor, you can always click the ‘?’ buttons next to any item for more
explanation.

(a) Axes tab (b) Lights tab

(c) Prefs tab (d) Windows tab

Figure 11.6.: Master ArGL Panel Tabs

Here are some of the more popular actions on these panels, even though many users will rarely use
any of them:
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Remove text or axes Go to the Axes tab. Uncheck the ‘Show Axes’ check box or the ‘Axes Labels’
check box.

Arrange or close multiple 3D image windows Go to the Windows tab. Hold ‘Shift’ and click on
windows in the list to stack, tile, or close them en masse.

Make surfaces appear shiny Go to the Lights tab and check ‘Shiny’. The percentage next to the
‘Shiny’ checkbox will adjust the intensity of specularly reflected light. Apply changes to the last
viewed image or check ‘All’ to apply to all current and future 3D windows.

Change illumination color Go to the Lights tab and change the light color using the ‘Color’ drop-
box. This only affects the specularly reflected light, so if ‘Shiny’ is set to 0%, then the light color is
irrelevant.

Change the background color Go to the Prefs tab. Use the ‘Color’ dropdown to change the back-
ground.

Note Apply changes to the last viewed image or check ‘All’ to apply the changes to all current and
future 3D windows.

11.3.2. Color Tables, Rotate, Zoom, Pan, and Lighting

This instruction set will show the relevant panel, usually the View tab, with different modes selected
on the left, the resulting image on the right, and instructions below.

1.
Starting Point:

• We will apply a series of actions to
the image shown at right.

2.

Choose a Different Color Table:

• Select the Display tab.
• Select a different color table using the ‘Color Map’ menu.
• Invert the direction of the color table with the ‘Invert’ check box.

Optional (not shown in the above image):

• Check the ‘Negative Color’ check box to make the image be a color negative of the
initial color scale. Red, for instance, would be displayed as green.

• Remove the color scale bar from the right of the image by unchecking ‘Color Bar’.
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3.

Rotate the Image:

• Under the View tab, select “Rotate” mode from the ‘View Mode’ menu.
• Change the view angle using the text fields or the sliders.
• Notice that the colors associated with the pitch and rotation fields are also applied

to the sliders.

Optional

• Or, with the mouse, left click-drag on the 3D image to change the rotation
variables.

4.

Zoom In:

• Select the View tab.
• Set ‘View Mode’ to “Zoom”.
• Enter a number for ‘Zoom Factor’ or slide the left slider back and forth.

Optional

• Or, with the 3D image window selected, rotate the mouse wheel to zoom in and
out.
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5.

Translate the Image:

• Select the View tab.
• Set ‘View Mode’ to “Offset”.
• Enter XY offset values or move the sliders to slide the image around on the

screen.

Optional

• Or, left Shift + click to translate the 3D image.

6.

Change the Lighting Angle:

• Select the View tab.
• Set ‘View Mode’ to “Light Rotate”.
• Enter values or use the sliders to change the incident angle of the image lighting.

Optional

• Or, right-click-drag the mouse pointer over the 3D image.
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11.3.3. Z Axis Range, Offset, and Clipping

1.

Change the Z Axis Range:

• Select the View tab.
• Set ‘View Mode’ to “Data Scale”.
• ‘Clip’ must be set to “None”.
• Enter a new value into the ‘Data Scale’ field. In our example, we cut the data scale

in half, increasing the size of the 3D topography by a factor of 2.
• Alternatively, you can use the yellow left-slider.

Note Since the color scale is normally fixed to the vertical range, the colors of the
surface that extend above the box stay constant. The only reason the surface still looks
like data is due to the shadows cast by the lighting. If you go to the Master ArGL Panel
and turn off the lights under the Lights tab, then the out of range parts of the image will
become featureless.

Note The data expands equally up and down from the vertical midpoint of the Z range.

Note The extremes of the data scale can give visually confusing results or may even
seem to erase the data. If the data seems irrevocably distorted, the ‘Fix’ button will
restore the default settings.
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2.

Clip Data Extending Outside the Frame:

• Select the View tab.
• Set ‘View Mode’ to “Data Scale”.
• Set the ‘Clip ’ to “Clamp”. The data extending beyond the vertical range are

capped with solid surfaces.
• To leave an open hole in which you can see the backside of the data, select the

“Clip” option from the ‘Clip’ dropdown menu.

3.

Change the Z Axis Offset:

• Select the View tab.
• Set ‘View Mode’ to “Data Scale”.
• The ‘Clip’ can still be set to “Clamp”.
• Enter a new value into the ‘Data Offset’ field. In our example, we offset by 125

nm, which brought the taller features nearly back inside the box and moved lower
features outside the box.

• Alternatively, use the blue right-slider to adjust the offset value.
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11.3.4. 3D Graphics Aspect Ratio

1.

Change the 3D Graph Aspect Ratio:

• Select the View tab.
• Set ‘View Mode’ to “Zoom”.
• Change the ‘Z Scale’ from the default value of “0.33” to “0.66”. The result is a

stretched graph which resembles the one in Step 1 on page 144. In this case,
however, the entire box is taller, and the data still fits inside that box. The data
will not be clipped and will not exceed the color scale.

• Alternatively, you may move the rightmost, blue-slider to change the value.

support.asylumresearch.com Page 146



Ch. 11. ARgyle 3D Data Visualization Sec. 11.3. Display Settings

2.

3D Graph Aspect Ratio 1:

• Select the View tab.
• Set ‘View Mode’ to “Zoom”.
• Click the ‘Aspect 1’ checkbox.
• The Z Scale value will assume a value which shows the sample in its true

proportions. For many AFM samples that have tens of nanometers of topography
over a many micron scan range, it will appear almost flat. In our case, the sample
is fairly rough and still gives something to look at.

• Changing the ‘Zscale’ by entering a number or using the slider will automatically
uncheck ‘Aspect 1’.

Note Aspect 1 only works when the Z axis has units of length. While not common,
any quantity, such as phase or amplitude, can be plotted on the Z axis. In this case, the
check box has no effect.

Note The term Aspect Ratio 1 refers to the actual sample X, Y, and Z dimensions, not
to the way the frame looks on the screen. This is not to be confused with setting the
Zscale to 1, which always makes the 3D frame appear to be a cube.

11.3.5. Anaglyphs, Auto Rotation, and Fly-Overs.

1.

Viewing with 3D Glasses:

• Go to the Display tab.
• Click the ‘Anagylph’ button.

Note While guaranteed to work on all
computers shipped with Asylum AFMs, the
Anaglyphs may not always work with
unusual graphics processors. This is often
the case with laptop computers. Note 3D viewing is most effective with a

gray scale color table, as shown in this
example image.
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2.

Auto Rotation (Spinning 3D Image):

• Select the View tab.
• Set ‘View Mode’ to “Spin”.
• Type in some small values or use the

sliders.
• The 3D image will slowly spin until

the spin rates are set to zero again.

Note This can be combined with the 3D
glasses though may cause motion sickness.

11.4. Exporting Images

There are many ways to export images from the ARgyle window, including the following four
methods.

1.

Cut and Paste a Screen Shot:

• Make the 3D image window the forwardmost image.
• From the menu bar select Edit > Copy . This puts a screenshot of that window on the

clipboard.
• Open another program where you can paste this bitmap, such as Paint, Photoshop, or e-mail.
• From the menu bar of that program, choose Edit > Paste.

Note Since this is a screenshot, the larger you make the window on screen, the higher your
exported image resolution.

2.

Save a Screen Shot to Disk:

• Make the 3D image window the forwardmost image.
• From the menu bar select Edit > Export Graphics.
• Select the file name, location, and type.
• Click ‘Save’ to export the screenshot to disk.

Note Since this is a screenshot, the larger you make the window on screen, the higher your
exported image resolution.

3.

Export to Layout:

• Make the 3D image window the forwardmost image.
• Select the New tab of the Master ArGL panel.
• Click the ‘Export to Layout’ button. To learn more about this, see Section 7.4.4 on page 91.

Note This will work only for open 3D windows. All the dropdown menus above the ‘Export to
Layout’ button have no bearing on this feature.
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4.

Save a High Resolution Bitmap to Disk:

• Make the 3D image window the forwardmost image.
• Go to the Igor Command line (Ctrl+J).
• Type:

argl_export2("","",0,1,3000,2000)

followed by the Return/Enter key for an exported image of 3000 pixels wide by 2000 pixels
tall. The pixel values have a 4000 maximum.

• From the dialog box that appears, select the file name, location, and type. In this case, the
type should be a bitmap (BMP).

• Click ‘Save’ to export the graphic.

Note If you have the color bar showing and choose a narrow window, the color bar will fall atop
your 3D graphic. Choose an aspect ratio similar to the screen. The Command line approach will
only show which 3D window is currently on top, not how it is proportioned.

11.5. Activating Real Time ARgyleTM

The lighting and shading features of ARgyle can be useful when fine tuning imaging parameters.
It is possible to update a live 3D image, line by line, as data is being collected. ARgyle does not
distinguish between real-time images and saved images; all of the manipulations discussed in this
chapter can be applied to either.

1. Start imaging.

2.

Open a 3D Window, Topography:

• Open the Master ArGL Panel by
selecting from the menu bar AFM
Analysis > 3D Surface Plots. Select the
New tab.

• From the ‘Surface’ dropdown menu,
select ’Realtime’.

• From the Data Type pull-down menu
to the right, select the desired channel,
usually ’Height’ or ’Zsensor’.

• Either skip to the next step or, IF you
want color overlays, click the ‘Color’
checkbox and select Realtime as the
source. For Data Type, the usual
channel is Phase, but any other
channel of your choice may be
selected.

• Click the ‘Do It’ button.

You will now have a 3D image on screen that fills up line by line. You can apply any manipulations
described in this chapter.
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11.6. Advanced Command Line Control

ARgyle has advanced command line features that will eventually be incorporated in the Igor GUI
interface. If you are curious, please read the following online help file. From within the AR SPM
software, select from the menu bar:

Help > AR Help Files > Xop Help Files > ARgyle help

11.7. ARgyle Lite: Stand Alone Data Visualizer for Windows

Asylum Research has released a free program which incorporates all the functionality of ARgyle
3D image viewing. See Figure 11.7 on page 151 for a screenshot of the application. It can be down-
loaded from https://support.asylumresearch.com/forum/content.php?157-ARgyle-Light

This program is an excellent way to share and view Asylum Research SPM data on computers that
do not have the Igor Pro / AR SPM software installed. You can send *.ibw files to anyone if they
install the free viewer.

For true 3D visualization, please contact Asylum Research for a free pair of 3D glasses: sa-
les@AsylumResearch.com.

If you understand the ARgyle functionality described in this chapter, you will find the ARgyle Lite
user interface quite familiar. The only limitation is that the software works with only one image
(.ibw) file at a time, so it is not possible to overlay data from one image onto another, as in the force
map example in Figure 11.3 on page 136.
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Figure 11.7.: ARgyle Lite windows application.
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12. Managing Image Data
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12.1. Introduction

This chapter assumes you are imaging, but sooner or later you’ll need to save the data and quickly
analyze it a bit while it’s still being collected. Hence, this chapter covers topics such as the follo-
wing:

BETA Page 152



Ch. 12. Managing Image Data Sec. 12.2. Data Channels

• How to select the proper incoming data streams for storing in memory.
• How to make sure that you save it to disk.
• How to best visualize the incoming data, including zooming, sectioning, and adjusting colors

and contrast.
• How to analyze it on the fly, even before an image is completed and stored.

12.2. Data Channels

An SPM image usually has many layers of data. Typically, the sample topography will be recor-
ded, but other concurrent measurements might be cantilever amplitude and phase (in AC mode),
cantilever deflection (in contact mode), cantilever current (for conductive AFM), or a host of other
signals. These concurrently measured quantities are known as channels, or image channels. For
real-time data, each channel can have a real-time image window. For data retrieved from the hard
drive, each channel creates a tab in the image display window. We will often refer to the channels
as layers also.

12.3. Selecting Image Pixel Density

No matter how many layers or data channels an image has, each layer will have the same physical
dimension and the same number of pixels. Before we launch into the business of setting up the
channels, we’ll discuss how to select the pixel density.

The Scan Line and Scan Points (i.e., pixel density) are selected in the Main tab of the Master Panel
using the respective variable fields. Note that the tip must be withdrawn to change these values,
unless the Delay Update checkbox is activated.

Figure 12.1.: Master Panel Main Scan Lines And Points

12.3.1. Choosing Enough Pixels

One important calculation to keep in mind:

PixelSize = (ScanArea/ # of pixels)

For example, for 512 x 512 pixels in a 5µm scan area, each pixel is 9.76nm²; while in a 90µm scan
area, each pixel covers 175.78nm².

So make sure the feature of interested has a high enough resolution such that it isn’t pixilated, but
isn’t so high that it doesn’t take 2 days to collect the image.

The absolute number of simultaneous data channels at high pixel resolution is difficult to quantify
but is directly related to computing power. For example, twelve channels at 2k x 2k can be collected
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with the stock PC, or three channels at 4k x 4k. At lower pixel resolution (512 x 512), up to twenty
images can be simultaneously collected. Obviously the higher the pixel density, the longer it takes
to collect that data.

12.3.2. Aspect Ratio

12.3.2.1. Pixel Aspect Ratio

If you are set up to collect an image of 10µm by 10µm and enter in 512 pixels by 128 lines, your
image will still be square, but your pixels will be vertically elongated.

12.3.2.2. Image Aspect Ratio

The aspect ratio of the image can also be changed in factors of 2, whole integer numbers. This will
automatically update the number of scan lines or points. For example, say a 1:1 image at 512 x
512 was being collected and then changed to 1:4; the scan lines will be changed to 128, while the
points will remain at 512.

12.3.3. Notes on Selecting Pixel Densities

When the‘Delay Update’ check box is activated, you can change the pixel density and have it take
place when the scan reaches top or bottom or when the ‘Frame Up’ or ‘Frame Down’ button is clicked.

If the ‘Delay Update’ check box is not activated, the tip must be withdrawn to change these values.

Since Igor is a memory-based program, collecting images with very large pixel densities (i.e., 2 to
4k x 2 to 4k) is most likely to occur with a fresh experiment/template, as opposed to one that has a
lot of information already stored in it. To help accommodate this, saving images to memory is not
recommended.

You may use a low pixel density to scan quickly to find an area of interest, and then increase the
density to acquire a high-quality image.

12.4. Master Channel Panel

This panel is where to select data channels to display and capture, adjust Z scales, color tables, and
flatten.

12.4.1. Opening Image Channels

To open and activate additional image channels before the tip is scanning, go to the Master Channel
Panel. The default ARSPM software is set for AC mode with Height, Amplitude, and Phase chan-
nels (Figure 12.1 on page 153) to be open in the Master Channel Panel, but it is advised to always
also capture the Z sensors data, especially when working with topography features larger than 500
nm (12.1). This is due to the fact that the closed loop sensors are very linear and quiet over their
range, whereas the piezo voltage (i.e., height channel) suffers from piezo creep and hysteresis.
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(a) Channel Panel Height Tab (b) Chanel Panel 4 Tab

Figure 12.2.: Master Channel Panel. Select addition channels from the Input dropdown menu in the
Master Panel.

Whatever the first channel tab is selected as, it will be 32 bit; all others are 16 bit.

Additional image channels cannot be activated during scanning.

Dropdown menus in the Master Channel Panel are self-explanatory, and the Help menus (question
marks) to the right further explain the features, including Color Map, Live Display (12.4.3), and
Live Flatten (12.4.4), which you can select as needed.

It is best to save both Trace and Retrace images, in case there is sample slope or some debris stuck
to one side of the tip that will give an imaging artifact. Capturing the trace and retrace data usually
increases your chances of obtaining a publication quality image.

Input Choose the data channel to display, per respective tab; Note: only activated when tip is not
scanning.

Data Scale Adjusts the Z scale of the image; or click the ‘Fix’ button to autoscale (see 12.4.2).

Auto Autoscales the Z scale data during imaging (see Section 12.4.3 on page 156).

Data Offset Adjusts where the center of the (Z) Data scale of the image, or click the ‘Fix’ button to
autoscale.

ColorMap Offers many color tables.

Live Flatten (see Section 12.4.4 on page 157)

Save Planefit (see Section 12.4.5 on page 158)

Capture What (see Section 12.4.6 on page 158)

Live Display (see Section 12.4.6 on page 158)

Show Scope (see Section 12.4.3 on page 156)
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12.4.2. Adjusting Image Z Scale

There are many ways to adjust the Z scale in the image channel, including:

1. Select the ‘Auto’ check box in upper-left corner of image channel tabs in the Master Channel
Panel.

2. Click the ‘Fix’ button next to Data Scale.

3. Draw a quadrangle onto the image window, right- (or left-) mouse-click inside the selected
area and select ‘Fix Scale’. This fixes the scale according to the Z values within the selected
area.

Note Alternatively, you can select ‘Fix All Scales’ which rescales the Z data in all imaging
data channels. This is a very nice feature.

4. Manually type a ‘Date Scale’ value, or use arrows to select a value.

12.4.3. Adjusting Trace/Retrace Scale

The individual Trace and Retrace images can be viewed and saved by selecting them in the Master
Channel Panel. To view Trace or Retrace, confirm that the proper check box is selected.

The red bar/cursor to the left of the image indicates which scan line the tip is located (i.e., which
slow scan line it’s rastering).

Trace or Retrace oscilloscope scan lines below the image can be turned ON or OFF with the ‘Show
Scope’ check boxes at the bottom of the Master Channel Panel. Trace is Red; Retrace is Blue.

The ‘Auto’ check box, when selected, autoscales the trace/retrace lines (below the image) with every
slow scan line added. Typically, it shows the slope of the sample relative to the tip, because it is
auto-scaled. Even if the slope (Z) is sub-nanometer over several tens of microns (XY), it is still
going to display slope because its auto-scaled (Figure 12.3).

If the ‘Auto’ checkbox is unchecked, it scales to the Data Scale value. For example, if the Data
Scale value is too low, then trace/ retrace will be clipped (shown below); this also depends on the
Data Offset value.

Figure 12.3 shows an example result in the trace/retrace lines from changing the Data Scale value.
Notice that the larger peaks are clipped because the Z scale is lower (red ellipse). By increasing
the Z scale, the entire traces can be scaled down (Figure 12.3).

(a) ScopeAutoScale (b) ScopeManualScaleClipping (c) ScopeManaulScaleZoomOut

Figure 12.3.: Effects of adjusting the Data Scale: A) ‘Auto’ check box activated; B) ‘Auto’ check box
unchecked, smaller defined Data Scale (notice larger features clipped in the Trace/Retrace lines); C)
‘Auto’ check box deactivated, larger defined Data Scale.
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• The Data and Offset Scales of the Trace and Retrace image channels can be separately con-
trolled by clicking the ‘Setup’ button in the Master Channel Panel (Figure 12.4). The upper
set of scale value applies to the Trace image, while the lower applies to the Retrace. From
the author’s understanding, if just the top is open, it applies to both Trace and Retrace images
of the respective channel.

• It is a good habit to always save the data as raw, unflattened data. To do this, select None in
the ‘Save Planefit’ dropdown menu (see Section 12.4.4 on page 157).

Figure 12.4.: Activating Data Scale and Offset setvar windows for Trace and Retrace images. Green
arrow shows where to choose live flattening.

12.4.4. Real Time Flattening

The Live Flatten menu allows the real-time scan to be flattened via plane, line, Masked Line, or not
at all. This modification is only applied to real-time data, but do not apply to saved data.

Figure 12.5.: Live Flatten Choices

None Leaves you with your raw data.

Offset Takes the average value of the scan line and subtracts that from the data.

Line Fits each scan line to a straight line, subtracts this line out of the scan line.

Masked Line Fits a line to each scan line but doesn’t use any data on the line that is more than 1/4
of the Data Scale away from the line. If you change the Data Scale, the lines after the change are
affected but not the lines already done. If you do want to redo the current lines, reselect Masked
Line in the popup.
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12.4.5. Save Planefit

Figure 12.6.: Planefit Choices

Caution This will modify the Saved data!

None Saves the raw data.

Offset Takes the average value of the Image and subtracts that from the data.

Planefit Subtracts a first order XY Plane from the Image.

The rest of these options modify your data quite a bit more, but you may return the data to its raw
state with the ‘Ultra Restore Layer’ button on the Modify panel.

Flatten 0 Temoves the offset from each individual line.

Flatten 1 Removes the offset and slope from each individual line.

Histo Flatten Removes the offset from each line by looking at a histogram of each line to deter-
mine the offset. The slope is removed in the X direction by a planefit on the whole image.

Magic Mask Performs a first order flatten on each line, then calculates a mask and redoes the
flatten. This process is reiterated until it is satisfied. This process is similar to flattening offline
images

Magic Mask (Pits) Use if the sample happens to be imaging something with pits. This algorithm
can’t tell if the features are pits or bumps.

12.4.6. Real-time or Saved Displays

Use the dropdown menus to display or save the trace, retrace, or both images. The author suggests
saving both traces, though rarely displays both, unless the sample is expected to give an interesting
result on the trace and retrace.

12.5. Capturing Images

The process of capturing image files occurs in the Main tab of the Master Panel.

BETA Page 158



Ch. 12. Managing Image Data Sec. 12.5. Capturing Images

Figure 12.7.: MasterPanelMainSaveOptions

Base Name Type a 17-character (or less) filename. The filename can’t start with a number.

Base Suffix Increases this by one with every additional captured image, as the software is designed
to do continuous capture, increasing.

Note Allows an unlimited length of text to describe imaging and experimental conditions that can
later be recalled in the Show Note option in the Commands dropdown menu of the Display window.

Save Images When selected, a dialogue appears to choose where to save the image data. Use the
‘Browse’ button to change folders or type a new folder name. Alternatively, the path can be typed
using colons ( : ) or backslashes ( \ ) to separate folders.

Note that, during imaging, this button changes to ‘Save Partial’, a function that allows you to save a
partial image before the entire image has been collected.

Save Status Shows if it is saving the current scan or the next.

Save Prev Saves the previous image scan if you had not initially saved it to disk. (It is temporarily
stored in experiment memory.)

Browse Allows you to look at stored images.

Save Graphics File (standard Igor panel):

If you only a want a screenshot of one of the windows, go to File > Save Graphics, and the Save
Graphics File dialog box appears (Figure 12.8).

Figure 12.8.: Saving graphics in Igor allows you to define the size, file type, screen resolution, file-
name, and path.

There are many things that can you can define yourself in this panel, including:
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Size The size of the saved graphics image can be adjusted here.

File Format Choose the type of file (TIF, JPEG, etc.).

Resolution Choose 1, 2 or 4x the resolution- larger values good for larger presentations to reduce
appearance of pixilation.

File Name Enter a file name.

Path The path needs to be defined. You can do this by going to the main menu and choosing:

• Misc > New Path. This will bring up the New Symbolic Path dialog box (Figure 12.9).
• Name the path. (The author generally uses one letter, because it’s easy.)
• If you need to change the path to the folder, click the ‘Path’ button. This brings up the Pick a

Folder dialogue.
– Click the ‘Browse’ button to select the folder you want and click ‘OK’ when complete.

This will update the New Symbolic Path dialog box with the proper path.
– Click the ‘Do It’ button, which installs the new path choice into the Save Graphics File

window ( Figure 12.8).

(a) Choose Path (b) Browse or type path folder (c) Once a proper path is designated,
click the ‘Do It’ button.

Figure 12.9.: Choosing a Path in Igor from the main menu: Misc > New Path.

12.6. Offset Scan Area

Images can be offset in a number of ways, including:

1. Manually typing in a value in each of the X, Y offset parameter fields. For more precision,
pull up the Igor cursors (Ctrl + I) to get the coordinates of the center of the offset image.

2. Use the hamster wheel, with activated radio buttons, to move. This method is not recom-
mended since Igor’s update time is the rate limiting step in the process.

3. Place the cursor somewhere on the image or the trace/retrace line, left-click the mouse button
and choose X, Y, X-Y offset, or Offset Next Scan from the pop-up menu that appears.

4. Use the Igor cursors (Ctrl + I) to determine the exact XY coordinate of the center of the
offset; type these values into the X & Y offset fields.

5. During the same imaging session, the tip can be offset by performing a similar operation
as described in option 3 on saved data. The tip will go to the area selected, thanks to the
superior closed-loop sensors.

Note If the head has been touched for some reason between the time the image was captured and
type of offset is selected, there is a great possibility that the head had been displaced by a couple
microns in the kinematic divots on the baseplate.
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12.7. Zooming Images

There are multiple ways to zoom on an image feature, including:

1. Manually type a value for the Scan Area. This will zoom with the same image center as the
previous scan area, unless you manually offset, which would be a separate step (see 12.6).

2. Use the mouse cursor to draw a box around a feature of interest on the image. Note that the
Igor mouse cursor changes shape when a popup menu is available. Right-click and select
one of the following menu options:

a) Zoom Zoom To pick the smallest side of the (imprecise) rectangle that was created.
12.10 shows an example of this.

b) [edit] Zoom Zoom For more a more precise zoom; manually type in the ‘Desired Size’
value. Click ‘Do It’ to zoom to the desired location.

Zoom Zoom Dialog box, opened from an image.

c) Nice Zoom Zoom To round to a “nice” number for the scan area.

An example of zooming can be seen below ( Figure 12.10).

Figure 12.10.: This is an example of zooming on a feature. Image: Moth eye in air using AC mode.

12.8. Multiple Offset/Zoom Parameters

You can determine multiple offset/zoom parameters two different ways:
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1. Use the Igor cursor (Ctrl + I) to determine XY coordinates before offset zoom.

2. From a larger scan area image, zoom on one area, and then use the larger scan area saved
data to zoom on second feature.

In some instances, it is desirable to zoom into two separate areas/features of interest from a larger
scan area. The only problem is knowing the exact coordinates of the scan area image centers
beforehand so they can be typed in as Offset values when the time comes.

This is easy to accomplish in Igor: Press Ctrl + I to bring up the Igor cursors, then place them in
the areas of interest to determine the X,Y coordinates within the scan area.

Figure 12.11.: Using the Igor (Ctrl + I) cursors to find the XY coordinates within a scan area during
real-time imaging.

Figure 12.12.: Copy coordinates in the Command line as comments.

It is a good idea to record these numbers so you can use them in the future, especially for the second
image zoom/offset. In the Command line, type a comment beginning with two forward slashes (//).
You can easily retrieve these values by scrolling up into the History window (Figure 12.12).

Zooms/offsets can also occur from a saved image.

Note To be of significance, the saved image must be viewed while the instrument is still scanning
within that 90 um XY scan area. Figure 12.13 shows an example of this.
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(a) Real time scan to zoom-in on one area. (b) Using saved data of inital real-time data to
zoom on another area of interest.

(c) Large saved image. (d) Real-time zoom image (panel A).

(e) Zoom from saved image (blue box in
large saved image).

Figure 12.13.: Zoom/offsets from saved data.
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12.9. Real Time Section Analysis:

12.9.1. Basic Real-Time Line Section Analysis:

To measure a section line analysis during a real-time image acquisition, you can use the Analyze
Panel (Figure 12.14).

Figure 12.14.: Section tab of the Analyze Panel.

1. Go to MFP IP > Analyze Panel.

2. Select the ‘Include RealTime’ check box.

3. Line will be selected by default for the ‘Mode’, because it is unable to do free hand lines in
real time.

4. Click the ‘Draw’ button. Pull the cursor over the image feature to draw a line on the area of
interest in the image (Figure 12.15).

5. Select the ‘Full Width’ check box for sections to traverse to the edge of scan areas along the
line vector drawn (Figure 12.14).

6. Multiple scan lines can be averaged to eliminate noise or give more statistical relevance to
the sectioned line.

7. Once the line is drawn, a Section plot appears, similar to that shown in Figure 12.15. You
can place the Igor cursors (Ctrl + I) on the curve to measure points on the line, displayed
in the lower half of the Analyze Panel. (Notice the blue cursors on the feature in the image
being measured at FWHM.)
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(a) Drawn line on image (b) Corresponding section analysis, with user-
positioned Igor cursors. The lower portion of Ana-
lyze Panel gives specifics of line relative to cursor
locations.

Figure 12.15.: Real time section analysis

If the Y axis data values do not match the values in the Sum and Deflection Meter, some type of
real-time flattening is probably activated that will offset the data. Switch the real-time flattening
(‘Live Flatten’) to None in the Master Channel Panel (Figure 12.2).

If the image happens to possess some tilt, it won’t be intuitive to get a proper height from the
cursors. To remedy:

1. On the section plot, hold down the Crtl + Shift keys over the curve to be “leveled” (Figure
12.16).

2. Right or left mouse-click over the line scan; a double arrow appears.

3. Move the mouse up or down to make the section level. From here, you can put the Igor Crtl
+ I cursors on to measure the dY.

4. Click the ‘Export Table’ button in the Section window to get these cursor stats (i.e., Xa, Ya,
Za; Xb, Yb, Zb; plus differential values and angle values).
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(a) Ctrl + Shift + Mouse button over section to
obtain double-arrow cursor.

(b) Move mouse up or down to lever section.

Figure 12.16.: Real-time section leveling to obtain more accurate height differentials.

12.9.2. Adjusting the Angle of the Section Line

1. Click the ‘Clear’ button in the Analyze Panel and redraw a new line over the feature of interest.

2. Grab one end of the Igor cursors on the section line in the image by left mouse-clicking and
hold while dragging the cursor to new point (Figure 12.17). This will also update the Angle
value.

3. Select the ‘Angle’ check box to manually adjust the Angle value.
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(a) Drag one of the end Igor cursors to a new area. (b) Result

Figure 12.17.: Adjusting line section angles

To average multiple scan lines, enter the desired amount of scan lines to be averaged for the Width
in the Section tab of the Analyze Panel. Lines will be displayed with a solid center indicating center
and dotted lines representing the averaging scan line width.

Figure 12.18.: Averaging multiple scan lines (a 25 line average in a 512 x 512 image resolution)
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12.9.3. Plotting Multiple Section Lines on One Section Plot

1. Create a section line as described above.

2. Click the ‘Take a "Snap Shot" of active trace and append to upper graph’ button.

3. Create an additional section line.

4. Click the ‘Take a "Snap Shot" of active trace and append to upper graph’ button again.

(a) Create first section plot (b) Click “Snap Shot” button in Sections panel

(c) Create an additional section plot, and then click
“Snap Shot” button again

(d) Resulting multiple section plots (Red: sin-
gle line, Blue: averaged line, Green: single line)
(Sample: collagen in air)

Figure 12.19.: Plotting multiple sections on one section plot

12.9.4. Export the line section XY data:

Click the ‘Edit’ button in the Section plot. This will bring up a table with a Y value relative to
the points in the Igor Wave (see the Igor Getting Started manual to understand the definition of a
wave), and the blue cursor points. Take the following steps:
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1. Go to Windows > New Table.

2. Select ‘SectionWaveX & SectionWaveY’.

3. Click ‘Do It’. This will create an X,Y delimited table from which numbers/data can be cut
and pasted.

12.10. Other Features

12.10.1. Windows Manager

The windows manager helps find windows when you have many different panels and tables open.

• Ctrl + Shift + 1 opens the window (Figure 12.20).
• Find the panel, graph, or table you are interested in and double-click it. This will bring that

window forward.
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12.10.2. Saving Igor Experiments

Saving the Igor Experiment is a great way to begin right where you left off. When you save an
experiment, all the panels, graphs, etc. will come up just as it was exited. Other advantages to
saving them is that every command executed is stored in the History window. Recall that Igor is
memory-based, so many full days of this will make the file large and ultimately slow the program.

One downside to this feature is that .pxp experiments can be fairly large files. If you save pxp’s on
a regular basis, it is a good idea to back up these files or remove them from the lab PC so it doesn’t
get bogged down with a full hard drive.

One of the best ways to open a saved experiment is to open the AR software, then go to File > Open
Experiment to select the saved experiment you want to open.

Note The experiment will open if you used the same software version (or slightly later) to open
the saved experiment.

12.10.3. Adding Bars to the Sum and Deflection Meter

To view additional signals in the Sum and Deflection Meter:

1. Click the ‘Setup’ button.

2. Change the parameter of interest ‘Status’ from to “On”.

3. Click the ‘Done’ button.

Figure 12.21.: Turning on additional meters in the S&D meter.

Figure 12.21shows the phase signal being selected, such that the quantitative value of the signal can
be seen during imaging. This will show whether the tip is experiencing net attractive or repulsive
forces as it interacts with the surface .

12.10.4. Modifying Igor Graphs

To define or adjust the thickness, color, or appearance of a line in any Igor Pro window, double-
click the mouse on the plotted line. The Modify Trace Appearance dialog will come up (Figure
12.22) where you can make any changes. When finished, click the ‘Do It’ button.
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Figure 12.22.: Modify Trace Appearance dialogue.
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13. Exporting Raw Data
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13.1. Exporting Your Data in ASCII Format

You can export any wave in Igor. 90% of the battle is finding the wave.

To export a wave:

1. Double click on the wave. You get a Modify Trace dialog.

2. Hold down the left mouse button on the name of the wave that looks like the correct wave.
The box below will show the data folder that is holding that wave.

3. A different way to find the folder is to press Shift + F1, then click on the trace. This displays
a tooltip type box with the names of the waves and the data folders.

4. Go to the Data > Data Browser menu. Locate the data folder that was shown by the dialog.
Alt + left-click to the left of that data folder. There should now be a red arrow pointing at
that folder letting you know that you are in that folder.

5. Go to the Data > Save Waves > Save Delimited Text menu. Select the wave from the list of
waves in that data folder.

6. Click ‘Do It’. Then, select where you want to save the .dat file.

7. Note that images are layered waves, 3 dimensional. Ascii can only handle 2D waves, so the
layers are stacked in the rows.

Example:

• Make/N=(3,4,2) LayeredImageWave
• LayeredImageWave = P+Q*10+R*100 [P is row index, Q is column Index and R is layer

Index, all indexes start at zero]
• Save/J/M="\r\n" LayeredImageWave as "LayeredImageWave.txt" saves the .dat file with this

in it:

0 10 20 30 1 11 21 31 2 12 22 32 100 110 120 130 101 111 121 131 102 112 122 132
• As you can see, the 4th row and above are > 100; they came from the second layer of the

igor wave.
• You can either deal with all the data in one wave, pulling the layers out that you want, or

you can save only the layer you care about by first extracting the layer (with the command
popup, extract layer) and then saving the wave LayerData as the ascii.
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Exporting to matlab:

• Export Data. As images and as other raw formats used with Matlab.
• C:\Program Files\WaveMetrics\Igor Pro Folder\Technical Notes\Igor Tech Notes\TN003 Igor

binary format\TN003.ifn a technical note on the Igor file format.
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Part III

Programming
Part III: Who is it for? The AR SPM software can be customized for your needs in a variety of
ways. Custom control panels and macros can be set up with no programming needed. But if you
want even more control you can write your own Igor code. This section will cover the basics of
writing Igor code to control the AFM.
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14.1. Introduction

The purpose of this tutorial is to give you a start on learning how to control the AFM at a low-level
using Igor. You might want to do this to make the AFM do things not available in the graphical user
interface (gui) of the software. Before running through this tutorial you should be very comfortable
using the AFM and, ideally, have practiced a little bit of Igor programming. At the very least, it
is important to understand the difference between a wave’s scaling and wave indexes and doing
waveform assignments from the Command line. The "Getting Started" tutorial in the Igor manual
can teach you this much. This tutorial focuses on commands specific to the Asylum AFMs. At the
end of this tutorial, we’ll discuss some references for more programming commands.

14.2. Conventions

Anytime in this tutorial where you see something indented and in a different font, such as

print td_ReadValue("Head.Temperature")
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it is meant to be executed from the Igor Command line. You can just copy and paste text, but you
will learn more quickly if you type them out yourself. The value that the function returns to the
Igor history is often shown below the command, for example

print td_ReadValue("Head.Temperature")

31.625

This is just to show you what you might expect to see. You should not enter the 31.625 into the
Command line.

14.3. Help

The majority of commands you will be learning about are commands that start with td_. The
td stands for 3D and/or Todd Day, the programmer that created the commands. Help for these
commands can be found in the Xop Help file. The easiest way to get to this is to go to the menu
Help > Command Help. This brings up the Help Browser, and you can just scroll down to get help
on the command you are interested in learning about. Make sure the ‘Functions’, ‘Operations’, and
‘Programming’ check boxes are checked.

Another very useful help item is that, if you type the command into the Command line and right-
click on it, you can go to the Help for that command or insert a template. Inserting a template is
very useful if a command takes several parameters and you don’t remember the order.

14.4. Low Level Parameter Names

Everything on the instrument that has a value to read or control has a parameter name. These
parameter names are constructed as Device.[Group(s)].]Parameter. For example, to read the
value of a thermometer that is built into the MFP-3D head, you would execute the following:

print td_ReadValue("Head.Temperature")

31.625

The head refers to a specific device that is part of the instrument, while the temperature is a specific
parameter that the head owns. Examples of devices are the head, scanner, and ARC. Additional
devices, such as heaters, can also be added to the instrument. You can see all the devices hooked
up to the instrument by clicking on the gear icon at the bottom-left side of the screen.

As many devices have a lot of parameter names, there is an additional level of organization called
groups. For example, the ARC has a lot of analog-to-digital converters (ADC’s) and digital-to-
analog converters (DAC’s) in it. There is a group named "Input" that contains the ADC’s, and a
group named "Output" that owns the DAC’s. Furthermore, the controller device is often omitted
from the address, as it is the default device to read from. So, for example, to read the value of the
X sensor, you would execute the following:

print td_ReadValue("Input.X")

-6.84063

Similarly,
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print td_WriteValue("Output.X", 60)

0

would apply 60 volts to the X piezo. Note that when you use commands like td_WriteValue,
where you don’t expect an output, you should still precede them by a print command. They will
return 0 if everything worked, and a non-zero error code if it didn’t. For example, if you misspell
something, you will probably see a 3 or 5 returned.

Note that some outputs can also be read as inputs. You might be interested in knowing what the
current voltage to the X piezo is before you change it. You execute:

print td_ReadValue("Output.X")

60

Another way to access these parameters is to use the menu that pops up when you click on the
gear icon at the bottom-left side of the screen. A pop-up menu with icons of the devices currently
hooked up will appear. For example, to see the changes you just made, float the cursor over the
icon of the ARC in the menu, and an additional pop-up menu appears. Float the cursor over the
parameters menu, and yet another pop-up menu appears with a list of all the devices owned by the
ARC. Select Output, and a panel will pop up that contains all the parameters in the output group.
Click on the ‘read’ button, and you should see that the X output has a value of 60 V.

Before you start, the HighVolage Relays must be checked to see if they are open or closed. Click
on the ‘ARC’ icon in the toolbar and navigate to ARC .Parameters .Default. Then, use the ‘read’
and ‘write’ buttons to look at and set the state of the HighVoltageXYRelay and HighVoltageZRelay.
You can also change the state of the relays at the command link as follows:

print td_WriteValue("HighVoltageXYRelay",1)

0

OR

print td_WriteString(�HighVoltageXYRelay�,�Closed�)

0

At the top of the Help file, there is a complete list of parameter names as well as the error codes.

14.5. High Level Parameter Names

There are also parameters that exist in Igor rather than down at the device level. If you select
Programming > Global Variables > Master, you will see a table full of parameters and descriptions
of what they control. For example, the top item is the ScanSize and shows the scan size in meters
under the value column.

Though you can read these values from the table, while programming it is useful to access them
with the GV (Get Value) routine. Executing

print GV("ZPiezoSens")

will print the sensitivity of the Z piezo, in meters per volt, into the history. See Table 14.1 for a list
of other get functions.

support.asylumresearch.com Page 180



Ch. 14. Basic Programming Tutorial Sec. 14.6. The Crosspoint Switch

Table 14.1.: Get Functions

Function Name Description

GDS(’Parameter Name’) Get Description String

GFS(’Parameter Name’) Get Format String

GUS(’Parameter Name’) Get Unit String

GTS(’Parameter Name’) Get Title String

GPS(’Parameter Name’) Get Panel String

GV(’Parameter Name’) Get Value

GVU(’Parameter Name’) Get Units

GVL(’Parameter Name’) Get Value Low

GVH(’Parameter Name’) Get Value High

GVMU(’Parameter Name’) Get Value Min Units

GVS(’Parameter Name’) Get Step Size

14.6. The Crosspoint Switch

To make the instrument much more flexible, the controller has something called a crosspoint switch
inside of it. The crosspoint switch is a lot like an old telephone patch board. It has 16 inputs and 16
outputs, and you can connect virtual wires between any of the inputs and any of the outputs. You
can have multiple wires running from one input to many outputs.

The crosspoint switch can make programming somewhat more complicated because a given ADC
isn’t always connected to the same things. From the main menu bar, select Programming > Cros-
spoint Panel to bring up a panel that allows you to see and control the wiring of the crosspoint
switch. Switch between Contact mode and AC mode to see how some of the signals are rerouted.
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Figure 14.1.: Crosspoint Panel

When programming, you may find yourself using the BNCs on the front of the controller. These
appear on the crosspoint switch inputs and outputs. To help keep you sane, we named all the extra
ADCs and DACs with letters (e.g., InA) and the physical BNCs with numbers. So, for example,
you can connect the BNC In0 to the ADC InA using the top dropdown menu in the Crosspoint
Panel, and then clicking the Write Crosspoint button.

The crosspoint switch can also be set with td_WriteString commands. For example,

print td_WriteString("Crosspoint.InA","BNCIn0")

0

would accomplish the same thing.

Probably the most confusing option on the crosspoint is the ‘FilterIn’. By routing a signal to ‘FilterIn’,
you are routing it into a low pass filter of about 36 kHz. The filter signal then reappears as an input
to the crosspoint switch named ‘FilterOut’. This filter is useful for filtering high bandwidth signals
(e.g., Defl) before passing them to a 50 kHz ADC like ‘InA’.

A simple example with td_ReadValue and td_WriteValue

You can use the td commands to move the X stage around and measure its motion with the X
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sensor. The stage is approximately centered at 70 volts. If you execute the following commands in
a row, you should see output similar to those listed below:

print td_WriteValue("Output.X",60)

0

print td_ReadValue("Input.X")

-.0396402

print td_WriteValue("Output.X",70)

0

print td_ReadValue("Input.X")

-0.698834

print td_WriteValue("Output.X",80)

0

print td_ReadValue("Input.X")

1.51577

You just drove the X stage to 60, then 70, then 80 volts. As you can see, the sensor voltage measured
this movement and returned three different values. To see what happened in meters instead of volts,
we can use the sensitivities to convert the voltages.

print GV("XPiezoSens")*20

1.07474e-05

This means moving the stage from 60 to 80 volts (20 volt change) should have produced about 9.6
microns of movement. In reality, the sensors measured:

print (1.51577 - -.0396402)*GV("XLVDTSens")

1.1625e-05

This is about 11.6 µm. The fact that the stage moved more than we expected is the reason we have
the sensors. How far the stage movement is off is dependent on scan size. Try the above experiment
for a 2 volt change (drive X to 69 volts and then 71 volts), and you should get better agreement.

While you could make the sample move around by stringing together alot of td_WriteValue

commands, that is tedious. A better way is to use an Igor wave to control the stage and collect data.
This is described in the next section.

14.7. Parameter Control and Collection

It is good practice before sending instructions to the ARC to stop current instructions. The td_stop()
command does this but in general it should not be used as it stops all outwaves, inwaves, and feed-
back loops.

For now let’s just use the td_stop command:

print td_stop()

0

Now, make two Igor waves, one to store voltages to drive the X stage and one to store the sensor
values we read:

support.asylumresearch.com Page 183



Ch. 14. Basic Programming Tutorial Sec. 14.7. Parameter Control and Collection

Make/N=1024 PiezoVoltage SensorVoltage

Next make a graph of each

Display PiezoVoltage

Display SensorVoltage

Move the graphs so you can see both of them. You’ll notice that, right now, the wave scaling of both
is just p scaling. The X axis on each wave is from 0 to 1023. To use this wave to drive the piezo
voltage, it is much more convenient to have the x scaling in time. While you could set it by hand,
the easiest way is to use a td command. To set up an output wave, you use the td_xSetOutWave

command. You can find detailed help for the command described in Section 14.3 on page 179.

The syntax of the command is:

td_xSetOutWave(whichBank, eventString, channelString, wave,

interpolation)

The parameters are:

whichBank Determines which memory bank in the DSP the wave will be stored in. There are
three banks of memory, labeled 0,1, and 2, and each can hold up to two pairs of waves. These
waves can be up to 87,380 points long and must be single-precision (32 bit) floating point.

eventString Determines when the data will be output. You can think of them as a trigger. You
usually don’t want the wave to be output as soon as it reaches the DSP because you might want to
synchronize the output with some data collection. The events are group of parameters owned by
the controller, so a typical eventString would be "Event.0", but for functions that have a specific
event argument, it is simply “0”, the “event.” can be dropped. When we later change the value of
this event parameter, the wave will be output to the DAC that drives the X voltage.

channelString A low-level parameter name like we learned about above. In this case, it is "Out-
put.X".

wave Name of the Igor wave with the data to be sent. Here it is “PiezoVoltage”.

interpolation Determines how quickly the wave are output. The DAC’s and ADC’s on the ARC
all run at 50 kHz, so an interpolation of 1 means that each point in the Igor wave corresponds to a
50 kHz sample. For the 1024 point waves you made, this means the entire wave would be output
in about 20 milliseconds. This is very fast, so we will choose an interpolation factor of 100 to give
us about a 2 second output.

Note Older versions of the AR SPM software (prior to version 101010) ran the ADCs at 100kHz.
In that case, the output of the above example would take only 1 second.

Before we send the wave to the ARC, we need to populate it with values. Currently, each point is
set to zero. In this case, lets make a ramp over the full range of the piezo (-10V to 150V):

PiezoVoltage[0,511] = -10 + 160*p/511

PiezoVoltage[512,1023] = 150 - 160*(p-511)/511

Putting this all together gives:

print td_xSetOutWave(0, "0", "Output.X", PiezoVoltage, 100)

0
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If you did everything right, you should have gotten a zero (0) in the history.

If you look at the graph of PiezoVoltage that you made, you will notice that the x scale has been
updated to reflect the time that the wave will take to output. Shown in Figure 14.2 on page 185.

Figure 14.2.: Piezo Voltage vs. Time

Now you need to set up the SensorVoltage wave to record data. The syntax of the command is
fairly similar to that of td_xSetOutWave:

td_xSetInWave(whichBank, eventString, channelString, wave, callback,

decimation)

The first four parameters are conceptually identical except channelString will now be an input
instead of an output.

We also have a callback parameter and decimation instead of interpolation. Decimation is the
opposite of interpolation. Rather than creating points, we want the DSP to reduce the number of
points coming back. Sometimes getting data at 50 kHz is a bit like drinking from a fire hose, and
you want less information.

The callback function is an Igor function that will be called when the input data has been collected.
This is useful so that control returns to Igor while the data is being collected (otherwise Igor would
freeze during data collection). This function might be something that does some analysis on the
data.

To show how the callback works, let’s make a very simple example that prints “Done” when the
callback hits. To do this, we must write some code not in the Command line. Select the Windows
Menu > New > Procedure. Leave the name as is and click the ‘New’ button.

Type the following onto the procedure window:

Function InWaveCallback()

print �Done�

End

Now when the callback function hits, it should print “Done” to the Command line.

One major conceptual difference here is that, rather than the data being stored on the DSP like the
output data, it is continually streamed back to the PC. This means the banks correspond to "pipes"
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on the USB connection rather than memory. There are 3 banks, each bank brings back 1 or 2
channels of 24-bit data.

Putting all this together gives:

print td_xSetInWave(0, "0", "Input.X", SensorVoltage, "InWaveCallBack", 100)

0

You will see that the x scaling on the SensorVoltage graph has now changed to seconds. You
now have set up everything and all you have to do is trigger Event.0. For this, it is easier to
use td_WriteString instead of td_WriteValue. They are identical except the first is used for
passing strings instead of numbers.

print td_WriteString("Event.0", "once")

0

Done

If all went well, after about a second, you should see the SensorVoltage wave get updated with data,
and “Done” printed in the Command window. The curvature shows that the piezo isn’t moving
linearly. If the graph shows noise, then the high-voltage relays are in the open state, so the voltage
is not getting to the piezos. You can check this by clicking the ‘Controller Icon’ button on the Igor
window and navigating to ARC > Parameters > Default. Then use the ‘read’ and ‘write’ buttons to
look at and set the state of the HighVoltageXYRelay and HighVoltageZRelay. You can also change
this at the Command line as follows:

print td_WriteValue("HighVoltageXYRelay",1)

0

print td_WriteValue("HighVoltageZRelay",1)

0

If you graph the SensorVoltage vs. the PiezoVoltage, you will see the hysteresis loop traced out by
the stage (see Figure 14.3 on page 186), using:

display SensorVoltage vs PiezoVoltage

(a) Sensor Voltage vs. Time (b) Sensor vs. Piezo Voltage

Figure 14.3.
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14.8. Drive the XY Stage in a Circle

The set of commands below will drive the XY stage with voltages corresponding to a circle al-
most full scale for the stage. The sensors will measure what really happened. The example uses
td_xSetInWavePair and td_xSetOutWavePair, both of which are very similar to the commands
you learned above. You can watch the sample movement using the optics of your microscope.

make/N=(1024)/O XVoltage YVoltage XSensor YSensor

display XVoltage; appendtograph/R YVoltage

display XSensor; appendtograph/R YSensor

print td_xSetOutWavePair(0, "0,0", "Output.X", XVoltage,

"Output.Y",YVoltage,100)

//0

XVoltage = 70 + 70*cos(2*pi*x/1.024) //X is seconds, 1.024 is the time per cycle

YVoltage = 70 + 70*sin(2*pi*x/1.024)

print td_xSetOutWavePair(0, "0,0", "Output.X", XVoltage,

"Output.Y", YVoltage,100)

//0

print td_xSetInWavePair(0, "0,0", "Input.X", XSensor,

"Input.Y", YSensor, "", 100)

//0

print td_WriteString("Event.0", "once")

//0

print td_WriteString("Event.0", "once")

//0

display YSensor vs XSensor

ModifyGraph width={Plan,1,bottom,left}

(a) X,Y Voltage vs. Time (b) Y Sensor vs. X Sensor

Figure 14.4.

As you can see by Figure 14.4 on page 187, because of piezo non-linearities and hysteresis, the
circle isn’t very round.
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14.9. Feedback Loops

Note This section is very advanced, and you run the risk of damaging your microscope sensors if
using unstable gains.

For a lot of things that you might want to do, such as make a round circle, you will want to use a
feedback loop. The controller is able to run six PIDS loops. These loops have the following gains:

• Proportional gain P
• Integral gain I
• Differential Gain D
• Double-integral gain S

Each parameter belonging to the loop can be accessed;. For example, PIDSLoop.0.IGain is the name
for the Integral gain of loop 0.

One problem with feedback loops is that, if you pick the wrong gains, the feedback loop can
oscillate. Besides being incredibly loud, this can also push the sensors out of alignment.

The easiest thing to do is to look at the values that the software uses. Be careful not to look at the
gains in the panels themselves (like integral gain on the Main panel or the X and Y gains on the
XY gains panel). These are scaled to make it more convenient for users to think about.

To peek at the value that the software uses for Z in contact mode, click ‘Engage’ on the meter
panel. It doesn’t matter if you have a cantilever in or not. This turns on the Z feedback loop. The
following commands will then read the three gain values. This result is typical for contact mode.

print td_ReadValue("PIDSLoop.2.PGain")

0

print td_ReadValue("PIDSLoop.2.Igain")

1000

print td_ReadValue("PIDSLoop.2.SGain")

0

It is easiest to look at their values in the PIDS Loop Panel. Go to Programming > XOP Tables >
PIDS Loop Panel.

For AC mode, the gain will be the opposite sign and smaller.

Similarly, to see the X and Y gains, click ‘Do Scan’ and look at the PIDS Loop Panel, or you could
execute the following:

print td_ReadValue("PIDSLoop.0.PGain")

0

print td_ReadValue("PIDSLoop.0.IGain")

6887.8

print td_ReadValue("PIDSLoop.0.SGain")

1075803

print td_ReadValue("PIDSLoop.1.PGain")

0

print td_ReadValue("PIDSLoop.1.IGain")

6357.8

print td_ReadValue("PIDSLoop.1.SGain")

1007645
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In almost all software versions, the X loop is on the first PISLoop (PISLoop.0), the Y is on the
second (PISLoop.1), and Z is on the third (PISLoop.2). There is a small chance that the X and Y
are on PISLoop.3 and PISLoop.4. You would see this if you went to read the gains.

To set up a feedback loop, you use the ir_SetPISLoop command. This is because the PIDSLoop
panel is automatically updated by the AFM software and does not allow manual overwrite. The
syntax of the ir_SetPISLoop command is:

ir_SetPISLoop(whichLoop, eventString, inChannelString, setpoint, pgain,

igain, sgain, outChannelString,OutputMin,OutputMax)

The parameters are:

whichLoop Determines which of the six feedback loops you will use. They all run at 50 kHz.

eventString Similar to the events described above. Unlike with input and output waves, with
feedback loops you often want them to start running immediately. Passing a string of "Always"
for the eventString will make this happen for the start string; there also needs to be a comma and a
string for the stop event, in our examples "Never".

inChannelString The channel string for the input to the feedback loop. For example, in Contact
mode, this is one of the ADCs (InFast usually), which is wired up to Defl.

setpoint, pgain, igain, sgain The setpoint and gains for the loop. After the loop is set up, the
setpoint can be driven by a wave. This would be used, for example, to move the XY stage around
under feedback control. Note the gains are scaled to be mathematically right. A pgain of 1 will
give you a 1-volt output for a 1-volt input. Similarly, the same 1-volt input with an igain of 1 will
give you a ramp from 0 to 1 in one second.

outChannelString The output of the feedback loop. For Contact mode, this would be the Z DAC.

OutputMin OutputMax The range of values used for the OutputChannel.

14.10. Setting Up Your Own Z Feedback Loop

To set up your own feedback loop in Z, first turn on the meter and make sure you have a deflection
close to zero. Also make sure the cantilever is close to the surface by doing an engage the normal
way and then withdrawing. Above, you saw that for contact mode, typical gains are P=0, I=1000,
and S=0.

First you hook up the Defl channel to the InA ADC by executing:

print td_WriteString("Crosspoint.InA","Defl")

0

Next, you set up the feedback loop with:

print ir_SetPISLoop(2,"Always,Never","Input.A",1,0,1000,0,

"Output.Z",-10,150)

0

If all went well, you should see on the meter that the Zvoltage went to a stable value and that the
deflection is at 1 volt.

support.asylumresearch.com Page 189



Ch. 14. Basic Programming TutorialSec. 14.10. Setting Up Your Own Z Feedback Loop

Fig Closed Loop Circle We need to figure out what the gains are for X,Y, and Z. This is done
with the same read value commands as above. The microscope should be engaged and scanning.

td_RV is a shorthand function that calls td_ReadValue.

variable/G X_PGain, X_IGain, X_SGain, Y_PGain, Y_IGain, Y_SGain,

Z_PGain, Z_IGain, Z_SGain

X_PGain = td_RV("PIDSLoop.0.PGain")

X_IGain = td_RV("PIDSLoop.0.IGain")

X_SGain = td_RV("PIDSLoop.0.SGain")

Y_PGain = td_RV("PIDSLoop.1.PGain")

Y_IGain = td_RV("PIDSLoop.1.IGain")

Y_SGain = td_RV("PIDSLoop.1.SGain")

Z_PGain = td_RV("PIDSLoop.2.PGain")

Z_IGain = td_RV("PIDSLoop.2.IGain")

Z_SGain = td_RV("PIDSLoop.2.SGain")

printf "X Gains: P:%.4g I:%.4g S:%.4g\r", X_PGain, X_IGain, X_SGain

printf "Y Gains: P:%.4g I:%.4g S:%.4g\r", Y_PGain, Y_IGain, Y_SGain

printf "Z Gains: P:%.4g I:%.4g S:%.4g\r", Z_PGain, Z_IGain, Z_SGain

Now let’s make a variable Radius (the size of the Radius circle in volts). The range of the sensor is
between -10V and +10V, but they don’t use the full range. Try using 3V for a radius:

variable Radius

Radius=3

We then need to make all the waves as follows:

Make/N=(1024)/O XVoltage YVoltage XSensor YSensor XCommand YCommand

Display/K=1 /W=(5.25,41.75,399.75,250.25) XVoltage

Appendtograph/R YVoltage

Display/K=1 /W=(7.5,275.75,402,484.25) XSensor

Appendtograph/R YSensor

Display/K=1 /W=(409.5,41.75,662.25,250.25) YSensor vs XSensor

ModifyGraph width={Plan,1,bottom,left}

Now set up the circle commands:

XCommand = Radius*cos(2*pi*p/1024)

YCommand = Radius*sin(2*pi*p/1024)

We should do a td_stop() to make sure nothing else is running:

print td_stop()

0

We now set up the feedback loops for X and Y. Notice how the initial setpoint is set to the Radius
for X and 0 for Y. This is because the XCommand starts at a voltage equal to the Radius and the
YCommand starts at 0V.

print ir_SetPISLoop(0,"Always,Never","Input.X",Radius,X_PGain, X_IGain,
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X_SGain,"Output.X",-10,150)

0

print ir_SetPISLoop(1,"Always,Never","Input.Y",0,Y_PGain, Y_IGain,

Y_SGain,"Output.Y",-10,150)

0

We then pass the feedback loop voltages that we would like by using a command signal, and it
will vary the XVoltage and YVoltage to try to achieve this. We use the trick to look at outputs
(Output.X) as inputs to see what the voltages are and similarly display the input voltages.

print td_xSetOutWavePair(0, "0,0", "PIDSLoop.0.Setpoint", XCommand,

"PIDSLoop.1.Setpoint",YCommand,100)

0

print td_xSetInWavePair(0, "0,0", "Output.X", XVoltage, "Output.Y",

YVoltage, "", 100)

0

print td_xSetInWavePair(1, "0,0", "Input.X", XSensor, "Input.Y",

YSensor, "", 100)

0

As you can see in Figure 14.5 on page 191, the circle should be perfectly round.

(a) X,Y Voltage vs. Time (b) Y Sensor vs. X Sensor

Figure 14.5.

14.11. Creating Your Own Programs

While all the examples here have been performed from the command line, except the callback
function, it is pretty easy to start copying and pasting commands to make your own functions
inside procedure windows.
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14.12. More Programming Resources

14.12.1. Manuals

The AR SPM software is written in a third party software environment called Igor. There is a
pdf of the Igor manual in <\Igor Pro Folder>\Manual\IgorMan.pdf, where <Igor pro Folder> is
the location where the Igor software is installed. The manual starts with the all-important “Getting
started” guide. Igor is supplied by Wavemetrics, and they have an excellent website (http://www.
wavemetrics.com) with additional information like a knowledge base and a user forum.

14.12.2. Help Files

All of the AFM-related user interface panels were programmed by Asylum Research programmers
using the tools available in the Igor environment. To make that easier, many special functions are
subroutines based on Igor commands. An up-to-date list of these Asylum Research functions can
be found in the AR SPM software in the main menu bar under Help > AR Help Files > AR Common
Functions. Note that all these functions are stored in files that you can open and copy from to
make your own custom code and user panels. You might want to explore the higher-level macro
programming capabilities, but, in the end, you are allowed to delve into the source code of nearly
every aspect of the AR SPM Software.

In the same location, there are other useful Help files with respect to programming under Help >
AR Help Files > AR Advanced.

Finally, there is a list of low level commands that are mainly related to communicating with the
Asylum Research hardware. You have already seen some of them in this tutorial (the ones starting
with td_). These commands supplement the ones supplied by Igor. An up-to-date list can always
be found at: Help > AR Help Files > XOP Help Files > MFP3D XOP Help. The MFP3D reference is
historical, and the files also cover more recent instruments such as the Cypher and Jupiter AFMs.

14.12.3. User Forums

Years of Asylum Research SPM Discussion are archived at support.asylumreseach.com. Once
you join, you can peruse the DIY programming section of the forums or post questions. All Asylum
employees are forum members, and, within a day, you will typically get an answer from the experts
at Asylum, as well as from other power users around the world. The support site also hosts the latest
manuals and software updates for your instrument.

14.12.4. Give us a call

You call us if you need additional help. And, always feel free to contact us directly at:

Support@AsylumResearch.com
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15. Using the Command Line

CHAPTER REV. -2, DATED 00/00/0000, 00:00. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Chapter Contents

15.1 Command Line Favorites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

15.1. Command Line Favorites

Here’s a list of common commands (source: "http://wiki.AsylumResearch.com/Common_Commands")
that may be useful (some may be outdated):

Subtracting Images Extractlayer() //extract layer of first image–rename it

Extractlayer() //don’t rename it if you are subtracting first layer from this layer

Layerdata = renamed layer //kicks out subtracted image (but its upside down)

Newimage/F = layerdata //makes it right

//insert this layer back in to do modification of ARgyle on it.

Rotating Images (saved data) (See example in Section Section 7.4.2.3 on page 88.)

Extract a layer from the image to be rotated, then type in the command line:

duplicate layerdata, filename //what do you want to call the image

ïlayerdata = filename[q][X-p] //where X is equal to the number of points in the image per scan
line–remember Igor starts counting at zero:

//insert the layer back into the initial image.

//perform an overlay in ARgyle.

Monitor system parameters print td_ReadValue("Temperature%Default@Head") //reads temp
at head

print td_ReadValue("Temperature%Default@scanner") //reads temp at scanner
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Turn ON/OFF the blinking LED at XYlvdt board and head print td_WriteValue("LedBlinking%Default@XYLVDT",
1) //turns ON LED at XYLVDT board

print td_WriteValue("LedBlinking%Default@XYLVDT", 0) //turns OFF LED at XYLVDT board

print td_WriteValue("LedBlinking%Default@head", 1) //turns ON LED at head

print td_WriteValue("LedBlinking%Default@head", 0) //turns OFF LED at head

Set/read output voltage to XYZ piezo print td_writevalue("Z%Output@Controller", 70) //sets
output to Z piezo

print td_readvalue("Z%input@Controller") //reads z piezo voltage

print td_wv("y%output", 70) //sets output to Y piezo

print td_wv("x%output", 70) //sets output to X piezo

Send voltage pulse output (OutA) using DAC (e.g., 2V, -2) print td_WriteValue("A%Output",
2);print td_WriteValue("A%Output", 0)

print td_WriteValue("A%Output", -2);print td_WriteValue("A%Output", 0)

Print out what 50 pN is in Volts for Spring Constant and Invols //Useful for setting a trigger
during force curves.

Variable MyForce = 50e-12 //I want 50 pN.

Print MyForce/GV("SpringConstant")/GV("Invols")

Display captured video image //First set the data folder to :root or create one like root:Video or
root:Capture

//Then click Capture button

NewImage capture

Better way of displaying captured video image Display; AppendImage capture; ModifyGraph
height={Plan, 1, left, bottom}

Rename captured video image so it doesn’t get overwritten In the Igor Data Browser, Rename
capture pollenA.

Generate a piecewise continuous wave Make/N=65535 wave0, wave1, wave2, wave3

wave0 = (p<32768)?(0):(1)

wave1 = (p<16384)?(0):((p<32768)?(5):((p<49152)?(-5):(0)))

Piecewise linear wave2 = (p<32768)?(-5+p*10/32768):(15-p*10/32768)
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Output a wave to Out0 and collect from In0 in sync //write crosspoint to connect Out0 to OutA
and In0 to InA

print td_Stop() //usually not necessary but safest

print td_xSetOutWave(1, "2,2", "A%Output@Controller", wave2, 2)

print td_xSetInWave(1, "2,2", "A%Input@Controller", wave3, "print 42", 2)

print td_WriteString("2%Event@Controller","Once")

//wait for it to print 42

Display wave3

Note Be sure to read the Help for td_xSetInWave and td_xSetOutWave on banks, decimation, and
interpolation. In particular, you want the decimation and interpolation to be the same if you want
to correlate input with output.

Integrate noise spectra to find biggest contributor //From noise panel, click Save

//In Test Results:Noise, rename folder to a unique name (X01, not X; FastOffSurf, not Fast)

//Make that the current data folder

Duplicate /O PSD Int

Int *= Int //omit this line if you are using *true* PSD from Mario’s new panel

//old Noise panel gives amplitude spectral density as "PSD" and must be squared

Integrate Int

Display PSD; AppendToGraph /R Int

ModifyGraph log(bottom)=1

ModifyGraph RGB(Int)=(0,0,65535)

ShowInfo

//Now look for the biggest step(s) in the blue integrated curve.
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16. Help! Bug Reporting

CHAPTER REV. -2, DATED 00/00/0000, 00:00. USER GUIDE REV. 2436, DATED 09/04/2021, 14:34.

Chapter Contents

16.1 User Guides (Manuals) and Online Help Files . . . . . . . . . . . . . . . . . . . . 196
16.2 Strategies for Finding the Help You Want . . . . . . . . . . . . . . . . . . . . . . . 197

16.2.1 Finding Igor Pro Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
16.2.1.1 On Your Computer . . . . . . . . . . . . . . . . . . . . . . . 197
16.2.1.2 Web Based Support . . . . . . . . . . . . . . . . . . . . . . . 198

16.2.2 Asylum Research SPM Software Help Finding Strategies . . . . . . . . . . 198
16.2.2.1 Peruse the User Guide Volumes . . . . . . . . . . . . . . . . 198
16.2.2.2 On your computer . . . . . . . . . . . . . . . . . . . . . . . . 198
16.2.2.3 On the Web or by Telephone . . . . . . . . . . . . . . . . . . 198

16.3 AR SPM Software Help Specifics . . . . . . . . . . . . . . . . . . . . . . . . . . . 199
16.3.1 XOP Help files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199

16.4 Using Igor Pro Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199
16.4.1 Status Line Help, Tool Tips, and Context-Sensitive Help (Windows) . . . . . 199
16.4.2 More Information on Igor Pro Help . . . . . . . . . . . . . . . . . . . . . 200

16.5 How to Deal with Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
16.5.1 Bug Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

16.1. User Guides (Manuals) and Online Help Files

As we have discussed, the Asylum Research SPM Software co-exists with the Igor Pro Graphing
and Analysis software. Searching for help and information may require looking in one manual or
another.

The main sources of information are:

The Igor Pro user guide A box set of 5 volumes (books), also installed as a pdf file on any com-
puter with the Igor Pro Software installed.

Igor Pro “Online” help files Only accessible from your computer’s hard drive.

Igor Pro popup tips Various bits of popup information about menu items, buttons, and dialog
boxes.

Asylum Research SPM Software User Guide You’re reading it now. Comprised of several volu-
mes and installed on your computer, available at https://support.asylumresearch.com/forum. Please
inquire at https://support.asylumresearch.com/ about printed volumes.
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Asylum Research “Online” help files Blended in with the equivalent Igor Pro help files. Installed
on your computer when you installed the AR SPM software extension to Igor Pro.

Online 6=
Internet

The Igor Pro Manual refers to Help files which reside on your local computer
as “Online.” For the sake of consistency, Asylum Research will adopt this
nomenclature. Do not confuse “Online” as having anything to do with files on
the internet.

16.2. Strategies for Finding the Help You Want

First you need to determine if it is Igor Pro or AR SPM related. The following table is a good rule
of thumb for making this determination:

Igor Pro AR SPM Software
Any control panel on the main part of the

screen when you first launched the AR
SPM Software.

Anything related to menu items to the
left of and including the Help menu.

Anything related to menu items to the
right of the “help” menu.

Anything related to graphing and curve
fitting.

Anything related to Scanning Probe
Microscopy

Note that there are exceptions to this table, but this is a decent starting point.

16.2.1. Finding Igor Pro Help

16.2.1.1. On Your Computer

To find Igor help on your computer:

1. Open the pdf version of the manual by choosing from the Igor main menu bar Help > Manual
and click “Open Online Manual”.

2. Look in the index for the topic of your choice. Note that the pdf file allows the index to be
accessed easily for each letter in the alphabet. In turn, clicking on any item in the index will
jump to the relevant page in the manual volumes.

Note The index of the Igor Pro manual is no small feat. In the boxed set of books, it is bound
as a separate booklet in two-column text covering nearly 2000 manual pages. With nearly
12,000 index entries, that averages to about six entries per manual page. An impressive
resource.

If that proves unsuccessful, try the following:

1. From the main menu bar, choose Help > Help Topics and confirm that the ‘Sort Topics’ check
box at the end of the list is checked and that the dropdown menu is set to All Open Help Files.

2. Look down the list of topics until you find what you are looking for. Note that mixed in will
be items starting with AR and MFP3D. These are not Igor Pro related but may be useful, so
also read if you are not completely sure if your issue is related to Igor Pro or the AR software.
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3. As a last resort, choose from the main menu bar Help > Search Igor Files and try to search for
your Help topic. The search appears to not sort the results on any relevance, and this method
usually results in very many hits. In a pinch, it can be worthwhile to peruse the results.

Be aware of all the varieties of pop-up help described in Section 16.4.1 on page 199. In the print
manaul, you can look up Help in the index file to learn more about Igor Pro Help features in greater
detail.

16.2.1.2. Web Based Support

From the main menu bar in Igor choose:

Help > Support Web Page A link to Igor Pro support, including contact information for e-mail or
telephone support and access to web-based databases of previously answered questions.

Help > IgorExchange A link to Igor Pro customer forum website, including exchanged questions
and ideas with a huge number of Igor users world-wide. Also searches all existing posts.

At any point also feel free to call, e-mail, or otherwise contact Asylum Research for free support.

16.2.2. Asylum Research SPM Software Help Finding Strategies

16.2.2.1. Peruse the User Guide Volumes

The most general information can be found in the Asylum Research User Guides. Chapter titles
like “AC Mode Imaging in Air” are application-driven guides that tell you how to use the software
to achieve an imaging goal.

16.2.2.2. On your computer

1. For specific questions on software controls, look for the tiny question mark buttons next to
nearly every item on AR SPM control panels. Clicking it will take you directly to the online
Help file entry of relevance.

2. Since these help files are mixed in with the Igor Pro help files, you can search all existing
posts. Note that Help topics relating to Asylum Research always start with AR or MFP3D.

3. For more general questions on how to use the software, refer to the printed or online user
guides. The latest updates are always available for free.

16.2.2.3. On the Web or by Telephone

1. Join the our support website at support.asylumresearch.com. It contains FAQs, soft-
ware and documentation downloads, instructional videos, and a forum where you can pose
questions to fellow users and Asylum Personnel alike.

2. Call or e-mail Asylum Support. If needed, we can initiate an online session where we take
control of your AR SPM software remotely. See Getting Help, Section on page iii.
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16.3. AR SPM Software Help Specifics

As is also the case with Igor Pro, the online Help files are stored as .ihf (igor help file) files. If your
Igor Pro is installed in the standard location, most of those files are found in this directory: <Igor
Pro Folder>\Igor Help Files\ARHelpFiles, where <Igor Pro Folder> is the location where Igor
was installed.

• ToolTips, Ctrl+1 will toggle the tool tips on or off, and nearly every control has extra infor-
mation on how it works in the tool tips.

• Question mark buttons next to nearly every SPM related control in the Software. Click that
button, and the relevant topic in the relevant .ihf file will open. Scroll up and down from there
to read related material. You need no additional knowledge of the Help file organization and
structure to find what you need.

• Larger green Help buttons have additional documentation, typically linking to help pdfs.
• The Help button the bottom of the status bar opens the Asylum Help browser, which will

link to videos, tutorials, and manuals.
• Choose Help > AR Help Files from the main menu bar. This presenst you with a list of topics

with reasonable names, organized by subtopic via nested menus. The relevant .ihf help file
will open to the relevant section.

16.3.1. XOP Help files

You may notice Help > AR Help Files > XOP Help Files. These files describe a series Igor program-
ming commands which were written by Asylum Research to allow, among other things, Igor to
control and communicate with the Asylum Research hardware. If you are interested this will be
discussed at greater length here:1

16.4. Using Igor Pro Help

16.4.1. Status Line Help, Tool Tips, and Context-Sensitive Help (Windows)

(Source: Igor Pro Manuals)

On Windows Igor provides three ways to get help for icons, menu items and dialog items. These
are status line help, tool tips, and context-sensitive help.

Status Line Help The status line area at the bottom of the main Igor Pro window shows brief
descriptions of icons and menu items. This help is shown automatically; you don’t have to do
anything to make it appear.

Note Not currently available for AR SPM software functions.

Tool Tips If you point at an icon in an Igor Pro window, a tool tip will appear after a short delay.
It contains just a two- or three-word description of the button. You can adjust the delay before the
tool tip appears, and the duration of display in the Help page of the Miscellaneous Settings dialog,
which you can choose from the Misc menu.

1 Software User Guide, Programming and Automation..
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Context-Sensitive Help Context-sensitive help (sometimes referred to as F1 help) is displayed in a
pop-up window and provides more detail than the status line help. It is accessed in several different
ways depending on the type of item you need help for.

Menus For help on items in a menu, pull down the menu and highlight the item of interest, then
press the F1 key to display the context-sensitive help window.

Icons For help on icons in windows such as graphs and tables, hold down Shift and press F1. This
changes the mouse cursor to a question-mark. Click on a button or icon to display the context-
sensitive help window.

Dialog Boxes Help for individual items in Igor’s dialogs can be summoned by clicking the question-
mark button at the right end of the dialog’s title bar, then clicking on the item for which you want
help.

16.4.2. More Information on Igor Pro Help

To learn more about Igor Pro Help features, look up “Help” in the index of the print or pdf manual.
It describes your options in greater detail.

16.5. How to Deal with Error Messages

If you have a problem that you suspect is due to a software bug, it is always a good idea to update
your software. Chapter 16 on page 196 describes how to do this in such a way that a copy of your
current version of the software remains functioning. We don’t require the update, but it is highly
likely that in the process of trying to resolve the bug, we will request that an update is made.

16.5.1. Bug Reporting

The preferred method is as follows:

1. From the main menu bar choose Programming > Bug Report Panel .

2. Fill in your e-mail address and your name.

3. Click the ‘Edit’ button and type in a description of your problem.

4. Close the Edit window.

5. Click the ‘Send Report’ button.

6. You will be prompted to “OK” the saving of your current experiment, which is required so it
can be automatically attached to the outgoing e-mail. The e-mail also contains information
on the version of Windows you are running and a few other specifics of your computer
hardware.

The message will be sent out using Asylum Research’s e-mail servers. Note that an experiment file
can easily be tens of megabytes, so it may take a little while to upload, depending on your internet
connection.
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An alternative method is to describe the bug in an email and send it to https://support.asylumresearch.com/
or call us to discuss the bug. Note that this way we won’t have your experiment file containing clues
as to why you are experiencing an error.
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